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Warranty
The material contained in this docu-
ment is provided “as is,” and is sub-
ject to being changed, without notice, 
in future editions. Further, to the max-
imum extent permitted by applicable 
law, Agilent disclaims all warranties, 
either express or implied, with regard 
to this manual and any information 
contained herein, including but not 
limited to the implied warranties of 
merchantability and fitness for a par-
ticular purpose. Agilent shall not be 
liable for errors or for incidental or 
consequential damages in connection 
with the furnishing, use, or perfor-
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document that conflict with these 
terms, the warranty terms in the sep-
arate agreement shall control.

Technology Licenses 
The hardware and/or software described in 
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license and may be used or copied only in 
accordance with the terms of such license.

Restricted Rights Legend
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a U.S. Government prime contract or sub-
contract, Software is delivered and licensed 
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defined in DFAR 252.227-7014 (June 1995), 
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receive no greater than Restricted Rights as 
defined in FAR 52.227-19(c)(1-2) (June 
1987). U.S. Government users will receive 
no greater than Limited Rights as defined in 
FAR 52.227-14 (June 1987) or DFAR 
252.227-7015 (b)(2) (November 1995), as 
applicable in any technical data.

Open Software License 
A portion of the software in this product is 
licensed under terms of the General Public 
License Version 2 (“GPLv2”). The text of 
the license and source code can be found 
at:
www.agilent.com/find/GPLV2

About Customer Feedback 
We love hearing from you. Please take a few 
moments and let us know how we can 
improve this manual. Click here to open the 
Agilent B2900 manual feedback form.

We respect your privacy. Be assured that 
Agilent will never sell or rent your informa-
tion. Nor will Agilent share this information 
with other companies without your 
expressed consent. We make a commit-
ment to you that we will respect and protect 
your privacy. Please see the details of this 
commitment in our Privacy Statement. Click 
here to open the statement.
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DECLARATION OF CONFORMITY
According to EN ISO/IEC 17050-1:2004

Manufacturer’s Name: Agilent Technologies Singapore (International) Pte. Ltd.
Manufacturer’s Address: No. 1 Yishun Ave 7

SINGAPORE 768923
Singapore

Declares under sole responsibility that the product as originally delivered

Product Name: Precision Source/Measure Unit

Model Number: Agilent Model B2901A / B2902A / B2911A / B2912A

Product Options: This declaration covers all related options of the above product(s)

complies with the essential requirements of the following applicable European Directives, and carries 
the CE marking accordingly:

Low Voltage Directive (2006/95/EC)
EMC Directive (2004/108/EC)

and conforms with the following product standards
EMC Standard

IEC 61326-1:2005 / EN 61326-1:2006
CISPR 11:2003 / EN55011:1998+A1:1999+A2:2002
IEC 61000-4-2:2008 / EN 61000-4-2:1995+A1:1998+A2:2001
IEC 61000-4-3:2006+A1:2007 / EN 61000-4-3:2002+A1:2002
IEC 61000-4-4:2004 / EN 61000-4-4:2004
IEC 61000-4-5:2008 / EN 61000-4-5:1995+A1:2001
IEC 61000-4-6:2008 / EN 61000-4-6:1996+A1:2001+A2:2006
IEC 61000-4-11:2004 / EN 61000-4-11:2004

Canada: ICES/NMB-001:2004
Australia/New Zealand: AS/NZS CISPR 11:2004

Limit

Group 1 Class A
4 kV CD, 8 kV AD
3 V/m / 80 MHz-1 GHz / 1.4-2 GHz, 1 V/m / 2-2.7 GHz
0.5 kV signal lines, 1 kV power lines
0.5 kV line-line, 1 kV line-ground
3 V, 0.15-80 MHz 
0 % for 1/0.5 cycle, 0 % for 250/300 cycles, 
70 % for 25/30 cycles

Safety IEC 61010-1:2001 / EN 61010-1:2001
Canada: CAN/CSA-C22.2 No. 61010-1-04, C/US

Supplementary Information:
The product was tested in a typical configuration with Agilent Technologies test systems.

This DoC applies to above-listed products placed on the EU market after:
Year of the CE marking ‘11

January 31, 2011
Date Toshiyuki Kawaji

QA Manager
Agilent Technologies

For further information, please contact your local Agilent Technologies sales office, agent or distributor,
or Agilent Technologies Deutschland GmbH, Herrenberger Straße 130, 71034 Böblingen, Germany.



COMPLIANCE WITH GERMAN NOISE REQUIREMENTS

This is to declare that this product is in conformance with the German Regulation on 
Noise Declaration for Machines 
(Lärmangabe nach der Maschinenlärminformation-Verordnung -3.GSGV Deutschland).

• Herstellerbescheinigung

GERÄUSCHEMISSION

Lpa < 70 dB

am Arbeitsplatz

normaler Betrieb

nach DIN 45635 T. 19

• Manufacturer’s Declaration

ACOUSTIC NOISE EMISSION

Lpa < 70dB

operator position

normal operation

per ISO 7779



Safety Summary
The following general safety precautions must be observed during all phases of 
operation, service, and repair of this instrument. Failure to comply with these 
precautions or with specific warnings elsewhere in this manual may impair the 
protections provided by the instrument. In addition, it violates safety standards of 
design, manufacture, and intended use of the instrument. Agilent Technologies, Inc. 
assumes no liability for customer’s failure to comply with these requirements.

Product manuals may be provided on CD-ROM or in printed form. Printed manuals are 
an option for many products. Manuals may also be available on the Web. Go to 
www.agilent.com and type the product model number in the Search field at the top of 
the page.

NOTE Do not use this instrument in any manner not specified by the manufacturer. The 
protective features of this instrument may be impaired if it is used in a manner not 
specified in the operation instructions.

This instrument is an INDOOR USE product.

This instrument complies with INSTALLATION CATEGORY II for mains input and 
INSTALLATION CATEGORY I for measurement input terminals, and POLLUTION 
DEGREE 2 defined in IEC 61010-1.

If an instrument is marked CAT I (IEC Measurement Category I), or it is not marked 
with a measurement category, its inputs must not be connected to line-voltage mains.

• DANGEROUS PROCEDURE WARNINGS

Warnings, such as example below, shall be complied. Procedures throughout in 
this manual prevent you from potentially hazard. Their instructions contained in 
the warnings must be followed.

WARNING Hazardous voltage of up to the instrument’s maximum voltage may appear at High 
Force, Guard, and High Sense terminals if Interlock terminal is closed. Open the 
Interlock terminal when the High Force, Guard, and High Sense terminals are 
accessible. Voltage applied to the terminals will be limited up to ±42 V.

• BEFORE APPLYING POWER

Verify that all safety precautions are taken. Make all connections to the 
instrument before applying power. Note the instrument's external markings 
described under “Safety Symbols”.



• GROUND THE INSTRUMENT

This is Safety Class I instrument. To minimize shock hazard, the instrument 
chassis and cabinet must be connected to an electrical ground. The power 
terminal and the power cable must meet International Electrotechnical 
Commission (IEC) safety standards.

• DO NOT OPERATE IN AN EXPLOSIVE ATMOSPHERE

Do not operate the instrument in the presence of flammable gases or fumes. 
Operation of any electrical instrument in such an environment constitutes a 
definite safety hazard.

• KEEP AWAY FROM LIVE CIRCUITS

Operation personnel must not remove instrument covers. Component replacement 
and internal adjustments must be made by qualified maintenance personnel. Do 
not replace components with power cable connected. Under certain conditions, 
hazardous voltages may exist even with the power cable removed. To avoid 
injuries, always disconnect power and discharge circuits before touching them.

• DO NOT SERVICE OR ADJUST ALONE

Do not attempt internal service or adjustment unless another person, capable of 
rendering first aid and resuscitation, is present.

• DO NOT SUBSTITUTE PARTS OR MODIFY INSTRUMENT

Because of the danger of introducing additional hazards, do not install substitute 
parts or perform any unauthorized modification to the instrument. Return the 
instrument to a Agilent Technologies Sales and Service Office for services and 
repair to ensure that safety features are maintained.

• IN CASE OF DAMAGE

Instruments that appear damaged or defective should be made inoperative and 
secured against unintended operation until they can be repaired by qualified 
service personnel.



Safety Symbols
The general definitions of safety symbols used on equipment or in manuals are listed 
below.

Direct current.

Alternating current.

Protective conductor terminal. For protection against electrical shock in case of a 
fault. Used with field wiring terminals to indicate the terminal which must be 
connected to ground before operating equipment.

Frame or chassis terminal. A connection to the frame (chassis) of the equipment 
which normally includes all exposed metal structures.

Grounded terminal which indicates the earth potential.

On supply.

Off supply.

Standby supply. The equipment will be marked with this symbol is not completely 
disconnected from AC mains when power switch is in the standby position.

In position of a bi-stable push switch.

Out position of a bi-stable push switch.

Hazardous voltage and potential for electrical shock. Do not touch terminals that have 
this symbol when the equipment is on.

Hot surface. Avoid contact. Surfaces are hot and may cause personal injury if touched.

Instruction manual symbol. The equipment will be marked with this symbol when it is 
necessary for the user to refer to the instruction manual.

IEC Measurement Category I

WARNING The warning sign denotes a hazard. It calls attention to a procedure, practice, 
condition or the like, which, if not correctly performed or adhered to, could result in 
injury or death to personal.

CAUTION The caution sign denotes a hazard. It calls attention to an operating procedure, 
practice, condition or the like, which, if not correctly performed or adhered to, could 
result in damage to or destruction of part or all of the equipment.



The CE mark shows that the product complies with all applicable European Directives.

The CSA mark is a registered trademark of the Canadian Standards Association.

The C-Tick mark is a registered trademark of the Australian Communications 
Authority. This signifies compliance with the Australian EMC Framework Regulations 
under the terms of the Radio communications Act.

This ISM device complies with Canadian ICES-001.
Cet appareil ISM est conforme à la norme NMB-001 du Canada.

This is the symbol for an Industrial, Scientific and Medical, Group 1 Class A product. 
(CISPR 11)

China RoHS -  Environmentally Green Product Label

China RoHS -  Product with Toxic Substance 40 yr EPUP

The Chinese mark for paper-based packaging materials; Paperboard and Corrugated 
Fiberboard

Plastic Material Coding Identification



Power Supply and Measurement Safety
• Power Supply Safety

This instrument can output high currents and voltages. Make sure that the load or 
device under test can safely handle the output current and voltage. Also, make 
sure that the connection leads can safely withstand the expected currents and are 
insulated for the expected voltages.

The instrument outputs may be connected so as to float relative to earth ground. 
Isolation or floating voltage ratings are indicated on the instrument, near the 
output terminal or the Chassis ground terminal.

• Voltage/Current Measurement Safety

Multimeters and other instruments capable of measuring high voltages and 
currents are subject to specific safety concerns because of the circuits to which 
they may be connected. To safely use these instruments, you need to understand 
the markings on the instrument near the input terminals, which include the 
Protection Limits and the IEC Measurement Category.

• Protection Limits

Agilent multimeters and other voltage measurement instruments provide 
protection circuitry to prevent damage to the instrument and to protect against the 
danger of electric shock, provided the Protection Limits are not exceeded. To 
ensure safe operation of the instrument, do not exceed the Protection Limits 
shown on the input terminals.



• Source/Measure Terminals

Source/measure unit, SMU, can simultaneously perform DC voltage or current 
output and measurement. Typical SMU has the Force, Sense, and Guard terminals 
as shown below. Normally the Force, Sense, and Guard are the same potential. 
Voltage marked around the terminals indicates the Protection Limits.

Force and Sense must be connected to a terminal of a device under test (DUT) for 
the 4-wire connection (Kelvin connection) which is effective for high current 
measurement and low resistance measurement. For the 2-wire connection to ease 
the connections, connect Force only. Do not connect Sense. It must be opened.

Guard should be connected to the guard shield which covers the DUT high side 
wiring for reducing leakage current caused by the wire. Or else, the Guard must be 
opened.

Chassis ground (green terminal) should be connected to the ground shield which 
covers the DUT including the guard shield to minimize the affect of noise. Or else, 
the chassis ground should be opened.

The following image is the source and measurement terminals of Agilent B2900. 
For the B2900, the High Force, High Sense, and Guard are the same potential. And 
the Low Force and Low Sense are the same potential.

High Sense, for 4-wire connection

High Force

Guard

Chassis ground

Low Force

Low Sense, for 4-wire connection



High Voltage Shock Hazard

Agilent B2900 can force dangerous voltages (±210 V) at the High Force, Guard, and 
High Sense terminals. To prevent electric shock hazard, the following safety 
precautions must be observed during the use of Agilent B2900.

• Use a three-conductor AC power cable to appliance coupler (inlet) and the 
instrument to an electric ground (safety ground).

• Prepare shielding box which covers interface to a device under test and equipped 
with interlock circuit that opens when the door is opened.

• Before performing measurement, connect the interlock circuit to the Interlock 
terminal of this instrument.

• Confirm periodically that the interlock function works normally.

• Before touching the connections of the High Force, Guard, and High Sense 
terminals, turn the instrument off and discharge any capacitors of the 
measurement path. If you do not turn the instrument off, complete “all” of the 
following items, regardless of any instrument’s settings.

• Terminate source output by pressing the On/Off switch, confirm that the 
On/Off switch turns off.

• Confirm that the High Voltage indicator is not lit.

• Open the shielding box access door (open the Interlock terminal).

• Discharge any capacitors if the capacitance is connected to an SMU.

• Warn workers in the vicinity of the instrument about hazardous conditions.



Gefahr durch Hochspannung

Von den Geräten Agilent B2900 können Spannungen an den Anschlüssen “High 
Force, Guard und High Sense” von bis zu 210 V ausgehen. Um elektrischem Schlag 
vorzubeugen, ist bei der Benützung der Geräte Agilent B2900 folgendes zu 
beachten.

• Verwenden Sie ein dreiphasiges AC-Stromkabel für die Gerätsteckvorrichtung 
(Eingang) und schließen Sie das Instrument an eine Erdung an 
(Sicherheitserdung).

• Bereiten Sie das Abschirmungsgehäuse vor, dass die Oberfläche eines zu 
testenden Geräts abdeckt und mit einem Verriegelungsstromkreis ausgestattet 
ist, der bei geöffneter Tür unterbrochen wird.

• Vor der Messung verbinden Sie den Verriegelungsstromkreis mit dem 
Interlock-Anschluss dieses Instruments.

• Prüfen Sie in regelmäßigen Abständen, dass die Verriegelungsfunktion 
ordnungsgemäß funktioniert.

• Bevor Sie die Verbindungen zu den Anschlüssen High Force, Guard und High 
Sense berühren, schalten Sie das Instrument aus und entladen alle 
Kondensatoren des Messwegs. Wenn Sie das Instrument nicht ausschalten, 
führen Sie, unabhängig von den Instrumenteinstellungen, alle folgenden Schritte 
durch.

• Beenden Sie die Messung, indem Sie auf die Taste “On/Off” drücken. 
Stellen Sie sicher, dass die Statusanzeige “On/Off” nicht leuchtet.

• Stellen Sie sicher, dass die Anzeige “High Voltage” nicht leuchtet.

• Öffnen Sie die Tür des Abschirmungsgehäuses (öffnen des 
Interlock-Anschlusses).

• Entladen Sie alle Kondensatoren, wenn die Kapazität mit einer SMU 
verbunden ist.

• Warnen Sie Mitarbeiter in der Umgebung des Instruments vor den Gefahren.



Danger de choc dû à une haute tension

Une tension dangereuse  (max. ± pour; 210 Vdc) émanant du dispositif Agilent 
B2900 peut être sortie aux bornes de force, d'appareil de protection ou de détection. 
Les précautions suivantes doivent être obserées contre commotion électrique acci-
dentelle.

• Utilisez un câble d’alimentation CA à trois conducteurs vers le coupleur secteur 
(entrée) et branchez l’instrument sur une mise électrique à la terre (prise de terre 
de sécurité).

• Préparez le boîtier de protection qui couvre l’interface avec le dispositif à tester 
et équipez-le d’un circuit de sécurité qui s’ouvre lors de l’ouverture d’une porte.

• Avant de procéder aux mesures, connectez le circuit de sécurité à la borne 
Interlock de l’instrument. 

• Vérifiez régulièrement le bon fonctionnement de la fonction de sécurité.

• Avant de toucher les connexions des bornes High Force, Guard et High Sense, 
mettez l’instrument hors tension et déchargez tout condensateur du chemin de 
mesure. Si vous ne mettez pas l’instrument hors tension, effectuez « toutes » les 
opérations ci-dessous, quels que soient les paramètres de l’instrument.

• Terminez les mesures en appuyant sur la touche On/Off ; vérifiez que 
l’indicateur d’état On/Off est éteint.

• Vérifiez que le témoin High Voltage est éteint.

• Ouvrez la trappe d’accès au boîtier de protection (ouvrez la borne Interlock).

• Déchargez les éventuels condensateurs si la capacité est connectée à une 
unité SMU.

• Informez les personnes travaillant à proximité de l’instrument des conditions.



高電圧感電注意

Agilent B2900 のフォース、ガード、センス端子には、危険電圧が出力されることが
あります（最大 ±210 Vdc）。感電事故防止のため、必ず以下の事柄を守ってくださ
い。

• 3 極電源ケーブルを使用して本器を接地してください。

• ドアを開くことによって開放されるインターロック回路を装備し、被測定デバ
イスとのインタフェースを覆うことのできるシールド・ボックスを用意してく
ださい。

• 測定を開始する前にはインターロック回路を本器の Interlock 端子に接続してく
ださい。

• インターロック機能が正常であることを定期的に確認してください。

• High Force、Guard、High Sense 端子に繋がる接続部に触れる前には、本器の電源
を切断してください。また、測定系のキャパシタを放電してください。電源を
切らない場合は、以下の事項を全て実施してください。

• On/Off スイッチを押して On/Off スイッチが消灯したことを確認してくださ
い。

• 高電圧警告（High Voltage）インジケータが消灯していることを確認してくだ
さい。

• シールド・ボックスのドアを開けてください（Interlock 端子を開放してくだ
さい）。

• キャパシタが SMU に接続されているならば、キャパシタを放電してくださ
い。

• 周囲のほかの作業者に対しても、高電圧危険に対する注意を徹底してください。



Product Stewardship
• Waste Electrical and Electronic Equipment (WEEE) Directive 2002/96/EC

This product complies with the WEEE Directive (2002/96/EC) marking 
requirements. The affixed label indicates that you must not discard this electrical/ 
electronic product in domestic household waste. 

Product Category: With reference to the equipment types in the WEEE directive 
Annex 1, this product is classified as a “Monitoring and Control instrumentation” 
product. 

Do not dispose in domestic household waste. 

To return unwanted products, contact your local Agilent office or visit the 
following website for more information.

www.agilent.com/environment/product/

• LCD Fluorescent Lamp

Certain products sold by Agilent contain a liquid crystal display (LCD); backlighting 
for the LCD is provided by a fluorescent lamp which contains mercury, and must 
be managed, recycled, and/or disposed in accordance with all applicable laws, 
ordinances and regulations. 

For information on how to recycle or dispose of the fluorescent lamp contained in 
your own product, visit the following website.

http://www.agilent.com/environment/mercury.shtml

If you live in the U.S., also visit the following websites.

http://www.lamprecycle.org

http://www.eiae.org

If you have additional questions, please visit the following website.

http://www.agilent.com/go/contactus

• Perchlorate Information

Perchlorate Material - special handling may apply. Visit the following website.

http://www.dtsc.ca.gov/hazardouswaste/perchlorate/

Equipment's real-time clock battery or coin cell battery may contain perchlorate 
and may require special handling when recycled or disposed of in California.



In This Manual 
This manual describes the front panel operation, installation, and functions of the 
Agilent Technologies B2900 Precision Source/Measure Unit, SMU. This manual 
consists of the following chapters.

• Chapter 1, “Getting Started”

This chapter briefly explains how to use the Agilent B2900 by the front panel 
operation.

• Chapter 2, “Introduction”

This chapter describes overview, specifications, accessories, and options of the 
Agilent B2900.

• Chapter 3, “Installation”

This chapter explains how to install the Agilent B2900, and how to connect the 
device under test to a test fixture.

• Chapter 4, “Front Panel Reference”

This chapter provides the reference information of the Agilent B2900 front panel 
keys and graphical user interface.

• Chapter 5, “Front Panel Operations”

This chapter explains how to use the Agilent B2900 in the local mode.

• Chapter 6, “Function Details”

This chapter explains the several functions and initial settings of the Agilent 
B2900.

NOTE To get the latest firmware/software/electronic manuals/support information, go to 
www.agilent.com and type in your product number in the Search field at the top of the 
page.
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Getting Started
This chapter describes basic operations for Agilent B2900. Before learning the 
details of B2900, let us briefly cover the use of the B2900 source/measure unit. The 
operations require only B2900 and the power cord. To get started with the 
operations, open the measurement terminals.

This chapter consists of the following sections.

• “Applying DC Output”

• “Performing Spot Measurement”

• “Performing Sweep Measurement”

• “Operation Tips”

• “Operation Summary”

NOTE Turning B2900 on

1. Connect the power cord from the AC input connector (receptacle) on B2900’s 
rear panel to an AC power outlet at your site.

2. Press the line switch  on the front panel.

B2900 boots up and performs a self-test. After B2900 boots normally, the front 
panel LCD displays the following view. It will be the Single view for the 1-channel 
model or the Dual view for the 2-channel model.

NOTE Connecting your DUT

If you want to connect your device under test, see “Connecting a DUT” on page 
3-10.

D: Dual view1: Single view
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Applying DC Output
Applying DC Output
B2900 can be used as a DC voltage or current source. The following procedure 
configures B2900 as a voltage source and applies a voltage of +500 mV.

Step 1. Setting the Source mode (voltage output)

1. Press the Mode assist key on a 1-ch model, or the Ch1 Mode assist key on a 2-ch 
model.

The field pointer appears on the Source mode, and the status changes to EDIT 
(green). The status information will show .

2. Press the VOLTS (V) assist key. Or use the rotary knob or arrow keys 
 and  to specify the mode, and press the knob to fix the setting.

The status changes to MOVE (blue). The status information will show .

Step 2. Setting the Source value (voltage output value)

1. Press the Source assist key on a 1-ch model, or the Ch1 Source assist key on a 
2-ch model. Or, use the rotary knob or arrow keys to move the field pointer onto 
the Source value and press the knob. The field pointer appears on the Source 
value, and the status changes to EDIT (green).

2. Turn the rotary knob clockwise to increase the value, or counter clockwise to 
decrease the value. Set the desired value. 

When you press an arrow key, a digit pointer will appear on a digit. Turning the 
knob will change the value of the digit, or move the decimal point if the pointer 
is on it. 

3. Press the rotary knob to fix the value. The status changes to MOVE (blue).

The numeric/alpha keys and the unit assist keys are also available for setting the 
Source value in the same way as for setting the Limit value, shown in the next step.
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Applying DC Output
This example sets the Source value to +500 mV.

Step 3. Setting the Limit value (compliance current)

1. Press the Limit assist key on a 1-ch model, or the Ch1 Limit assist key on a 2-ch 
model. Or, use the rotary knob or arrow keys to move the field pointer onto the 
Limit value and press the knob. The field pointer appears on the Limit value, and 
the status changes to EDIT (green).

 

2. Use the rotary knob, arrow keys, or numeric/alpha keys  
to set the value.

3. Press one of the unit assist keys to set the unit and fix the value. 
The status changes to MOVE (blue).

This example sets the Limit value to 1 mA.

Step 4. Enabling the channel

Press the Ch 1  switch to enable channel 1. This turns the switch green. 
Channel 1 starts applying the voltage specified by the Source value.

Step 5. Disabling the channel

Press the Ch 1  switch to disable channel 1. This turns off the switch light.
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Performing Spot Measurement
Performing Spot Measurement
B2900 can be used as a DC voltage or current meter. The following procedure 
performs one point current measurement.

Step 1. Setting the measurement mode (current measurement)

Press the Measure assist key on a 1-ch model, or the Ch1 Measure assist key on a 2-ch 
model. And press the AMPS (I) assist key.

The rotary knob and arrow keys are also available for setting the measurement 
mode, in the same way as for setting the Source mode under “Applying DC Output”.

Step 2. Enabling the channel

Press the Ch 1  switch to enable channel 1. This turns the switch green. 
Channel 1 starts applying the voltage specified by the Source value.

Step 3. Starting measurement

• Press the  key to start a single (one shot) measurement. Spot 
measurement is performed once.

• Press the  key to start a repeat (continuous) measurement. Spot 
measurement is performed repeatedly.

The measurement results will be displayed in the left half of the LCD. 

The following example shows the measurement results for a 1 k resistor connected 
between the High Force and Low Force terminals of channel 1.

Step 4. Disabling the channel

Press the Ch 1  switch to disable channel 1. This turns off the switch light.
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Performing Sweep Measurement
Performing Sweep Measurement
B2900 supports sweep measurements. The following example applies a staircase 
sweep voltage and measures the current at each step voltage.

Step 1. Press the  key to display the Single view.

Step 2. Set the Source mode, Limit value, and measurement mode as shown in “Applying 
DC Output” and “Performing Spot Measurement”.

This example sets the voltage output, a 10 mA limit value, and both current and 
voltage measurements.

Step 3. Setting the Sweep parameters

1. Press the More assist key to change the assist keys.

2. Press the Show Sweep assist key to display the Sweep setup parameters.

3. Press the rotary knob to change the status to EDIT (green).

4. Press the LINEAR SINGLE assist key to set the linear single sweep mode. 

The source shape indicator shows the staircase icon, and the status changes to 
MOVE (blue).
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Performing Sweep Measurement
5. Use the rotary knob, arrow keys, or numeric/alpha keys to set the Start (sweep 
start value), Stop (sweep stop value), and Step (sweep step value) or Points 
(number of sweep steps).

This example sets Start to 1 V, Stop to 2 V, and Points to 11.

Step 4. Press the  key to display the Graph view.

Step 5. Enabling the channel

Press the Ch 1  switch to enable channel 1. This turns the switch green. 
Channel 1 starts applying the voltage specified by the Source value.

Step 6. Press the  key to start a single (one shot) measurement. Sweep measurement 
is performed once. And the measurement results will be displayed on the graph. 

Step 7. Press the Auto Scale assist key to fit the trace in the graph scale.

The following example shows the measurement results for a 1 k resistor connected 
between the High Force and Low Force terminals of channel 1.

Step 8. Disabling the channel

Press the Ch 1  switch to disable channel 1. This turns off the switch light.
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Operation Tips
This section introduces key operation and status information on B2900.

• “Changing the View Mode”

• “Editing the Setup”

• “Status Information”

Figure 1-1 Changing the View Mode

For details about the View mode, see “Display and Assist Keys” on page 4-5.

Graph

G

Single Ch1

1

Roll

R

Dual

D 2

Single Ch2
B2912A

Graph

G

Single

1

B2901A

Graph

G

Single Ch1

1

Dual

D 2

Single Ch2
B2902A

Graph

G

Single

1

RollB2911A

R

1- 8 Agilent B2900 User’s Guide, Edition 2



Getting Started

Operation Tips
Figure 1-2 Editing the Setup

For more information about the front panel keys, see “Hard Keys and Rotary Knob” 
on page 4-3.

Figure 1-3 Status Information

For details about the status information, see “Status Information” on page 4-22.
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Operation Summary
This section summarizes front panel operations on B2900.

• “Basic Operations”

• “Channel Setup”

• “Source Setup”

• “Measurement Setup”

• “Display Setup”

• “File Operations”

• “Miscellaneous Functions”

• “Interface Setup”

• “System Setup and Operations”

For details about front panel operations, see Chapter 4, “Front Panel Reference.”
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Operation Summary
Table 1-1 Basic Operations

Table 1-2 Channel Setup

Task Relevant front panel key

To turn the B2900 on/off Line switch

To change the display mode View key

To enable/disable the specified channel Ch 1 On/Off switch or Ch 2 On/Off switch

To cancel the previous setup operation Cancel/Local key

To return to the upper menu of a function key or softkey Cancel/Local key

To return to the local status from the remote status Cancel/Local key

To start a single (one shot) measurement Trigger key

To start a repeat (continuous) measurement Auto key

To move the field pointer Rotary knob or arrow keys

To move the digit pointer Rotary knob or arrow keys

To switch the EDIT/MOVE status Rotary knob on a setup field

To select the setup value Assist keys, rotary knob, or arrow keys

Task Relevant front panel key

To enable/disable the specified channel Ch 1 On/Off switch or Ch 2 On/Off switch

To select the sensing type; 2-wire or 4-wire Config > Source > Connection function keys

To select the low terminal status; grounded or floating Config > Source > Connection function keys

To enable/disable high capacitance mode Config > Source > Connection function keys

To enable/disable over voltage/current protection Config > Source > Connection function keys

To enable/disable resistance compensation Config > Measure > R Compen function keys

To enable/disable 2-channel synchronous operation Config > Common > Group function keys
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Table 1-3 Source Setup

Table 1-4 Measurement Setup

Task Relevant front panel key

To enable/disable source output Ch 1 On/Off switch or Ch 2 On/Off switch

To select source output mode Mode, Ch1 Mode, or Ch2 Mode assist key

To set source output value Source, Ch1 Source, or Ch2 Source assist key

To set limit/compliance value Limit, Ch1 Limit, or Ch2 Limit assist key

To set constant source ranging mode Speed assist key or Hide Sweep/Pulse/Trigger assist key on 
Single view

To set sweep source Show Sweep assist key on Single view

To set list sweep source Edit assist key in the EDIT status for the LIST sweep 
Start/Stop/Points field

To set sweep source ranging mode Config > Source > Sweep function keys

To set sweep direction Config > Source > Sweep function keys

To set source output value after sweep Config > Source > Sweep function keys

To set pulse source Show Pulse assist key on Single view

To set source wait time Config > Common > Wait function keys

To set output filter Config > Source > Filter function keys

To select output-off status Config > Source > Connection function keys

To enable/disable automatic output ON Config > Source > Connection function keys

To enable/disable automatic output OFF Config > Source > Connection function keys

Task Relevant front panel key

To enable/disable the specified channel Ch 1 On/Off switch or Ch 2 On/Off switch

To select measurement mode Measure, Ch1 Measure, or Ch2 Measure assist key

To set measurement speed Speed assist key on Single view
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Table 1-5 Display Setup

Table 1-6 File Operations

To set measurement ranging mode Speed assist key or Hide Sweep/Pulse/Trigger assist key on 
Single view

To define automatic ranging operation Config > Measure > Ranging function keys

To set measurement wait time Config > Common > Wait function keys

Task Relevant front panel key

To change the display mode View key

To change the color set Display > Color function keys

To enable zoom-in Display > Zoom > ON function keys

To disable zoom-in Zoom Out assist key for the zoom-in display status

To change the data digits Display > Digits function keys

To enable/disable the front panel display 
in the remote condition

Display > Remote function keys

Task Relevant front panel key

To save a measurement result data to USB memory File > Save > Measure function keys

To save a math result data to USB memory File > Save > Math function keys

To save a limit test result data to USB memory File > Save > Limit Test function keys

To save a trace buffer data to USB memory File > Save > Trace function keys

To save a system setting data to USB memory File > Save > Config function keys

To save a graph screen damp to USB memory Dump Screen assist key on Graph or Roll view

To load a system setting data from USB memory File > Load > Config function keys

To load a list sweep data from USB memory Load assist key in the EDIT status for the LIST 
sweep Start/Stop/Points field

Task Relevant front panel key
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Table 1-7 Miscellaneous Functions

Table 1-8 Interface Setup

Task Relevant front panel key

To see measurement result Result > Measure function keys

To use math expression Function > Math function keys

To see math result Result > Measure function keys

To set limit test Function > Limit Test function keys

To see limit test result Result > Limit Test function keys

To set trace buffer Function > Trace function keys

To see trace statistical result Result > Trace function keys

To select program memory Program > Catalog function keys

To control program memory Program > Control function keys

To set trigger parameters easily Show Trigger assist key on Single view

To set trigger parameters in detail Function > Trigger > Config function keys

To control trigger system Function > Trigger > Initiate/Abort/Immediate function keys

Task Relevant front panel key

To specify measurement data elements I/O > Format > Measure function keys

To specify math and limit test data elements I/O > Format > Math/Limit function keys

To specify trace statistical data elements I/O > Format > Trace function keys

To select data output format I/O > Format > Data Type function keys

To enable/disable byte swap of binary data I/O > Format > Byte Swap function keys

To set LAN configuration I/O > LAN > Config function keys

To see status of LAN interface I/O > LAN > Status function keys

To reset all of LAN connections I/O > LAN > Reset function keys
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Table 1-9 System Setup and Operations

To sets LAN settings to the default settings I/O > LAN > Default function keys

To see status of USB interface I/O > USB function keys

To set GPIB address I/O > GPIB function keys

To see status of GPIB interface I/O > GPIB function keys

To set configuration of Digital I/O I/O > DIO > Config function keys

To read/write a value set to Digital I/O I/O > DIO > R/W function keys

Task Relevant front panel key

To set power line frequency System > PLC function keys

To initialize B2900 System > Reset function keys

To perform self-calibration System > Cal/Test > Self-Cal function keys

To perform self-test System > Cal/Test > Self-Test function keys

To check errors System > Error > Log function keys

To clear errors System > Error > Clear function keys

To clear time stamp System > Timestamp > Clear function keys

To set automatic clear of time stamp System > Timestamp > Auto CLR function keys

To set start-up operation System > More > Start-up function keys

To enable/disable beep and sound System > More > Sound function keys

To select remote control command set System > More > SCPI function keys

To set date and time System > More > Info. > Date/Time function keys

To perform firmware update System > More > Info. > Update > Firmware function keys

To perform demonstration System > More > Info. > Demo. function keys

Task Relevant front panel key
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Introduction
This chapter describes the basic functions and features of the Agilent B2900, and 
consists of the following sections.

• “Agilent B2900 Series”

• “Front View”

• “Rear View”

• “Source/Measure Unit”

• “Specifications”

• “Operation and Functions”

• “Software and Drivers”

• “Accessories”

• “Options”
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Agilent B2900 Series
Agilent B2900 is a series of precision SMU (source/measure unit, SMU). B2900 
provides the LCD, front panel keys, and rotary knob for applying voltage/current or 
measuring voltage/current/resistance. B2900 also supports several functions, such 
as sweep output, pulse output, arbitrary waveform generation, limit test, trace buffer, 
math expressions, and graph plot. Hence, B2900 can be used as a DC (constant) 
voltage/current source, sweep voltage/current source, pulse generator, arbitrary 
waveform generator, and multimeter.

The product lineup of the Agilent B2900 series includes the following products.

Table 2-1 Agilent B2900 Series

B2900 is a LAN eXtended Interface Class C (LXI-C) compliant instrument.

Model 
No.

Number 
of SMU 
channels

Effective set and measure value

Minimum 
resolution Maximum 

current
Maximum 

voltage
 Set Measure

B2901A 1 1 pA, 
1 V

0.1 pA, 
0.1 V

DC: ± 3.03 A 
Pulse: ± 10.5 A

± 210 V

B2902A 2

B2911A 1 0.01 pA, 0.1 V

B2912A 2
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Front View
This section describes the front view of the Agilent B2900 series.

• Line switch

Turns the instrument on or off.

• Display

Displays the source setup, measurement result, status information, etc. For 
details, see Chapter 4, “Front Panel Reference.”

• Trigger key

Starts a single (one shot) measurement or initiates trigger system. If a repeat 
(continuous) measurement is in progress, stops the repeat measurement.

The single measurement is performed with the DC bias output, staircase sweep 
output, pulsed bias output, or pulsed sweep output set to the channel. One single 
measurement can contain the maximum of 100000 measurement points.

Once a single measurement starts, the data buffer (maximum 100000 data) is 
cleared, and the last single measurement result is stored in the buffer. The 
measurement result is displayed on the Single view, Dual view, Graph view, or 
Roll view.

NOTE If measurement is not performed properly, check the trigger setting. The trigger type 
must be set to AUTO, or the trigger count (Count) must be set properly. See 
“Trigger parameters” on page 4-15.
2- 4 Agilent B2900 User’s Guide, Edition 2



Introduction

Front View
• Auto key

Starts a repeat measurement. If a repeat measurement is in progress, stops the 
repeat measurement. 

The repeat measurement is performed with the DC bias output of the Source 
value. And the measurement result is displayed on the Single view, Dual view, 
or Roll view. The repeat measurement result is not stored in the buffer.

• USB-A connector

Used to connect a USB memory. After disconnecting the USB memory, wait 10 
seconds before connecting it again or new one.

CAUTION Turning the instrument off while the USB memory is being accessed may damage 
the device. 

• Function keys

Six function keys are available below the display. They are assigned to the 
softkeys, Config, Function, Trigger, Result, File, Program, I/O, System, and 
More. For details, see Chapter 4, “Front Panel Reference.”

• Assist keys

Five assist keys are available to the right of the display. They are assigned to 
several softkeys, such as Mode, Source, Limit, Measure, and More. The softkey 
assignment depends on the display mode (Single, Graph, Roll, or Dual). For 
details, see Chapter 4, “Front Panel Reference.”

• View key

Changes the display mode. Pressing the key changes the mode as shown below.

On B2901A Single  Graph  (return to Single)

On B2902A Dual  Single for channel 1  Single for channel 2  
Graph  (return to Dual)

On B2911A Single  Graph  Roll  (return to Single)

On B2912A Dual  Single for channel 1  Single for channel 2  
Graph  Roll  (return to Dual)

• Cancel / Local key

Cancels the setup operation if the instrument is in the local status. Returns the 
instrument to the local status if it is in the remote status.
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• Numeric/alpha keys

Used to enter the value of setup parameters such as the source output value, limit 
(compliance) value, and message, specified by the field pointer.

• Rotary knob

If the field pointer is in the MOVE (blue) status, turning the knob moves the 
pointer. Pressing the knob fixes the pointer position and changes the pointer 
status to EDIT (green).

If the field pointer is in the EDIT (green) status, turning the knob changes the 
value of the setup parameter specified by the pointer. Pressing the knob fixes the 
value and changes the pointer status to MOVE (blue).

• Left and right keys

If the field pointer is in the MOVE (blue) status, pressing the key moves the 
pointer.

If the field pointer is in the EDIT (green) status, pressing the key changes the 
value of the setup parameter specified by the pointer.

If the field pointer is in the EDIT (green) status on a numeric value entry field, 
pressing the key changes the pointer to a digit pointer.

• On/Off switch(es)

Used to enable or disable the SMU channel. Turns the channel off if it is in the 
output status even if it is in the remote status. One switch on 1-channel models, 
and two switches on 2-channel models.

The switch turns green if the channel is enabled.

The switch turns red if the channel is in the high voltage state.

• Channel 1 source/measure terminals

Terminals for SMU channel 1. High Force, Low Force, High Sense, Low Sense, 
Guard, and chassis ground. For details, see “Connecting a DUT” on page 3-10

CAUTION Never connect the Guard terminal to any output, including circuit common, chassis 
ground, or any other guard terminal. Doing so will damage the B2900.

CAUTION Do not apply current to the chassis ground terminal. Doing so will damage the 
B2900.
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Rear View
Rear View
This section describes the rear view of the Agilent B2900 series.

• Channel 2 source/measure terminals

Only on 2-channel models. Terminals for SMU channel 2. High Force, Low 
Force, High Sense, Low Sense, Guard, and chassis ground. For details, see 
“Connecting a DUT” on page 3-10

CAUTION Never connect the Guard terminal to any output, including circuit common, chassis 
ground, or any other guard terminal. Doing so will damage the B2900.

CAUTION Do not apply current to the chassis ground terminal. Doing so will damage the 
B2900.

• GPIB interface connector

Use an Agilent 82357A/B USB/GPIB interface or Agilent 10833A/B/C/D GPIB 
cable to connect to an external computer or equipment.

• Cooling fan

• AC input connector

AC power cord is connected to this receptacle.

• LAN interface connector

Connects to 10/100 Base-T interface. Left LED indicates activity. Right LED 
indicates link integrity.
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Rear View
• USB-B connector

Connects to USB interface.

• Digital I/O connector

D-sub 25 pin female connector for general purpose I/O (GPIO). Can be used as 
trigger input/output terminals or as an interface to a handler or the likes. For 
details, see “Using Digital I/O” on page 3-29

Pins 16 and 24 and pins 17 and 25 are reserved for the interlock function. If the 
terminals are open, the instrument output is limited to 42 V. Be sure to connect 
the terminals to the Agilent 16442B test fixture or another DUT interface before 
performing measurements. If you do not use 16442B, you need to install an 
interlock circuit. For details on how to install the interlock circuit, see “Installing 
the Interlock Circuit” on page 3-19.

WARNING Dangerous voltage of up to the maximum voltage of SMUs may be present at 
the High Force, High Sense, and Guard terminals if the Interlock terminal is 
closed.

NOTE Serial Number

You will need the instrument’s serial number when using the Agilent Technologies 
telephone assistance program. The serial number label is attached to the bottom of 
the instrument.
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Source/Measure Unit
Source/Measure Unit
The source/measure unit (SMU) can apply voltage or current, and can measure 
current or voltage.

Figure 2-1 shows a simplified SMU circuit diagrams. The SMU can perform the 
following operations.

• Applies voltage and measures current

• Applies current and measures voltage

• Applies voltage and measures voltage

• Applies current and measures current

Figure 2-1 Simplified SMU Circuit Diagram

High Force

Chassis ground

V

A

+
-

+ -
High Sense

4-wire connections

Low Sense

Low Force

High Force

Chassis ground

V
A +

-

+ -

Low Force

2-wire connections
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Source/Measure Unit
Measurement Parameters

B2900 supports the following measurement parameters.

• Current

• Voltage

• Resistance

• Power

Resistance data is given by Resistance=Vmeas/Imeas.

Power data is given by Power=VmeasImeas.

In the above formula, Vmeas is the voltage measurement data, and Imeas is the 
current measurement data.

For using the resistance compensation, see “Resistance Compensation” on page 
6-16.

Limit/Compliance

B2900 has a compliance feature that limits the output voltage or current to prevent 
damage to the device under test. When the SMU applies voltage, you can specify the 
current limit/compliance. When the SMU applies current, you can specify the 
voltage limit/compliance. For details about limit/compliance, see 
“Limit/Compliance” on page 6-3.
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Source/Measure Unit
Output and Measurement Ranges

This section describes typical specifications of the Agilent B2900 series.

• Maximum voltage and current: see Figure 2-2.

• Maximum power: 31.8 W

• Output/measurement value and resolution: see Table 2-2 to Table 2-7.

Figure 2-2 Maximum Voltage and Current
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-21 21

Duty cycle ~ 2.5 %
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Table 2-2 Current Output Range

Range 
value

Setting resolution DC output current or 
pulse peak/base 

current a b

Maximum voltage

Pulse width t cB2901A 
B2902A

B2911A 
B2912A

DC 
output

Pulsed 
output

10 nA d ― 10 fA 0  |I|  10.5 nA 210 V 210 V 50 s  t  tmax

100 nA 1 pA 100 fA 0  |I|  105 nA

1 A 10 pA 1 pA 0  |I|  1.05 A

10 A 100 pA 10 pA 0  |I|  10.5 A

100 A 1 nA 100 pA 0  |I|  105 A

1 mA 10 nA 1 nA 0  |I|  1.05 mA

10 mA 100 nA 10 nA 0  |I|  10.5 mA

100 mA 1 A 100 nA 0  |I|  105 mA

1 A 10 A 1 A 0  |I|  105 mA

105 mA < |I|  1.05 A 21 V 21 V

0  |I|  1.05 A ― 200 V 50 s  t  2.5 ms

― 180 V 50 s  t  10 ms

1.5 A 0  |I|  105 mA 210 V 210 V 50 s  t  tmax

105 mA < |I|  1.515 A 21 V 21 V

0  |I|  1.515 A ― 200 V 50 s  t  2.5 ms

0  |I|  1.05 A ― 180 V 50 s  t  10 ms

3 A 100 A 10 A 0  |I|  105 mA 210 V 210 V 50 s  t  tmax

105 mA < |I|  1.515 A 21 V 21 V

1.515 A < |I|  3.03 A 6 V 6 V

10 A 0  |I|  10.5 A ― 6 V 50 s  t  1 ms

0  |I|  1.515 A ― 200 V 50 s  t  2.5 ms

0  |I|  1.05 A ― 180 V 50 s  t  10 ms
2- 12 Agilent B2900 User’s Guide, Edition 2



Introduction

Source/Measure Unit
Table 2-3 Voltage Output Range

a. Table 2-4 shows the limitations when using Channels 1 and 2 for DC output or Pulsed output 
with 50 s  t  tmax (=99.9999 ks).

b. Maximum base current is 500 mA for the pulse with 50 s  t  1 ms, and 50 ms for the pulse 
with 50 s  t  2.5 ms or 50 s  t  10 ms.

c. Maximum duty cycle is 99.9999 % for the pulse with 50 s  t  tmax, and 2.5 % for the pulse 

with 50 s  t  1 ms, 50 s  t  2.5 ms, or 50 s  t  10 ms.
d. Available for the B2911A and B2912A. Not available for the B2901A and B2902A.

Range 
value

Setting resolution
DC output voltage 
or pulse peak/base 

voltage

Maximum current a

a. Table 2-4 shows the limitations when using Channels 1 and 2 for DC output or Pulsed output 
with 50 s  t  tmax (=99.9999 ks).

Pulse width t b

b. Maximum duty cycle is 99.9999 % for the pulse with 50 s  t  tmax, and 2.5 % for the pulse 

with 50 s  t  1 ms, 50 s  t  2.5 ms, or 50 s  t  10 ms.

B2901A 
B2902A

B2911A 
B2912A

DC 
output

Pulsed 
output

0.2 V 1 V 0.1 V 0  |V|  0.21 V 3.03 A 3.03 A with 50 s  t  tmax

10.5 A with 50 s  t  1 ms2 V 10 V 1 V 0  |V|  2.1 V

20 V 100 V 10 V 0  |V|  6 V

6 V < |V|  21 V 1.515 A 1.515 A with 50 s  t  tmax

200 V 1 mV 100 V 0  |V|  6 V 3.03 A 3.03 A with 50 s  t  tmax

10.5 A with 50 s  t  1 ms

6 V < |V|  21 V 1.515 A 1.515 A 50 s  t  tmax

21 V < |V|  210 V 105 mA 105 mA

0  |V|  180 V ― 1.05 A 50 s  t  10 ms

0  |V|  200 V ― 1.515 A 50 s  t  2.5 ms
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Table 2-4 Limitations for using Channels 1 and 2

Table 2-5 Current Measurement Range

Channel 1 voltage V1 Channel 2 voltage V2 Current limit a

a. I1: Channel 1 current, I2: Channel 2 current

0 < |V1|  6 V 0 < |V2|  6 V I1 + I2  4 A

6 V < |V2|  21 V I1 + I2  1.6  4 A

6 V < |V1|  21 V 0 < |V2|  6 V I1 + I2  0.625  2.5 A

6 V < |V2|  21 V I1 + I2  2.5 A

Range value Current measurement value Resolution

10 nA a

a. Available for the B2911A and B2912A. Not available for the B2901A 
and B2902A.

0  |I|  10.6 nA 10 fA

100 nA 0  |I|  106 nA 100 fA

1 A 0  |I|  1.06 A 1 pA

10 A 0  |I|  10.6 A 10 pA

100 A 0  |I|  106 A 100 pA

1 mA 0  |I|  1.06 mA 1 nA

10 mA 0  |I|  10.6 mA 10 nA

100 mA 0  |I|  106 mA 100 nA

1 A 0  |I|  1.06 A 1 A

1.5 A 0  |I|  1.53 A

3 A 0  |I|  3.06 A 10 A

10 A b

b. Available for pulse mode. Not available for DC mode.

0  |I|  10.6 A
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Table 2-6 Voltage Measurement Range

Table 2-7 Resistance Measurement Range1

Range value Voltage measurement value Resolution

0.2 V 0  |V|  0.212 V 0.1 V

2 V 0  |V|  2.12 V 1 V

20 V 0  |V|  21.2 V 10 V

200 V 0  |V|  212 V 100 V

Range value Resistance measurement value
Display 

resolution
Test 

current

2  0 < R  2  1  1A

20  2  < R  20  10  100 mA

200  20  < R  200  100  10 mA

2 k 200  < R  2 k 1 m 1 mA

20 k 2 k < R  20 k 10 m 100 A

200 k 20 k < R  200 k 100 m 10 A

2 M 200 k < R  2 M 1  1 A

20 M 2 M < R  20 M 10  100 nA

200 M 20 M < R  200 M 100  10 nA

1. The resistance measurement range is effective for the resistance measurements set to the AUTO 
mode which is selected by the :SENS:RES:MODE command.
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Specifications
This chapter lists specifications and supplemental information for the Agilent 
B2900 series. The specifications are the standards against which the B2900 is tested. 
When the B2900 is shipped from the factory, it meets the specifications.

Specification Conditions

The source and measurement accuracy are specified under the conditions listed 
below.

1. Temperature: 23 C ± 5 C

2. Humidity: 30 % to 80 % RH

3. After 60 minutes warm-up

4. Ambient temperature change less than ± 3 C after self-calibration execution

5. Calibration period: 1 year

6. Measurement speed: 1 PLC (Power Line Cycle)

Maximum Voltage and Current

• Voltage output range: See Figure 2-2, Table 2-3, and Table 2-4.

• Current output range: See Figure 2-2, Table 2-2, and Table 2-4.

Source Specifications

• Voltage source specifications: See Table 2-8.

• Current source specifications: See Table 2-9.

Measurement Specifications

• Voltage measurement specifications: See Table 2-10.

• Current measurement specifications: See Table 2-11.
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Table 2-8 Voltage Source Specifications

Table 2-9 Current Source Specifications

Range

Programming resolution Accuracy 
(gain error (% of 
reading) + offset 

error)

Noise a 
(peak-peak) 

0.1 Hz to 10 Hz

a. Supplemental characteristics

Maximum 
voltage 

(over range)
B2901A 
B2902A

B2911A 
B2912A

200 mV 1 V 0.1 V (0.015 % + 225 V)  10 V 210 mV

2 V 10 V 1 V (0.02 % + 350 V)  20 V 2.1 V

20 V 100 V 10 V (0.015 % + 5 mV)  200 V 21 V

200 V 1 mV 100 V (0.015 % + 50 mV)  2 mV 210 V

Range

Programming resolution Accuracy 
(gain error (% of 
reading) + offset 

error)

Noise a 
(peak-peak) 

0.1 Hz to 10 Hz

a. Supplemental characteristics

Maximum 
current 

(over range)
B2901A 
B2902A

B2911A 
B2912A

10 nAb

b. 10 nA range is not available for B2901A/B2902A.

― 10 fA (0.10 % + 50 pA)  1 pA 10.5 nA

100 nA 1 pA 100 fA (0.06 % + 100 pA)  2 pA 105 nA

1 A 10 pA 1 pA (0.025 % + 500 pA)  25 pA 1.05 A

10 A 100 pA 10 pA (0.025 % + 1.5 nA)  60 pA 10.5 A

100 A 1 nA 100 pA (0.02 % + 25 nA)  2 nA 105 A

1 mA 10 nA 1 nA (0.02 % + 200 nA)  6 nA 1.05 mA

10 mA 100 nA 10 nA (0.02 % + 2.5 V)  200 nA 10.5 mA

100 mA 1 A 100 nA (0.02 % + 20 V)  600 nA 105 mA

1 A 10 A 1 A (0.03 % + 1.5 mA)  70 A 1.05 A

1.5 A 10 A 1 A (0.05 % + 3.5 mA)  100 A 1.515 A

3 A 100 A 10 A (0.4 % + 7 mA)  120 A 3.03 A

10 Ac

c. 10 A range is available only for pulse mode, not available for DC mode.

100 A 10 A (0.4 % + 25 mA)d

d. Measurement speed: 0.01 PLC

― 10.5 A
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Table 2-10 Voltage Measurement Specifications

Table 2-11 Current Measurement Specifications

Range

Measurement resolution Accuracy 
(gain error (% of reading) 

+ offset error)
B2901A 
B2902A

B2911A 
B2912A

200 mV 0.1 V 0.1 V (0.015 % + 225 V)

2 V 1 V 1 V (0.02 % + 350 V)

20 V 10 V 10 V (0.015 % + 5 mV)

200 V 100 V 100 V (0.015 % + 50 mV)

Range

Measurement resolution Accuracy 
(gain error (% of reading) 

+ offset error)
B2901A 
B2902A

B2911A 
B2912A

10 nAa

a. 10 nA range is not available for B2901A/B2902A.

― 10 fA (0.10 % + 50 pA)

100 nA 100 fA 100 fA (0.06 % + 100 pA)

1 A 1 pA 1 pA (0.025 % + 500 pA)

10 A 10 pA 10 pA (0.025 % + 1.5 nA)

100 A 100 pA 100 pA (0.02 % + 25 nA)

1 mA 1 nA 1 nA (0.02 % + 200 nA)

10 mA 10 nA 10 nA (0.02 % + 2.5 V)

100 mA 100 nA 100 nA (0.02 % + 20 V)

1 A 1 A 1 A (0.03 % + 1.5 mA)

1.5 A 1 A 1 A (0.05 % + 3.5 mA)

3 A 10 A 10 A (0.4 % + 7 mA)

10 Ab

b. 10 A range is available only for pulse mode, not available for DC mode.

10 A 10 A (0.4 % + 25 mA)c

c. Measurement speed: 0.01 PLC
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Source Supplemental Characteristics

• Temperature coefficient (0 C to 18 C and 28 C to 50 C):

(0.1  Accuracy specification) / C

• Maximum output power and source/sink limits:

31.8 W. 6 V@ 3.03 A, 21 V@ 1.515 A, 210 V@ 105 mA, four quadrant 
source or sink operation.

• Current limit/compliance:

Accuracy is same as current source. Minimum value is 1 % of range, or 1 nA in 
10 nA range.

• Voltage limit/compliance:

Accuracy is same as voltage source. Minimum value is 1 % of range, or 20 mV 
in 200 mV range.

• Over range:

101 % of source range for 1.5 A and 3 A ranges. 105 % of source range other 
than 1.5 A and 3 A ranges. No over range for 200 V range with current 
exceeding 105 mA pulse only condition.

• Over temperature protection:

Turns off all channel outputs and locks the causal channel at over temperature 
sensed internally.

• Voltage output settling time:

Time required to reach within 0.1 % of final value at open load condition. Step is 
+10 % to +90 % range.

200 mV and 2 V ranges: < 50 s

20 V range: < 110 s

200 V range: < 700 s
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• Current output settling time:

Time required to reach within 0.1 % (0.3 % for 3 A range) of final value at short 
condition. Step is +10 % to +90 % range.

10 nA and 100 nA ranges: < 10 ms

1 A range: < 500 s

10 A and 100 A ranges: < 250 s

1 mA to 3 A ranges: < 80 s

• Noise 10 Hz to 20 MHz (V source): 3 mVrms, 20 V range

• V source overshoot:

< (0.1 % + 10 mV) Step is +10 % to +90 % range, resistive load.

• I source overshoot:

< 0.1 % (0.3 % for 3 A range) Step is +10 % to +90 % range, resistive load.

• Voltage source range change overshoot:

 250 mV. 100 k load, 20 MHz bandwidth

• Current source range change overshoot:

 250 mV/R load, 20 MHz bandwidth

Pulse Source Supplemental Characteristics

• Minimum programmable pulse width: 50 s

• Pulse width programming resolution: 1 s

• Pulse width definition:

The time from 10 % leading to 90 % trailing edge as follows.

• Maximum duty cycle and pulse width: See Table 2-12.

• Minimum pulse width at the given voltage, current, and settling conditions: See 
Table 2-13.

90 %

10 %

Pulse peak

Pulse width

Pulse base
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Measurement Supplemental Characteristics

• Temperature coefficient (0 C to 18 C and 28 C to 50 C):

(0.1  Accuracy specification) / C

• Over range:

102 % of measurement range for 1.5 A and 3 A ranges. 106 % of measurement 
range other than 1.5 A and 3 A ranges.

• Voltage measurement range change overshoot:

< 250 mV. 100 k load, 20 MHz bandwidth

• Current measurement range change overshoot:

< 250 mV/R load, 20 MHz bandwidth

• Derating accuracy for measurement speed less than 1 PLC:

Add % of range using Table 2-14 for measurement with PLC < 1.

Triggering and Timing Specifications

Triggering (Supplemental Characteristics)

• Digital I/O trigger in to trigger out:  5 s

• Digital I/O trigger in to source change:  5 s

• LXI trigger in to source change:  200 s

Timer

• Trigger timing resolution: 1 s to 100 ms

• Timer accuracy: 50 ppm

• Arm/trigger delay: 0 to 100000 s

• Arm/trigger interval:

• B2901A/B2902A: 20 s to 100000 s

• B2911A/B2912A: 10 s to 100000 s

• Arm/trigger event: 1 to 100000

• Time stamp: TIMER value automatically saved when each measurement is 
triggered.
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Table 2-12 Maximum Duty Cycle and Pulse Width

Table 2-13 Minimum Pulse Width at the Given Voltage, Current, and Settling Conditions

Table 2-14 Derating Accuracy with PLC Setting < 1 PLC

Maximum 
duty cycle

Pulse width
Maximum 

voltage
Maximum peak 

current
Maximum base 

current

99.9999 % 50 s to 99999.9 s 6 V 3.03 Aa

a. Max current limitation: For 21 V/1.515 A and 6 V/3.03 A ranges, total max current is limited as 
shown in Table 2-4 for using 2 channels. Max current is not limited for using 1 channel only.

3.03 Aa

21 V 1.515 Aa 1.515 Aa

210 V 0.105 A 0.105 A

2.5 % 50 s to 1 ms 6 V 10.5 A 500 mA

50 s to 10 ms 180 V 1.05 A 50 mA

50 s to 2.5 ms 200 V 1.515 A 50 mA

Source value Limit value Load
Source settling 
(% of range)

Minimum pulse 
width

200 V 1.5 A 200  0.1 % 1 ms

6 V 10.5 A 0.6  0.1 % 0.2 ms

1.5 A 200 V 65  0.1 % 2.5 ms

10.5 A 6 V 0.5  0.1 % 0.2 ms

PLC setting
Voltage range Current range

0.2 V 2 V to 200 V 10 nA 100 nA 1 A to 100 mA 1 A to 3 A

0.1 PLC 0.01 % 0.01 % 0.1 % 0.01 % 0.01 % 0.01 %

0.01 PLC 0.05 % 0.02 % 1 % 0.1 % 0.05 % 0.02 %

0.001 PLC 0.5 % 0.2 % 5 % 1 % 0.5 % 0.2 %
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Other Supplemental Characteristics

Output Characteristics

• Sensing modes: 2-wire or 4-wire (remote-sensing) connections

• Low terminal connection: Chassis grounded or floating

• Output connectors:

Banana jack. Triaxial connections are recommended for sourcing and measuring 
less than 1 nA. A banana jack to triaxial adapter is available for low current 
measurement.

• Output location: Channel 1 at front and channel 2 at rear

• Maximum load:

• Normal mode: 0.01 F

• High capacitance mode: 50 F

• DC floating voltage: Maximum 250 V DC between Low Force and chassis 
ground

• Guard offset voltage (V source): < 4 mV

• Remote sense operation range:

• Maximum voltage between High Force and High Sense: 3 V

• Maximum voltage between Low Force and Low Sense: 3 V

• Common mode isolation: > 1 G, < 4500 pF

• Maximum sense lead resistance: 1 k for rated accuracy

• Sense input impedance: > 10 G
Agilent B2900 User’s Guide, Edition 2 2- 23



Introduction

Specifications
High Capacitance Mode

The high capacitance mode permits the measurement of devices with capacitances 
greater than the normal mode maximum load value of 0.01 F. In high capacitance 
mode, the maximum allowed value of the load capacitance is 50 F.

• Voltage output settling time:

Time required to reach within 0.1 % of final value with 4.7 F capacitive load 
on a fixed range at specified current limit value.

200 mV and 2 V Ranges: 600 s, at 1 A limit

20 V Range: 1.5 ms, at 1 A limit

200 V Range: 20 ms, at 100 mA limit

• Current measurement settling time:

Time required to reach within 0.1 % of final value after voltage source is 
stabilized on fixed range. Vout is 5 V unless noted.

1 A range: 230 ms

10 A and 100 A ranges: 23 ms

1 mA and 10 mA ranges: 0.23 ms

100 mA to 3 A ranges: 100 s

• Mode change delay:

• Delay into High Capacitance mode:

1 A range: 230 ms

10 A and 100 A ranges: 23 ms

1 mA to 3 A ranges: 1 ms

• Delay out of High Capacitance mode:

All ranges: 10 ms

• Noise 10 Hz to 20 MHz (20 V range): 4.5 mVrms

• Voltage source range change overshoot (20 V range or below):

< 250 mV, 20 MHz bandwidth
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• High Capacitance mode working conditions:

• V/I mode: Voltage source mode only

• Range: Current measurement range is limited to fixed range only. 10 nA and 
100 nA ranges are not available.

• Current limit: 1 A

Resistance Measurement

Resistance measurement can be performed under either auto or manual test 
conditions. Auto resistance measurement is performed in current source and voltage 
measurement mode. The total auto resistance measurement error is shown in Table 
2-15. The total error of a manual resistance measurement can be calculated using the 
voltage and current accuracy information as shown below.

• Source I mode, manual ohm measurement (4-wire):

Total error = Vmeasure / Isource = R reading  (gain error of V range + gain 
error of I range + offset error of I range / I source value  100) % + (offset error 
of V range / I source value)

where, gain error and offset error can be given by Table 2-9 and Table 2-10.

• Source V mode, manual ohm measurement (4-wire):

Total error = Vsource / Imeasure = 1/ [1/R reading  (gain error of I range + gain 
error of V range + offset error of V range / V source value  100) % + (offset 
error of I range / V source value)]

where, gain error and offset error can be given by Table 2-8 and Table 2-11.

• Measurement speed = 1 PLC

• Applicable for temperature: 23 C  5 C

• Example of total error calculation:

I source value = 1 mA at 1 mA range

V measure range = 2 V range

Total error (% reading + offset) = (0.02 % + 0.02 % + 200 nA/1 mA  100) % + 
(350V/1mA) = 0.06 % + 0.35 

System Speeds

• Maximum sweep operation reading rates (reading/second) for 50 Hz: See Table 
2-16.
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Table 2-15 Typical Performance of Auto Resistance Measurement (4-wire), 2 V range

Table 2-16 Maximum Sweep Operation Reading Rates (reading/second) for 50 Hz

Operation reading rate varies with number of sweep steps 1 to 2500.

Range
Display 

resolution
Test 

current
Current 

range
Total error 

(% reading + offset)

2  1  1A 1A 0.2 % + 0.00035 

20  10  100 mA 100 mA 0.06 % + 0.0035 

200  100  10 mA 10 mA 0.065 % + 0.035 

2 k 1 m 1 mA 1 mA 0.06 % + 0.35 

20 k 10 m 100 A 100 A 0.065 % + 3.5 

200 k 100 m 10 A 10 A 0.06 % + 35 

2 M 1  1 A 1 A 0.095 % + 350 

20 M 10  100 nA 100 nA 0.18 % + 3.5 k

200 M 100  10 nA 100 nA 1.08 % + 35 k

Measure 
speed

Measure to 
memory

Measure to 
GPIB

Source 
measure to 

memory

Source 
measure to 

GPIB

< 0.001 PLC 20000 12500 19500 12500

0.01 PLC 4500 3950 4500 3950

0.1 PLC 500 490 500 490

1 PLC 49 49 49 49
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General Specifications

• Environment

For use in indoor facilities

• Temperature range

Operating 0 C to +55 C

Storage -30 C to +70 C

• Humidity range

Operating 30 % to 80 %RH, non-condensing

Storage 10 % to 90 %RH, non-condensing

• Altitude

Operating 0 m to 2,000 m (6,561 ft.)

Storage 0 m to 4,600 m (15,092 ft.)

• Power requirement: 90 V to 264 V, 47 Hz to 63 Hz

• Maximum volt-amps (VA): 250 VA

• Cooling

Forced air. Side intake and rear exhaust.

• Regulatory compliance

EMC IEC61326-1 / EN61326-1
AS/NZS CISPR 11

Safety IEC61010-1 / EN61010-1
CAN/CSA-C22.2 No. 61010-1-04, C/US

• Certifications: CE, cCSAus, C-Tick

• Dimensions

Without handle and feet: 88 mm (H)  213 mm (W)  450 mm (D)

Bench configuration (with handle and feet): 180 mm (H)  260 mm (W)  480 
mm (D)

• Weight

B2901A/B2911A: 5.0 kg

B2902A/B2912A: 6.4 kg
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Operation and Functions

Front Panel Interface

4.3” color TFT WQVGA (480272, with LED backlight) provides a graphical user 
interface (GUI) with the following features.

• 4-view modes (Single, Dual, Graph, Roll view)

• Easy-to-use key operations

• Easy access to basic and advanced source/measurement capabilities

Single view

Single view provides basic and advanced settings and display capabilities for the 
selected channel from the front panel of the instrument. No additional controller or 
software is required.

Dual view

Dual view provides the basic settings and display capabilities for both channels 1 
and 2. Up to 6½ digits can be displayed in the Dual view mode. This mode is 
available only for the B2902A and B2912A.

Graph View

Graph View displays measurement results on XY graphs (such as I-V and I-t/V-t 
curves) on up to 2 channels. This is useful for quick evaluation of device 
characteristics, especially those obtained from sweep measurements.

Roll View

Roll view draws I-t or V-t curves similar to the curves drawn by a strip chart 
recorder. Up to 1000 acquired data points can be displayed and updated while the 
measurement is still in progress. Roll view’s continuous measurement capability is 
especially useful for monitoring low frequency phenomena. Roll view is available 
only for the B2911A and B2912A.

Easy-to-use Key Operations

• Numeric/alpha keys, assist keys, and rotary knob for easy operation

• Numeric/alpha keys enable direct input of alphanumeric values.

• Assist key guides operation on the front panel.
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Easy Access to Source/Measurement Capabilities

• Settings:

• V/I source mode

• Source value

• Limit (Compliance) value

• Sweep parameters

• Pulse parameters

• Measure speed

• Range setting

• Trigger setting

• Result Displays:

• Numeric results fully up to 6½ digits both in Single and Dual view modes

• Characterization in Graph view and Roll view

• Data list

• Advanced Capabilities:

• Limit testing by user definable limits working with component handlers

• Trace memory for accumulating measurement (or math) result and collecting 
their statistics

• File Operations (USB memory):

Save:

• System configuration

• Measurement/Math result

• Limit test result

• Trace data

• Graph screen dump

Load:

• System configuration

• List sweep data
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Source/Measurement Capabilities

Sweep Measurement

• Number of steps: 1 to 2500

• Sweep mode: linear, logarithmic (log), or list

• Sweep direction: single or double

• Type: DC or pulse

• Minimum programmable value to create list sweep waveform:

B2901A/B2902A: 20 s with 1 s resolution

B2911A/B2912A: 10 s with 1 s resolution

Digitizing/Sampling Measurement

Digitizing/sampling measurement can be performed by appropriate setting of 
measure speed and trigger interval.

Minimum trigger interval (maximum speed of measurement):

B2901A/B2902A: 20 s (50000 points/s)

B2911A/B2912A: 10 s (100000 points/s)

Data Buffers

Data buffers are array of measurement elements. Each elements hold the following 
values.

• Measured voltage

• Measured current

• Measured resistance

• Time stamp

• Measurement status

• Source setting

Maximum buffer size: 100000 points/channel
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Program and Interface Capabilities

Programming Language

The B2900 supports SCPI (Standard Commands for Programmable Instruments).

• Default command set: Supports all of the advanced features of the B2900.

• Conventional command set: Supports industry standard conventional SCPI 
command set for basic compatibility.

Program Memory

Program memory allows you to store long strings of SCPI command lines once into 
the built-in volatile memory and then recall those strings multiple times while the 
program is executing using a single SCPI command. By storing the command 
strings in memory, the time that would have been spent sending those same 
commands over a communication bus is eliminated. For tests that utilize lots of 
repeated code (such as subroutines), program memory can dramatically reduce test 
times.

• Maximum number of characters of program name: 32 with alphabets, numbers, 
hyphens, and underscores

• Maximum memory size: 100 KB (2500 lines typical)

LXI

LXI Class-C compliant. The B2900 follows specified LAN protocols and adhere to 
LXI requirements such as a built-in Web control server and IVI-COM driver.

• Ethernet: 10/100Base-T

• USB2.0: USB-TMC488 protocol (rear  1)

• GPIB: IEEE-488.2 compliant

USB File System

USB 2.0 high-speed mass storage (MSC) class device (front  1)
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Digital I/O Interface

• Connector: 25-pin female D

• Input/output pins: 14 open drain I/O bits

• Absolute maximum input voltage: 5.25 V

• Absolute minimum input voltage: -0.25 V

• Maximum logic low input voltage: 0.8 V

• Minimum logic high input voltage: 2.0 V

• Maximum source current: 1 mA, Vout = 0 V

• Maximum sink current: 50 mA, Vout = 5 V

• 5 V power supply pin:

Limited to 600 mA, solid state fuse protected

• Safety interlock pin:

One active high pin and one active low pin. Activation of both pin enables 
output voltage > 42 V.
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Software and Drivers
• Agilent B2900A Quick I/V Measurement Software

The B2900 includes PC-based Agilent B2900A Quick I/V Measurement 
Software. This powerful software makes it easy to quickly setup and perform 
I/V measurements and to display the measurement data in a table or graph 
without the need to perform any programming. The software allows you to 
control up to four SMU channels over a GPIB or LAN connection, or one B2900 
unit via a USB connection.

Operating System: Windows 7 (64 bit/32 bit), XP SP3 (32 bit)

Other requirements: Microsoft .NET framework 4.0 or later and Agilent IO 
Libraries 16.0 or later

• Agilent B2900A Graphical Web Interface

The Agilent B2900A Graphical Web Interface is a web browser based 
instrument control panel. It enables you to set up and perform a measurement 
easily and quickly from a web browser using the built-in web server. This allows 
you to control one B2900 unit over a LAN connection.

• IVI-C or IVI-COM drivers

Compatible with Windows 7 (64 bit/32 bit), XP SP2 (32 bit) IO Libraries 16.0 or 
later. Supports Agilent VEE, Microsoft Visual Studio (Visual Basic, Visual C++, 
Visual C#), National Instruments LabWindows and LabVIEW.

• LabVIEW driver (VI)

National Instruments LabVIEW 7.0 or later. LabView drivers are available at 
NI.COM.

NOTE For the latest system requirements, go to www.agilent.com and type in B2900A in 
the Search field at the top of the page. 
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Furnished Accessories

The Agilent B2900 is furnished with the following accessories.

• Quick Reference, 1 ea.

• Product Reference CD-ROM, 1ea.

• Agilent IO Libraries CD-ROM, 1ea.

• Power cord, 1 ea.

• USB cable, 1 ea.

The Product Reference CD-ROM stores Agilent B2900A Quick I/V Measurement 
Software, sample programs, user manuals, and application notes.

Available Accessories

Table 2-17 lists the available accessories for the Agilent B2900.

Table 2-17 Available Accessories

Model Number Option Item Description 

N1294A Accessories

N1294A-001 Banana to triaxial adapter for 2-wire connections

N1294A-002 Banana to triaxial adapter for 4-wire connections

N1294A-011 Interlock cable for 16442B, 1.5 m

N1294A-012 Interlock cable for 16442B, 3.0 m

N1295A Device/Component Test Fixture
2- 34 Agilent B2900 User’s Guide, Edition 2



Introduction

Accessories
16442B Test Fixture

16442B-010 Add triaxial cables, 1.5 m, 4 ea.

16442B-011 Add triaxial cables, 3 m, 4 ea.

16442B-800 Extra blank Teflon board

16442B-801 Universal socket module, 0.1 inch pitch, with 10 pins

16442B-802 Universal socket module, 0.075 inch pitch, with 10 pins

16442B-803 Universal socket module, 0.05 inch pitch, with 10 pins

16442B-810 Extra pin set (for universal socket module, 10 pins.)

16442B-811 Extra wire set (mini banana to pin plug, 6 ea.)

16442B-812 Extra wire set (pin plug to pin plug, 6 ea.)

16442B-813 Extra wire set (mini banana to mini clip, 6 ea.)

16442B-814 Extra wire set (mini banana to mini banana, 6 ea.)

16442B-821 Socket module, 4-pin TO package

16442B-822 Socket module, 18-pin DIP package

16442B-823 Extra socket module, 28-pin DIP package

16442B-890 Extra accessory case

16493G Digital I/O Connection Cable

16493G-001 1.5 m length

16493G-002 3.0 m length

16494A Triaxial Cable

16494A-001 1.5 m length

16494A-002 3 m length

16494A-003 80 cm length

Model Number Option Item Description 
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Table 2-18 lists the options for the Agilent B2900.

Table 2-18 Options

Option Description 

Calibration

A6J ANSI Z540 compliant calibration

UK6 Commercial calibration certificate with test data

Printed Manual (User’s Guide)

AB0 Traditional Chinese

AB2 Simplified Chinese

ABA English

ABJ Japanese

Rack Mount Kit

1CM Rack mount kit
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Installation
This chapter describes how to install Agilent B2900 and accessories and consists of 
the following sections.

• “Inspecting the Shipment”

• “Installing the Agilent B2900”

• “Maintenance”

• “Connecting a DUT”

• “Installing the Interlock Circuit”

• “Connecting to the Interfaces”

• “Communicating Over the LAN”

• “Using Digital I/O”

WARNING There are potentially hazardous voltages (210 V) present at the High Force, 
High Sense, and Guard terminals of Agilent B2900. To prevent electrical shock, 
the following safety precautions must be observed during the use of the B2900.

• Use a three-conductor AC power cord to connect the cabinet (if used) and 
the B2900 to an electrical ground (safety ground).

• If you do not use the Agilent 16442B test fixture, you must install and 
connect an interlock circuit that opens the interlock terminal when the 
shielding box access door is opened.

• Confirm periodically that the interlock function works normally.

• Before touching the connections on the High Force, High Sense, and 
Guard terminals, turn the B2900 off and discharge any capacitors. If you 
do not turn the B2900 off, complete all of the following items, regardless 
of the B2900 settings.

• Press the On/Off switch, and confirm that the switch turns off.

• Confirm that the On/Off switch does not turn red.

• Open the shielding box access door (open the interlock terminal).

• Discharge any capacitors connected to a channel.

• Warn persons working around the B2900 about dangerous conditions.
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Inspecting the Shipment 
Perform the following inspections when the Agilent B2900 and accessories arrive at 
your site.

1. Before unpacking any component, inspect all boxes for any signs of damage that 
might have occurred during shipment, such as:

• dents

• scratches

• cuts

• water marks

If you suspect any damage, contact your nearest Agilent Sales and Support 
Office.

2. When you open the boxes that contain the B2900 and accessories, check the 
components against the contents lists attached to the boxes.

If anything is missing, contact your nearest Agilent Sales and Support Office.

3. Verify the operation of B2900 as described in “Checking the Operation of 
Agilent B2900”.

If any problem occurs, contact your nearest Agilent Sales and Support Office.

Checking the Operation of Agilent B2900

1. Make sure that the line switch is set to off.

2. Connect the power cord from the B2900’s rear panel AC input connector 
(receptacle) to an AC power outlet at your site.

3. Press the line switch to turn on the instrument. 

The initialization screen will appear on the B2900’s front panel display, and the 
power-on self-test is automatically executed. 

If the B2900 is operating normally, the front panel LCD displays as shown in 
Figure 3-1 or 3-2.
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Figure 3-1 Display Example for 1-ch Model

Figure 3-2 Display Example for 2-ch Model

Checking for Errors

Errors can be checked as described below.

1. Press the More > System > Error > Log function keys. This opens the Error Log 
dialog box.

2. Check the errors displayed on the dialog box.

If no error is detected, “0, No Error” is displayed.

3. Press the OK softkey to close the dialog box.
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Installing the Agilent B2900
This section describes information you must pay attention to when installing the 
Agilent B2900.

• “Safety Considerations”

• “Environment”

• “Connecting the Power Cord”

• “Setting the Power Line Frequency”

• “Bench Installation”

• “Rack Installation”

Safety Considerations

Refer to the Safety Summary page at the beginning of this guide for general safety 
information. Before installation or operation, check the B2900 and review this guide 
for safety warnings and instructions. Safety warnings for specific procedures are 
located at appropriate places throughout this guide.

Environment

WARNING Do not operate the instrument in the presence of flammable gasses or fumes

Environmental conditions for B2900 are documented in “General Specifications” on 
page 2-27. In principle, B2900 should only be operated indoors in a controlled 
environment.

The dimensions of B2900 are also given in “General Specifications”. Fan cools the 
instrument by drawing air through the sides and exhausting it out the back. The 
instrument must be installed in a location that allows sufficient space at the sides 
and back of the instrument for adequate air circulation.

Connecting the Power Cord

WARNING FIRE HAZARD: Use only the power cord supplied with your instrument. 
Using other types of power cord may cause overheating of the power cord, 
resulting in fire.
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SHOCK HAZARD: The power cord provides the chassis ground through a 
third conductor. Be sure to connect to a three-conductor type power outlet with 
the correct pin grounded.

NOTE The detachable power cord may be used as an emergency disconnecting device. 
Removing the power cord will disconnect AC input power to the instrument.

Connect the power cord to the IEC 320 connector on the rear of the instrument. If 
the wrong power cord was shipped with your instrument, contact your nearest 
Agilent Sales and Support Office.

The AC input on the back of your instrument is a universal AC input. It accepts 
nominal line voltages in the range of 100 to 240 VAC.

Setting the Power Line Frequency

The power line frequency must be set properly for the AC power at your site. Press 
the following function keys to set the frequency to 50 Hz or 60 Hz.

• For setting to 50 Hz: More > System > PLC > 50 Hz

• For setting to 60 Hz: More > System > PLC > 60 Hz

Bench Installation

Do not block the air intake at the sides and the exhaust at the rear of the B2900. 
Minimum clearances for bench operation are 5 mm along the sides and 100 mm 
along the back.

For easier display viewing and measurement terminal access, you can tilt up the 
front of the instrument by turning the handle. To adjust the handle, grab the handle 
by the sides and pull outward. Then, rotate the handle to the desired position.
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Rack Installation

NOTE Use the Rack Mount kit (Option 1CM) to rack mount the Agilent B2900.

Agilent B2900 can be mounted in a 19-inch EIA rack cabinet. It is designed to fit in 
two rack-units (2U) of space.

Remove the front and rear rubber bumpers and the handle before rack mounting the 
B2900.

Do not block the air intake at the sides and the exhaust at the rear of the B2900.

Removing the Bumper

Stretch a corner of the rubber bumper and slide it off. 

Removing the Handle

1. Grab the handle by the sides and pull outward. This will allow you to rotate the 
handle.

2. Rotate the handle to a vertical position. Then, position the instrument 
horizontally.

3. Pull outward and then lift the handle upward.

CAUTION When reattaching the handle, pay attention to its direction. Incorrect attachment 
may damage the hardware.

1 1

2

3
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Maintenance
Maintenance should be performed periodically to keep the Agilent B2900 in good 
condition. If problems arise, contact your nearest Agilent Sales and Support Office.

• “Cleaning”

• “Self-test”

• “Self-calibration”

• “Calibration”

Cleaning

WARNING SHOCK HAZARD: To prevent electric shock, unplug the B2900 before 
cleaning.

Use a dry cloth or a cloth slightly dampened with water to clean the external case 
parts. Do not use detergents or chemical solvents. Do not attempt to clean internally.

Self-test

Agilent B2900 provides the self-test function to check the operation. The self-test is 
automatically performed when the instrument is turned on. It is recommended to 
perform the self-test for the following condition or purpose. Before performing the 
self-test, turn the channel output off and disconnect test leads and cables from the 
terminals.

• If a channel is in the lock condition due to over temperature

In this condition, the Emergency dialog box is displayed on the gray background 
screen, however this is not shown in the remote status if the remote display is set 
to OFF. And the ERR indicator turns on and the On/Off switch is not effective. 

Perform the self-test to unlock the channel. The channel can be used soon if the 
self-test does not report any problem. 

• If you feel that the instrument may be defective

• For preventive maintenance

To perform 
self-test

The following procedure shows how to perform the self-test.
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1. If it is in the remote state, press the Cancel / Local key.

2. Press the On/Off switch and confirm that the switch turns off.

3. Disconnect test leads and cables from the channel terminals.

4. Press the following function keys.

More > System > Cal/Test > Self-Test

Confirmation dialog box is opened.

5. Press the OK key. This starts the self-test.

Self-calibration

Agilent B2900 provides the self-calibration function to maintain the measurement 
performance. If the environmental temperature changes 3 C or more, perform the 
self-calibration. This is effective for the accurate measurements by minimizing the 
effect of thermal drift. The self-calibration must be performed after warming-up of 
60 minutes. Before performing the self-calibration, turn the channel output off and 
disconnect test leads and cables from the terminals.

To perform 
self-calibration

The following procedure shows how to perform the self-calibration.

1. If it is in the remote state, press the Cancel / Local key.

2. Press the On/Off switch and confirm that the switch turns off.

3. Disconnect test leads and cables from the channel terminals.

4. Press the following function keys.

More > System > Cal/Test > Self-Cal

Confirmation dialog box is opened.

5. Press the OK key. This starts the self-calibration.

Calibration

Calibration and adjustments must be performed periodically so that the instruments 
satisfy the specifications, and keep a good condition. It is recommended to perform 
the calibration once a year at least. For the calibration and adjustments, contact your 
nearest Agilent Sales and Support Office. Trained service personnel will perform the 
calibration and adjustments.
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Connecting a DUT
This section describes how to connect a device under test (DUT) to the Agilent 
B2900 source/measure terminals.

NOTE Set the channel output off when changing the connections. If not, the DUT may be 
damaged.

To set the channel output off, press the On/Off switch and confirm that the switch 
LED turns off.

This section includes the following descriptions.

• “2-Wire Connections or 4-Wire Connections”

• “Floating”

• “Using Test Leads”

• “Using the N1295A Test Fixture”

• “Using the 16442B Test Fixture”

• “Guarding”

• “Performing Low Current Measurements”

NOTE Connecting the interlock circuit

B2900 provides an interlock function to prevent the user from receiving an electrical 
shock from high voltages over 42 V. If the Digital I/O interlock terminal is open, 
B2900 cannot apply a high voltage.

For high voltage measurement, connect the interlock terminal to the interlock circuit 
as described in “Installing the Interlock Circuit” on page 3-19.
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2-Wire Connections or 4-Wire Connections

When connecting a DUT, you can choose the connection type either 2-wire 
connections or 4-wire connections.

If you want to simplify the connections, use 2-wire connections by connecting the 
Force terminals only and opening the Sense terminals. The Force terminals can be 
used to apply and measure DC voltage or current.

To make 4-wire connections, remote sensing, well known as Kelvin connections, 
use both Force and Sense terminals. Connecting the Force and Sense lines together 
at the terminal of the DUT minimizes the measurement error caused by the residual 
resistance of the test leads or cables. This connection is effective for low resistance 
measurements and high current measurements.

To specify the connection type (Sensing Type), perform the following procedure.

1. Press the Config > Source > Connection function keys. This opens the Output 
Connection dialog box.

2. Set the Sensing Type on this dialog box. Choose 2-WIRE for 2-wire 
connections, or 4-WIRE for 4-wire connections.

3. Press the OK softkey. For 4-wire connections, the following indicator appears 
on the Single view or the Dual view.

4-wire connection indicator: 

Figure 3-3 Dual View, 4-Wire Connection Setup for Channel 1
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Floating

With the default setting, Low Force and Low Sense terminals are connected to the 
chassis ground. However, they can be disconnected from the ground for floating 
measurements.

To specify the low terminal status, perform the following procedure. Setting is not 
saved. Turning off the instrument sets the status to the grounded.

1. Press the Config > Source > Connection function keys. This opens the Output 
Connection dialog box.

2. Set the Low Terminal State on this dialog box. It must be FLOATING for the 
floating status, or GROUNDED for the grounded status.

3. Press the OK softkey.

For the floating status, the following indicator appears on the status information 
area. And then the Low Force and Low Sense terminals can be connected to the 
maximum of 250 V.

Channel 1 floating status indicator: 

Channel 2 floating status indicator: 

Figure 3-4 Dual View, Floating Status for Channels 1 and 2

CAUTION Do not apply current to the chassis ground. Doing so will damage the B2900.

WARNING Potentially hazardous voltages of up to 250 V may be present at the Low 
Force and Low Sense terminals. To prevent electrical shock, use accessories 
that comply with IEC 61010-2-031. The terminals and the extended conductors 
must be isolated by using insulation caps, sleeves, etc.
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Using Test Leads

B2900 source/measure terminals use banana jacks. For connecting a DUT, the 
following test leads are available. Figure 3-5 shows the connections for 
two-terminal device measurements.

• Agilent U8201A Combo Test Lead Kit

Couple of test leads, test probes, alligator clips, SMT grabbers, fine-tips test 
probes, and banana plugs, CAT III 1000 V, 15 A maximum

Two kits are required for 4-wire connections.

• Agilent 11059A Kelvin Probe Set

Test leads for 4-wire connections, 42 V maximum

Figure 3-5 Connecting a Two-Terminal Device

High Sense

High Force

Low Force

Low Sense

DUT

High Force

Low Force

DUT

2-wire connections 4-wire connections
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Using the N1295A Test Fixture

Agilent N1295A is a test fixture which has four triaxial connectors and which 
supports two 2-wire connections.

Requirements • Agilent N1295A test fixture furnished with pin clip wire 4 ea. and pin plug wire 
2 ea.

• Agilent N1294A-001 banana to triaxial adapter for 2-wire connections

• Triaxial cable, 2 ea. for one 2-wire connection

Connections 1. Attach the banana to triaxial adapter to the B2900 source/measure terminals. See 
Figure 3-6. If there is some space as “Bad connection”, the contact is not 
enough.

2. Connect the triaxial cables between the adapter and N1295A as shown in Figure 
3-7.

3. Connect the DUT between terminals 1 and 2 for the example in Figure 3-7.

Figure 3-6 Attaching Banana to Triaxial Adapter

Figure 3-7 Agilent N1295A Connection Example

NOTE Shielding

N1295A is equipped with a lid. To minimize the effect of ambient noise, close the 
lid when performing measurements.

Bad connectionGood connection (no space)

1

1

2

3

4

3
2

4

± 42V � 1.05 A Max

Low Force

High Force

DUT
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CAUTION Maximum voltage and current

The test fixture and adapters must be used under the following limitations to prevent 
damage.

Agilent N1294A-001: 250 V maximum, 42 V maximum for connecting N1295A

Agilent N1294A-002: 250 V maximum, 42 V maximum for connecting N1295A

Agilent N1295A: 42 V, 1.05 A maximum

Using the 16442B Test Fixture

Agilent 16442B is a test fixture which has six triaxial connectors for source/measure 
unit (SMU), the GNDU connector for the ground unit of a parameter/device 
analyzer, the Intlk connector for the interlock control, and six coaxial connectors for 
other instruments. See Agilent 16442B User’s Guide for details and accessories of 
the 16442B.

Requirements • Agilent 16442B test fixture furnished with pin clip wire, pin plug wire, etc.

• Agilent N1294A-001 banana to triaxial adapter for 2-wire connections

• Agilent N1294A-002 banana to triaxial adapter for 4-wire connections

• Triaxial cable, 2 ea. for 2-wire connections, and 3 ea. for 4-wire connections

NOTE Shielding

16442B is equipped with a lid. To minimize the effect of ambient noise, close the lid 
when performing measurements.

CAUTION Maximum voltage and current

The test fixture and adapters must be used under the following limitations to prevent 
damage.

Agilent N1294A-001: 250 V maximum, 200 V maximum for connecting 16442B

Agilent N1294A-002: 250 V maximum, 200 V maximum for connecting 16442B

Agilent 16442B: 200 V, 1 A maximum for SMU input
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Connections 1. Attach the banana to triaxial adapter to the B2900 source/measure terminals. See 
Figure 3-6. If there is some space as “Bad connection”, the contact is not 
enough.

2. Connect the triaxial cables between the adapter and the 16442B. Figure 3-8 
shows a connection example.

3. Connect the DUT on the 16442B wiring panel by using the 16442B’s furnished 
accessories, socket module, blank board, and wire suitable for the DUT.

Figure 3-9 shows the connection example for the connections of Figure 3-8.

For 2-wire connections, connect the SMU 1 Force terminal to a DUT terminal, 
and connect the SMU 2 Force terminal to the other DUT terminal.

For 4-wire connections, connect the SMU 1 Force and Sense terminals to a DUT 
terminal. And connect the SMU 3 Sense and Guard terminals to the other DUT 
terminal if the adapter’s Low Force/Low Sense connector is connected to the 
SMU 3 Sense connector. The Low Force signal appears on the Guard terminal.

Figure 3-8 Connection Example between N1294A and 16442B

Figure 3-9 Connection Example of 16442B Wiring Panel

N1294A-001 Adapter
for 2-wire connections

N1294A-002 Adapter
for 4-wire connections

to SMU 2
       Force

to SMU 1 Force to SMU 1 Forceto SMU 1 Sense

to SMU 3 Sense
(or GNDU)

Low Force/
Low Sense

High Sense High Force

Low Force

High Force

SMU(±200V= 1A Max)

SenseForce

Guard Guard

1

SenseForce

Guard Guard

2

SenseForce

Guard Guard

3

DUT

SMU(±200V= 1A Max)

SenseForce

Guard Guard

1

SenseForce

Guard Guard

2

SenseForce

Guard Guard

3

2-wire connections 4-wire connections

DUT

(or GNDU Sense) (or GNDU Force)
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NOTE Performing high voltage measurement

When the Digital I/O interlock terminal is open, B2900 cannot apply high voltage 
over 42 V. To perform high voltage measurements, B2900 must be connected to 
the interlock circuit installed in 16442B. 

Prepare the N1294A-011 or 012 interlock cable, and connect it between the B2900 
Digital I/O connector and the 16442B Intlk connector. B2900 can apply a high 
voltage when the test fixture lid is closed.

WARNING Potentially hazardous voltages of up to 210 V may be present at the High 
Force, High Sense, and Guard terminals when the 16442B test fixture lid is 
closed. To prevent electrical shock, do not expose these lines.
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Guarding 

Guarding reduces the leakage current between the instrument and a DUT. This is 
important when you measure a low current.

Figure 3-10 shows the theory of guarding. The buffer amplifier (1) keeps the 
potential of the Guard conductor at the same potential as the High Force conductor, 
so that the current does not flow between the High Force and Guard conductors. 
Therefore, the current measured by the instrument is the same as the current at the 
DUT terminal because no current is leaked.

For the connection examples shown in Figures 3-7 and 3-8, the guard is extended to 
the test fixture input connectors with triaxial cables.

Figure 3-10 Guarding

CAUTION Never connect the Guard terminal to any output, including circuit common, chassis 
ground, or any other guard terminal. Doing so will damage the B2900.

Performing Low Current Measurements

With the default setting, 10 nA and 100 nA measurement ranges are not used. For 
the low current measurements, the measurement range settings must be changed.

To change the 
measurement 
range

1. Press the View key to display the Single view.

If the Range parameters are not displayed in the lower half of the Single view, 
press the More, Hide Sweep, Hide Pulse, or Hide Trigger assist key to display 
the Range parameters.

2. Change the setting of the Measure Amps field of the Range parameters.

Set AUTO for the auto ranging or FIXED for the fixed range.

Set 10 nA or 100 nA for the minimum or fixed measurement range.

A
Buffer

Guard High Force DUT
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Installing the Interlock Circuit 
The interlock circuit is a simple electric circuit, as shown in Figure 3-11. The circuit 
electrically opens when an access door is opened, and closes when the door is 
closed.

B2900 cannot apply high voltages over 42 V when the Digital I/O interlock 
terminal is open. To perform high voltage measurements, the B2900 interlock 
terminal must be connected to the interlock circuit installed in the measurement 
environment such as the shielding box. The interlock circuit is important and 
necessary to prevent electrical shock when the user touches the measurement 
terminals.

WARNING Potentially hazardous voltages of up to 210 V may be present at the High 
Force, High Sense, and Guard terminals when the interlock circuit is closed. 
To prevent electrical shock, do not expose these lines.

Requirements • LED (Agilent part number 1450-0641), 1 ea.

• Mechanical switch (Agilent part number 3101-0302 or 3101-3241), 2 ea.

• 25-pin D-sub connector (for wiring, mounted on the shielding box), 1 ea.

• Connection wire

• 25-pin D-sub cable, 1 ea.

Figure 3-11 Interlock Circuit

Mechanical switches

Shielding box

LED

Access door

D-sub connector

Interlock circuit B2900
Digital I/O

15, 19

14

17, 18

16

24, 25

Dsub cable

15, 19

22, 23

16, 17

24

14

Negative Positiveor
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Procedure 1. Mount two mechanical switches onto your shielding box, so that the switches 
close when the access door is closed, and open when the door is opened. See 
Figure 3-13 and Figure 3-14 for the switch dimensions.

2. Mount an LED onto your shielding box. See Figure 3-12 for the LED 
dimensions.

The LED is used as a high voltage indicator which is lit when B2900 is in the 
high voltage output status.

3. Mount a D-sub connector onto your shielding box.

4. Use a wire and short the following pins of the D-sub connector. See Figure 3-11 
for a connection example.

For the negative logic: Pins 24 and 25

For the positive logic: Pins 16 and 17

5. Use a wire and connect the two switches in series between the following pins of 
the D-sub connector. See Table 3-1 for the Digital I/O pin assignment.

For the negative logic: Pins 16 and some ground pins

The ground pins are pin numbers 15 and 17 to 21.

For the positive logic: Pins 24 and some +5 V pins

The +5 V pins are pin numbers 22, 23, and 25.

6. Use a wire and connect the LED between pin 14 and some ground pins of the 
D-sub connector. Then set pin 14 to HIGH VOLTAGE LAMP. See “DIO 
Configuration dialog box” on page 4-46.

Figure 3-12 Dimensions of the LED (Agilent part number 1450-0641) 
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Figure 3-13 Dimensions of the Interlock Switch (Agilent part number 3101-0302) 

Figure 3-14 Dimensions of the Interlock Switch (Agilent part number 3101-3241) 
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Connecting to the Interfaces

CAUTION Electrostatic discharges greater than 1 kV near the interface connectors may cause 
the unit to reset and require operator intervention.

B2900 supports GPIB, LAN, and USB interfaces. All three interfaces are live at 
power-on. Connect your interface cable to the appropriate interface connector. 
Information on configuring the interfaces can be found later in this section.

The front panel LAN indicator is lit when the LAN port is connected and 
configured.

B2900 provides Ethernet connection monitoring. With Ethernet connection 
monitoring, the instrument’s LAN port is continually monitored and automatically 
reconfigured.

GPIB/USB Interfaces

NOTE For detailed information about GPIB and USB interface connections, refer to 
Connectivity Guide installed with the Agilent IO Libraries.

The following steps will help you quickly get started connecting your instrument to 
the GPIB (General Purpose Interface Bus). The following figure illustrates a typical 
GPIB interface system.

Connect to GPIB interface
card installed in PC.

Connect to GPIB
port on instrument. InstrumentInstrument

Instrument

PCGPIB cable
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1. If you have not already done so, install the Agilent IO Libraries Suite from the 
CD shipped with your product.

2. If you do not have a GPIB interface card installed on your computer, turn off 
your computer and install the GPIB card.

3. Connect your instrument to the GPIB interface card using a GPIB interface 
cable.

4. Use the Connection Expert utility from the Agilent IO Libraries Suite to 
configure the installed GPIB interface card’s parameters.

5. B2900 is shipped with its GPIB address set to 23. To view or change the GPIB 
address, press the More function key, then the I/O > GPIB softkeys. The GPIB 
Configuration dialog box appears.

To change the GPIB address, use the rotary knob or the arrow keys, and press 
OK to set the value.

6. You can now use the Interactive IO within Connection Expert to communicate 
with your instrument, or program your instrument using various programming 
environments.

The following steps will help you quickly get started with connecting your 
USB-enabled instrument to the USB (Universal Serial Bus). The following figure 
illustrates a typical USB interface system.

1. If you have not already done so, install the Agilent IO Libraries Suite from the 
CD shipped with your product.

2. Connect the USB device port located on the back of your instrument to the USB 
port on your computer.

3. With the Connection Expert utility from the Agilent IO Libraries Suite running, 
the computer will automatically recognize the instrument. This may take several 
seconds. When the instrument is recognized, your computer will display the 
VISA alias, IDN string, and VISA address. This information is located in the 
USB folder.

Connect to USB
port on PC.

Connect to USB
port on instrument.

Instrument

PC

USB cable
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You can also view the instrument’s VISA address from the front panel. Press the 
More function key, then the I/O > USB softkeys. The VISA address is shown in 
the USB Status dialog box.

4. You can now use the Interactive IO within Connection Expert to communicate 
with your instrument, or program your instrument using various programming 
environments.

LAN Interface

NOTE For detailed information about LAN interface connections, refer to Connectivity 
Guide installed with the Agilent IO Libraries.

The following steps will help you quickly get started with connecting and 
configuring your instrument on a local area network.

Connecting to a Site LAN

A site LAN is a local area network in which LAN-enabled instruments and 
computers are connected to the network via routers, hubs, and/or switches. They are 
typically large, centrally-managed networks with services such as DHCP and DNS.

1. If you have not already done so, install the Agilent IO Libraries Suite from the 
CD shipped with your product.

2. Connect the instrument to the site LAN. The factory-shipped instrument LAN 
settings are configured to automatically obtain an IP address from the network 
using DHCP (DHCP is enabled). Note that this may take up to one minute. The 
DHCP server will register the instrument’s hostname with the dynamic DNS 
server. The hostname as well as the IP address can then be used to communicate 
with the instrument. The front panel LAN indicator will turn green when the 
LAN port has been configured successfully, or turn red if the configuration fails.

To network
interface card (NIC).

Connect to LAN
port on instrument.

Instrument

PC

LAN cable

To site LAN
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NOTE If you need to manually configure any instrument LAN settings, see “LAN 
Configuration dialog box” on page 4-46 for information about configuring the LAN 
settings from the front panel of the instrument.

3. Use the Connection Expert utility from the Agilent IO Libraries Suite to add the 
B2900 and verify the connection. To add the instrument, you can request 
Connection Expert to discover the instrument. If the instrument cannot be found, 
add the instrument using the instrument’s hostname or IP address.

NOTE If this does not work, refer to the troubleshooting section in the Agilent 
Technologies USB/LAN/GPIB Interfaces Connectivity Guide.

4. You can now use the Interactive IO within Connection Expert to communicate 
with your instrument, or program your instrument using various programming 
environments. You can also use the Web browser on your computer to connect to 
the instrument as described under “Using the Graphical Web Interface” on page 
3-26.

Viewing the Active LAN Status

To view the currently active LAN settings, press the More function key, then the I/O 
> LAN > Status softkeys. The LAN status dialog box appears.

Note that the currently active LAN settings for the IP Address, Subnet Mask, and 
Default Gateway may be different from the settings specified in the LAN 
Configuration dialog box, depending on the configuration of the network. If the 
settings are different, it is because the network has automatically assigned its own 
settings.

Modifying the LAN Settings

As shipped from the factory, B2900’s pre-configured settings should work in most 
LAN environments. If you need to manually configure these settings, press the 
More function key, then the I/O > LAN > Config softkeys. The LAN Configuration 
dialog box appears.

NOTE B2900 must be rebooted if the host name is changed.

For the LAN setup parameters, see “LAN Configuration dialog box” on page 4-46.
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Using the Graphical Web Interface

Your Agilent B2900 Source/Measure Unit has a built-in graphical web interface that 
lets you control it directly from an Web browser on your computer. Multiple 
simultaneous connections are allowed, but only from one computer. With additional 
connections, performance will be reduced. Multiple connections from multiple 
computers are not allowed.

With the graphical web interface, you can access the front panel control functions 
including the LAN configuration parameters. This is a convenient way to 
communicate with the B2900 without using I/O libraries or drivers.

NOTE The built-in graphical web interface only operates over the LAN interface. It 
requires Internet Explorer 6+ or Firefox 2+. You will also need the Java Plug-in. 
This is included in the Java Runtime Environment. Refer to Sun Microsystem’s 
website. If you are using Internet Explorer 7, open a separate browser window for 
each connection.

The graphical web interface is enabled when shipped.

JP00XXXXXX

JP00XXXXXX

Agilent B2912A Source/Measure Unit -

XXXXXXXXXX

B2912A

169.254.5.2

169.254.5.2

TCPIP::XXXXXXXXXX.local::inst0::INSTR

XXXXXXXXXX.local.
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 To launch the graphical web interface:

1. Open a Web browser on your computer.

2. Enter the instrument’s hostname or IP address into the browser’s Address field 
to launch the graphical web interface. The B2900 home page will appear.

3. Click on the Browser Web Control button in the navigation bar on the left to 
begin controlling your instrument.

4. For additional help about any page, click “Help with this Page”.

If desired, you can control the access to the graphical web interface using password 
protection. As shipped from the factory, the password is set to agilent. To change the 
password, click on the View & Modify Configuration button. Refer to the online 
help for additional information about setting the password.

Using Telnet

The Telnet utility (as well as sockets), is another way to communicate with B2900 
without using I/O libraries or drivers. In all cases, you must first establish a LAN 
connection from your computer to the B2900 as previously described.

In an MS-DOS Command Prompt box, type “telnet hostname 5024” where 
hostname is the B2900’s hostname or IP address, and 5024 is the instrument’s telnet 
port. You should get a Telnet session box with a title indicating that you are 
connected to the B2900. Type the SCPI commands at the prompt.

Using Sockets

NOTE Agilent B2900 allows any combination of up to four simultaneous data socket, 
control socket, or telnet connections to be made.

Agilent instruments are standardized on using port 5025 for SCPI socket services. A 
data socket on this port can be used to send and receive ASCII/SCPI commands, 
queries, and query responses. All commands must be terminated with a newline for 
the message to be parsed. All query responses will also be terminated with a 
newline.

The socket programming interface also allows control socket connections. The 
control socket can be used by a client to send device clear and to receive service 
requests. Unlike the data socket, which uses a fixed port number, the port number 
for a control socket varies and must be obtained by sending the following SCPI 
query to the data socket: SYSTem:COMMunicate:TCPip:CONTrol?
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Once the port number is obtained, a control socket connection can be opened. As 
with the data socket, all commands to the control socket must be terminated with a 
newline, and all query responses returned on the control socket will be terminated 
with a newline.

To send a device clear, send the string “DCL” to the control socket. When the B2900 
has finished performing the device clear, it will echo the string “DCL” back to the 
control socket.

Service requests are enabled for control sockets using the Service Request Enable 
register. Once service requests have been enabled, the client program listens on the 
control connection. When SRQ becomes true, the instrument will send the string 
“SRQ +nn” to the client. The “nn” is the status byte value, which the client can use 
to determine the source of the service request.
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Using Digital I/O
B2900A has a Digital I/O connector, D-sub 25 pin female, for general purpose 
input/output (GPIO). It can be used for:

• Trigger input

• Trigger output

• Digital signal input/output

• Digital signal input

• Start of Test (SOT) input (for component handlers)

• Busy status output (for component handlers)

• End of Test (EOT) output (for component handlers)

• Interlock control

• High voltage status output (shared with the digital signal input/output DIO 14)

The pin assignment of the Digital I/O connector is shown in Table 3-1. Pins DIO 1 
to DIO 14 can be assigned to one of the above functions, except for interlock 
control. To set the DIO functions, press the More function key, then the I/O > DIO > 
Config softkeys. For details, see “DIO Configuration dialog box” on page 4-46.

Figure 3-15 shows the input/output circuits internally connected to each pin of the 
Digital I/O connector.

Figure 3-15 Digital I/O Internal Circuit
Vcc

to Digital I/O
connector

R1
R2

from Output control Vcc: +5 V
R1: 5 kohm
R2: 100 ohm

to Input control
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Table 3-1 Digital I/O Pin Assignment

Description Pin Number Description

+5 V a

a. Current limit: 600 mA (total current to the pins 22, 23, and 25)

25 13 DIO 13 (bit 13)

Interlock control b

b. Used for the positive logic. Connected to the pin 25 for the negative 
logic.

24 12 DIO 12 (bit 12)

+5 V a 23 11 DIO 11 (bit 11)

+5 V a 22 10 DIO 10 (bit 10)

GND 21 9 DIO 9 (bit 9)

GND 20 8 DIO 8 (bit 8)

GND 19 7 DIO 7 (bit 7)

GND 18 6 DIO 6 (bit 6)

GND 17 5 DIO 5 (bit 5)

Interlock control c

c. Used for the negative logic. Connected to the pin 17 for the positive 
logic.

16 4 DIO 4 (bit 4)

GND 15 3 DIO 3 (bit 3)

DIO 14 (bit 14) or 
High voltage status

14 2 DIO 2 (bit 2)

1 DIO 1 (bit 1)
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Front Panel Reference
This chapter provides the reference information of the Agilent B2900 front panel 
keys and display.

• “Hard Keys and Rotary Knob”

• “Display and Assist Keys”

• “Function Keys”

• “Config key group”

• “Function key group”

• “Trigger key group”

• “Result key group”

• “File key group”

• “Program key group”

• “I/O key group”

• “Display key group”

• “System key group”

NOTE If measurement is not performed properly, check the trigger setting. The trigger type 
must be set to AUTO, or the trigger count (Count) must be set properly. See 
“Trigger parameters” on page 4-15.
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Hard Keys and Rotary Knob

Line switch Turns the instrument on or off.

Trigger Starts a single (one shot) measurement or initiates trigger system. If a repeat 
(continuous) measurement is in progress, stops the repeat measurement.

The single measurement is performed with the DC bias output, staircase sweep 
output, pulsed bias output, or pulsed sweep output set to the channel. One single 
measurement can contain the maximum of 100000 measurement points.

Once a single measurement starts, the data buffer (maximum 100000 data) is 
cleared, and the last single measurement result is stored in the buffer. The 
measurement result is displayed on the Single view, Dual view, Graph view, or Roll 
view. Also the last single measurement result can be listed and displayed on the 
Measure Result dialog box.

Auto Starts a repeat measurement. If a repeat measurement is in progress, stops the repeat 
measurement. The repeat measurement is performed with the DC bias output of the 
Source value. And the measurement result is displayed on the Single view, Dual 
view, or Roll view. The repeat measurement result is not stored in the buffer.

The repeat measurement is performed with the following trigger setup. Settings of 
“Trigger parameters” are ignored. 

• Acquire trigger (measurement trigger): Initiate

• ARM acquire count: Infinite

• ARM acquire source: AUTO (automatic internal)

• TRIGger acquire count (Measure Count) 100

• TRIGger acquire source (Measure Trigger): AUTO (automatic internal)

• TRIGger acquire timer period (Measure Period): 10 ms (this is automatically 
extended if the measurement is not completed.)

• Trigger delay (Source Delay=Measure Delay): 0 s

• Trigger output: Disable

• Measurement range: Compliance range if the fixed mode is selected

View Changes the display mode. See “Display and Assist Keys” on page 4-5.
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Cancel / Local Cancels the setup operation if the instrument is in the local status. Returns the 
instrument to the local status if it is in the remote status.

On/Off Used to enable or disable the SMU channel. Turns the channel off if it is in the 
output status even if it is in the remote status. One switch on 1-channel models, and 
two switches on 2-channel models.

The switch turns green if the channel is enabled.

The switch turns red if the channel is in the high voltage state.

Numeric/alpha 
keys

Used to enter the value for setup parameters such as the source output value, limit 
(compliance) value, and message, specified by the field pointer. The value can be 
changed if the field pointer is in the EDIT (green) status.

Rotary knob If the field pointer is in the MOVE (blue) status, turning the knob moves the pointer. 
Pressing the knob fixes the pointer position and changes the pointer status to EDIT 
(green).

If the field pointer is in the EDIT (green) status, turning the knob changes the value 
of the setup parameter specified by the pointer. Pressing the knob fixes the value and 
changes the pointer status to MOVE (blue).

If the field pointer is in the EDIT (green) status on a setup field other than the 
Source field and the Limit (Compliance) field, turning the knob changes the setting 
value. The value is applied by pressing the knob.

If the field pointer is in the EDIT (green) status on the Source or Limit (Compliance) 
field, turning the knob changes the setting value of the source channel in real time.

If the digit pointer is on a digit of a numeric value entry field, turning the knob 
changes the value of the digit. Note that changing the value from 9 to 0 or from 0 to 
9 changes the value of the next digit.

If the digit pointer is on the decimal point of a numeric value entry field, turning the 
knob moves the decimal point.

Left and right keys If the field pointer is in the MOVE (blue) status, pressing the key moves the pointer.

If the field pointer is in the EDIT (green) status, pressing the key changes the value 
of the setup parameter specified by the pointer.

If the field pointer is in the EDIT (green) status on a numeric value entry field, 
pressing the key changes the pointer to the digit pointer.

If the digit pointer is on a digit of a numeric value entry field, pressing the key 
moves the pointer on the digits.
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Display and Assist Keys
Agilent B2900 provides several display modes which depend on the model as 
shown below. The display mode is changed by the View key. Pressing the key 
changes the mode as shown below.

On B2901A Single  Graph  (return to Single)

On B2902A Dual  Single for channel 1  Single for channel 2  Graph 
 (return to Dual)

On B2911A Single  Graph  Roll  (return to Single)

On B2912A Dual  Single for channel 1  Single for channel 2  Graph 
 Roll  (return to Dual)

For each display mode, five assist keys are available on the right side of the display. 
They are assigned to several softkeys such as Mode, Source, Limit, Measure, and 
More. The softkey assignment depends on the display mode.

For details of each display mode and assist keys, see the following sections.

• “Dual View”

• “Single View”

• “Graph View”

• “Roll View”

• “Status Information”

The status information is common for all display modes. It is displayed above the 
bottom softkeys associated with the function keys. This display area is also used to 
display system messages and error messages.
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Dual View

Available on B2902A and B2912A. The upper half is for channel 1. The lower half 
is for channel 2. Each area displays the measurement results, source and 
measurement settings, and channel status. Most setup parameters can be edited on 
this display.

Display area 1. Channel number. 1 or 2.

2. Latest measurement data

3. High capacitance (HC) mode indicator

4. Remote sensing (4-wire connection) status indicator

5. Source function. VOLTS or AMPS.

6. Source shape indicator. DC, pulse, sweep, or pulsed sweep. DC does not show 
the indicator.

7. Source output value, 5½ digit resolution on B2902A, and 6½ digit resolution on 
B2912A

8. Limit (Compliance) value

D1. Primary measurement data

D2. Secondary measurement data or limit test result Pass or Fail

1 2 3 4 5 6 7 8

D1

D2

D1

D2
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Assist keys In the following descriptions, Ch n indicates Ch 1 or Ch 2.

Ch n Mode Changes the assist keys to VOLTS (V) and AMPS (I) used to 
select the source function.

VOLTS (V) sets the voltage source.

AMPS (I) sets the current source.

Ch n Source Changes the assist keys to the unit keys shown below.

mV and V for the voltage source

nA, A, mA, and A for the current source

First, enter or set the output value by using the numeric/alpha 
keys, rotary knob, and arrow keys. Then press one of the unit 
keys to apply the value.

Ch n Limit Changes the assist keys to the unit keys shown below.

nA, A, mA, and A for the current compliance

mV and V for the voltage compliance

First, enter or set the limit value by using the numeric/alpha 
keys, rotary knob, and arrow keys. Then press one of the unit 
keys to apply the value.

Ch n Measure Changes the assist keys to AMPS (I), VOLTS (V), OHMS (R), 
and WATTS (P) used to select the measurement function.

AMPS (I) sets the current measurement.

VOLTS (V) sets the voltage measurement.

OHMS (R) sets the resistance measurement.

WATTS (P) sets the power measurement.

Resistance data is given by Resistance=Vmeas/Imeas.

Power data is given by Power=VmeasImeas.

In the above formula, Vmeas is the voltage measurement data, 
and Imeas is the current measurement data.

For details on using resistance compensation, see “Resistance 
Compensation” on page 6-16.

More... Changes the assist keys to Ch 1 assist keys or Ch 2 assist keys. 
Ch 1 assist keys are effective for channel 1. Ch 2 assist keys are 
effective for channel 2.
Agilent B2900 User’s Guide, Edition 2 4- 7



Front Panel Reference

Display and Assist Keys
Single View

Displays the measurement results, source and measurement settings, and channel 
status. Most setup parameters can be edited on this display. The lower half displays 
the setup parameters selected by Assist keys 2.

Display area 1. Channel number. 1 or 2.

2. Latest measurement data

3. High capacitance (HC) mode indicator

4. Remote sensing (4-wire connection) status indicator

5. Source function. VOLTS or AMPS.

6. Source shape indicator. DC, pulse, sweep, or pulsed sweep. DC does not show 
the indicator.

7. Source output value, 5½ digit resolution on B2901A/B2902A, and 6½ digit 
resolution on B2911A/B2912A

8. Limit (Compliance) value

9. Measurement speed. AUTO, SHORT, MEDIUM, NORMAL, LONG, or 
MANUAL.

10. Aperture time in seconds or PLC (power line cycle, number of power line cycles 
per a measurement). Only for the MANUAL speed.

D1. Primary measurement data

D2. Secondary measurement data or limit test result Pass or Fail

1 2 3 4 5 6 7 8

9 10

D1

D2
4- 8 Agilent B2900 User’s Guide, Edition 2



Front Panel Reference

Display and Assist Keys
Assist keys 1 Mode Changes the assist keys to VOLTS (V) and AMPS (I) used to 
select the source function.

VOLTS (V) sets the voltage source.

AMPS (I) sets the current source.

Source Changes the assist keys to the unit keys shown below.

mV and V for the voltage source

nA, A, mA, and A for the current source

First, enter or set the output value by using the numeric/alpha 
keys, rotary knob, and arrow keys. Then press one of the unit 
keys to apply the value.

Limit Changes the assist keys to the unit keys shown below.

nA, A, mA, and A for the current compliance

mV and V for the voltage compliance

First, enter or set the limit value by using the numeric/alpha 
keys, rotary knob, and arrow keys. Then press one of the unit 
keys to apply the value.

Measure Changes the assist keys to AMPS (I), VOLTS (V), OHMS (R), 
and WATTS (P) used to select the measurement function.

AMPS (I) sets the current measurement.

VOLTS (V) sets the voltage measurement.

OHMS (R) sets the resistance measurement.

WATTS (P) sets the power measurement.

Resistance data is given by Resistance=Vmeas/Imeas.

Power data is given by Power=VmeasImeas.

In the above formula, Vmeas is the voltage measurement data, 
and Imeas is the current measurement data.

For details on using resistance compensation, see “Resistance 
Compensation” on page 6-16.

More... Changes the assist keys to Assist keys 2.
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Assist keys 2 Speed Changes the assist keys to AUTO (1 PLC for 10 nA and 100 nA 
ranges, 0.01 PLC for other ranges), SHORT (0.01 PLC), 
MEDIUM (0.1 PLC), NORMAL (1 PLC), LONG (10 PLC), or 
MANUAL used to select the measurement speed. The aperture 
time is automatically set to the above values in parentheses. For 
the aperture time, see “Measurement Time” on page 6-5.

For the MANUAL speed, the aperture time must be set to the 
right field in seconds or PLC (power line cycle, number of 
power line cycles per measurement). Move the field pointer to 
the one by using the arrow keys or rotary knob and press the 
knob to set the pointer to the EDIT mode. Enter or set the value 
by using the numeric/alpha keys, knob, or arrow keys, then 
press the knob or one of the unit keys to apply the value. For 
setting the seconds value, the following unit keys are available 
as assist keys.

s, ms, and s

Show Sweep Displays the sweep setup parameters shown in “Sweep 
parameters” on page 4-12, and changes the softkey label to 
Hide Sweep.

Hide Sweep Displays the range setup parameters shown in “Range 
parameters” on page 4-11, and changes the softkey label to 
Show Sweep.

Show Pulse Displays the pulse setup parameters shown in “Pulse 
parameters” on page 4-14, and changes the softkey label to 
Hide Pulse.

Hide Pulse Displays the range setup parameters shown in “Range 
parameters” on page 4-11, and changes the softkey label to 
Show Pulse.

Show Trigger Displays the trigger setup parameters shown in “Trigger 
parameters” on page 4-15, and changes the softkey label to 
Hide Trigger.

Hide Trigger Displays the range setup parameters shown in “Range 
parameters” on page 4-11, and changes the softkey label to 
Show Trigger.

More... Changes the assist keys to Assist keys 1.

Softkey labels Show XXXX and Hide XXXX are switched by pressing the key.
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Range parameters

The following setup parameters are available. Source or Measure XXXX is decided 
by the source setting.

Source Volts: Spot For the voltage source. Selects the range operation AUTO or 
FIXED for the constant voltage output and the source side 
voltage measurement.

Measure Amps For the voltage source. Selects the range operation AUTO or 
FIXED for the current measurement.

Source Amps: Spot For the current source. Selects the range operation AUTO or 
FIXED for the constant current output and the source side 
current measurement.

Measure Volts For the current source. Selects the range operation AUTO or 
FIXED for the voltage measurement.

The right field is used to set the range value for the FIXED range operation, or the 
minimum range value for the AUTO range operation. For the available range 
values, see “Output and Measurement Ranges” on page 2-11.

Measure Ohms Selects the resistance measurement operation AUTO, 
FIXED, or V/I. For AUTO and FIXED, the channel 
performs resistance measurement by using the current 
source and voltage measure condition automatically set by 
the resistance measurement range setting. For V/I, the 
channel performs measurement by using the present 
source/measure condition, and the resistance value is given 
by V/I calculation.

The right field is used to set the resistance measurement range value for the FIXED 
operation, or the minimum and maximum ranges for the AUTO operation. For the 
available range values, see Table 2-7 on page 2-15. This setup field is not available 
for the V/I operation.

In the AUTO range operation, the channel automatically sets the range which 
provides the best resolution for the source output value or the measured value.
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Sweep parameters

B2900 can be used as a sweep source, and supports the following sweep operations. 
The operation can be selected by using the assist keys displayed when the field 
pointer is in the EDIT (green) status on the Sweep Parameters field.

• LINEAR SINGLE: Sweep from start to stop in a linear incremental step

• LINEAR DOUBLE: Sweep from start to stop to start in a linear incremental step

• LOG SINGLE: Sweep from start to stop in a logarithmic incremental step

• LOG DOUBLE: Sweep from start to stop to start in a log incremental step

• LIST: Sweep of values defined in the List sweep setup list. See “List sweep 
setup”.

The following setup parameters are available.

Start Sets the sweep start value.

Stop Sets the sweep stop value.

Points Sets the number of sweep steps.

Step Sets the sweep step value (incremental step value). Not 
available for the LOG and LIST sweep operations.

When the field pointer is in the EDIT (green) status on an entry field, the assist keys 
are changed to the unit keys as shown below.

nA, A, mA, and A for current sweep

mV and V for voltage sweep

For the range operation of the sweep source, see “Sweep dialog box” on page 4-27. 
The range parameters Source Volt: Spot and Source Amps: Spot are not effective for 
the AUTO and BEST range operations of the sweep source. They are effective for 
the constant source and FIXED range operation of the sweep source.

List sweep setup When the field pointer is in the EDIT (green) status on the LIST sweep 
Start/Stop/Points field, the following assist keys are available for setting the list 
sweep source.
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Edit Opens the List Sweep dialog box used to set the list sweep 
source.

Load Opens the Load List Sweep Data dialog box used to load a list 
sweep data from a USB memory connected to the front panel 
USB-A connector.

• List Sweep dialog box

This dialog box provides the following GUI for setting the list sweep source. 
Data resolution is 6 digits on B2901A/B2902A, and 7 digits on 
B2911A/B2912A.

(data graph) Displays the shape of the list sweep output

Type Data type V (voltage) or I (current)

CH Channel number 1 or 2, only on 2-channel models

(data list) Lists the data index and the output value

Points Number of data points

Max Maximum value

Min Minimum value

• Load List Sweep Data dialog box

This dialog box provides the following GUI for loading a list sweep data from a 
file stored on a USB memory.

(data graph) Displays the shape of the list sweep data selected by the file 
list

Path Folder into which the list sweep data file is saved

(file list) List of the list sweep data file

Points Number of data points

Max Maximum value

Min Minimum value

The following data can be loaded as the list sweep data.

• Comma separated value format, file extension csv

• Carriage return or line feed separated value format, file extension txt

• Space separated value format in a line, file extension prn
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Pulse parameters

B2900 can be used as a pulse source, and supports pulsed output and measurement. 
Pulse ON or OFF can be selected by using the assist keys displayed when the field 
pointer is in the EDIT (green) status on the Pulse field.

The following setup parameters are available.

Peak Sets the pulse peak value. Not available for the sweep source 
which sets the sweep output value to the pulse peak. 

The pulse base value is set by the Source field in the upper half 
of the display area. See “Single View” on page 4-8.

Delay Sets the pulse delay time. The pulse source changes the output 
level from the base value to the peak value when the delay time 
elapsed after trigger delay.

Width Sets the pulse width.

When the field pointer is in the EDIT (green) status on an entry field, the assist keys 
are changed to the unit keys as shown below.

nA, A, mA, and A for the peak current

mV and V for the peak voltage

s, ms, and s for the delay and width
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Trigger parameters

The B2900 supports the following trigger types for triggering source output and 
measurement. They are effective for setting triggers easily.

The trigger type can be selected by using the assist keys displayed when the field 
pointer is in the EDIT (green) status on the Trigger field. See Table 4-1 for the 
trigger types and the setup parameters. 

AUTO Automatic trigger type

SYNC Synchronize trigger type

TIMER Timer trigger type

MANUAL Manual trigger type

The following setup parameters are available for setting the source output trigger 
(transient action) by using the Source column, and the measurement trigger (acquire 
action) by using the Measure column.

Count Trigger count (number of triggers). This value is automatically 
set for the AUTO trigger type. For the other trigger type, set the 
number of triggers required for each source output and 
measurement properly. For example, set Source Count = 
Measure Count = 10 for the sweep measurement with 10 steps.

Delay Sets the trigger delay time.

Period Sets the trigger period.

Trigger Selects the trigger source by using the assist key AUTO, BUS, 
TIMER, INTm (only for 2-channel model), LAN, or EXTn, 
where m is the integer 1 or 2, and n is an integer from between 1 
and 14. See Table 4-1 for the trigger sources.

When the field pointer is in the EDIT (green) status on the Delay or Period field, the 
assist keys are changed to the unit keys as shown below.

s, ms, and s
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Table 4-1 Trigger Types and Setup Parameters

Trigger=AUTO automatically selects the trigger source best suited for the present 
operating mode by using internal algorithms. 

Trigger=BUS selects the remote interface trigger command such as the group 
execute trigger (GET) and the *TRG command. 

Trigger=TIMER selects a signal internally generated every interval set by the 
Period parameter. 

Trigger=INT1 or INT2 selects a signal from the internal bus 1 or 2, respectively.

Trigger=LAN selects the LXI trigger.

Trigger=EXTn selects a signal from the DIO pin n which is an output port of the 
Digital I/O D-sub connector on the rear panel. n=1 to 14.

NOTE Setting trigger parameters in detail

For details of the trigger system, see Figure 6-8 on page 6-28.

The Single view provides the trigger types and parameters effective for setting 
triggers easily. If you want to set the trigger parameters in detail, select the 
MANUAL trigger type and use the Trigger Configuration dialog box opened by 
pressing the Trigger > Config function keys. See “Trigger key group” on page 4-35.

The Single view does not contain the setup parameters for the arm layer, but 
contains the setup parameters for the trigger layer. The Single view setup is given 
priority over the trigger layer setup on the Trigger Configuration dialog box. Hence, 
the overlapped parameter values on the dialog box are ignored.

Type Count Delay Period Trigger

AUTO set 
automatically

0 second N.A. AUTO

SYNC entered value entered value N.A. AUTO

TIMER entered value entered value entered value TIMER

MANUAL entered value entered value entered value selected value
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Graph View

Displays the graph for plotting the channel 1 and/or 2 measurement or math result. 
The Graph view can plot up to 5000 data.

Display area 1. Graph display status ON or OFF. Only on 2-channel models. [n] is for channel n.

2. Y-axis data type I (A), V (V), R (), P (W), or MATH (see Table 4-2)

3. Y-axis scale LINEAR or LOG 

4. X-axis data type I (A), V (V), R (), P (W), MATH, t (s), V1, or V2 (see Table 
4-2)

5. X-axis scale LINEAR or LOG 

6. Graph maximum value 

7. Graph minimum value 

8. Channel 1 and/or 2 source output value, limit value, or none (controlled by the 
Ch n Source, Ch n Limit, or Hide Ch n assist key)

9. Channel 1 and/or 2 Y-axis data at the active X-cursor position. ----.---- is 
displayed for the no-data position.

10. Cursor data (controlled by the Show Cursors or Hide Cursors assist key)

First line Positions and distance (e.g. I1, I2, A) of Y-cursors 1 and 2

1 2 3 4 5

6

7

8

9

10
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Second line Positions and distance (e.g. t1, t2, t) of X-cursors 1 and 2

Table 4-2 X and Y Axes Data Types for Graph View

Assist keys Auto Scale Changes graph scale to fit the trace in the graph automatically.

Dump Screen Opens the File Selection (Dump Screen) dialog box which is 
used to save the screen dump as a JPEG file.

The file can be saved onto a USB memory connected to the 
front panel USB-A connector. The file is saved with the 
specified name. If the file extension is not specified, “.jpg” is 
added automatically.

Show Cursors Displays the cursors (Y-cursors 1 and 2, X-cursors 1 and 2, and 
cursor data) and changes the softkey label to Hide Cursors.

Hide Cursors Hides the cursors and changes the softkey label to Show 
Cursors.

Ch n Source Displays the channel n source output value and changes the 
softkey label to Ch n Limit.

Ch n Limit Hides the channel n source output value and displays the limit 
value. Also changes the softkey label to Hide Ch n.

Hide Ch n Hides the channel n limit value and changes the softkey label to 
Ch n Source.

In the above descriptions, Ch n indicates Ch 1 or Ch 2.

Data type Assist key Description

I (A) AMPS (I) Current data

V (V) VOLTS (V) Voltage data

R () OHMS (R) Resistance data

P (W) WATTS (P) Power data

MATH MATH Math result data

t (s) TIME (t) Time data. Only for the X-axis data.

V1 Ch 1 V (V1) Only on 2-channel models. Voltage data of 
channel 1 or 2. Only for the X-axis data.

V2 Ch 2 V (V2)
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NOTE If the number of data exceeds 5000

If the number of measurement data exceeds 5000, the Graph view and the Roll view 
plot the following data. where, n is integer, 1 to 5000.

Number of data is 5001 to 10000: [2*(n-1)+1]th data

Number of data is 10001 to 25000: [5*(n-1)+1]th data

Number of data is 25001 to 50000: [10*(n-1)+1]th data

Number of data is 50001 to 100000: [20*(n-1)+1]th data

Roll View

Available on B2911A and B2912A. Displays the time domain graph for plotting the 
channel 1 and/or 2 measurement data. See Table 4-3 for the Y-axis data types. The 
Roll view can plot up to 5000 data.

Display area 1. Displays status ON or OFF, on B2911A

Displays status Ch 1, Ch 2, or OFF, on B2912A

Two lines can be displayed on the graph. [1] indicates the graph setup for line 1. 
[2] indicates the graph setup for line 2.

2. Y-axis data type I, V, R, or P.

1 2 3 4

5 6 7

8

9

10
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3. Y-axis scale per division A/div., V/div., /div., or W/div.

4. X-axis scale per division s/div.

5. X-axis minimum value (minimum timestamp)

6. Y-axis offset values for line 1 and 2

7. X-axis maximum value (maximum timestamp)

8. Channel 1 and/or 2 source output value, limit value, or none (controlled by the 
Ch n Source, Ch n Limit, or Hide Ch n assist key)

9. Channel 1 and/or 2 Y-axis data at the active X-cursor position. ----.---- is 
displayed for the no-data position.

10. Cursor data (controlled by the Line 1 Cursors, Line 2 Cursors, or Hide Cursors 
assist key)

First line Positions and distance (e.g. I1, I2, A) of Y-cursors 1 and 2

Second line Positions and distance (e.g. t1, t2, t) of X-cursors 1 and 2

Assist keys Auto Scale Changes graph scale to fit the trace in the graph automatically.

Dump Screen Opens the File Selection (Dump Screen) dialog box which is 
used to save the screen dump as a JPEG file.

The file can be saved onto a USB memory connected to the 
front panel USB-A connector. The file is saved with the 
specified name. If the file extension is not specified, “.jpg” is 
added automatically.

Line 1 Cursors Displays the cursors (Y-cursors 1 and 2, X-cursors 1 and 2, and 
cursor data) for line 1, and changes the softkey label to Line 2 
Cursors.

Line 2 Cursors Displays the cursors (Y-cursors 1 and 2, X-cursors 1 and 2, and 
cursor data) for line 2, and changes the softkey label to Hide 
Cursors.

Hide Cursors Hides the cursors and changes the softkey label to Line 1 
Cursors.

Ch n Source Displays the channel n source output value and changes the 
softkey label to Ch n Limit.

Ch n Limit Hides the channel n source output value and displays the limit 
value. Also changes the softkey label to Hide Ch n.
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Hide Ch n Hides the channel n limit value and changes the softkey label to 
Ch n Source.

In the above descriptions, Ch n indicates Ch 1 or Ch 2.

Table 4-3 Y-Axis Data Types for Roll View

Data type Assist key Description

I AMPS (I) Current data

V VOLTS (V) Voltage data

R OHMS () Resistance data

P WATTS (P) Power data
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Status Information

The status information is common for all display modes. It is displayed above the 
bottom softkeys associated with the function keys.

Table 4-4 Status Indicator

Label Color Description

AUTO white Trigger auto. Automatic trigger is enabled now.

ARM white Trigger active. Trigger system is active now.

HV yellow High voltage. Output voltage setting is over 42 V.

Channel 1 floating status. Channel 1 is not grounded.

Channel 2 floating status. Channel 2 is not grounded.

REM white Remote. Instrument is in the remote state.

Local lockout. 
Instrument is in the local lockout (LLO) status.

ERR white Error. At least one error is detected.

EDIT green Edit mode. The field specified by the pointer can be 
edited. Not in the move mode.

MOVE blue Move mode. The field pointer can be moved. Not in the 
edit mode.

LAN green or 
red

LXI LAN status indicator. Green indicates normal LAN 
status. Red indicates abnormal condition. Blinking 
indicates the LAN identification status.

D white Display mode: Dual view

1 white Display mode: Single view for channel 1

2 white Display mode: Single view for channel 2

G white Display mode: Graph view

R white Display mode: Roll view
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Function Keys
Agilent B2900 has six function keys below the front panel display, and provides the 
following nine softkeys.

Function keys 1 Config SMU configuration setup. Displays the softkeys for setting 
several functions of the SMU. See “Config key group” on page 
4-24.

Function Math, limit test, and trace function setup. Displays the softkeys 
for setting these functions. See “Function key group” on page 
4-30.

Trigger Trigger configuration and control. Displays the softkeys for 
setting and controlling the trigger system. See “Trigger key 
group” on page 4-35.

Result Measurement, limit test, and trace result display. Displays the 
softkeys for displaying these results. See “Result key group” on 
page 4-38.

File File operation. Displays the softkeys for saving and loading a 
file. See “File key group” on page 4-41.

More... Changes the function keys to Function keys 2.

Function keys 2 Program Program configuration and control. Displays the softkeys for 
setting and controlling the program memory. See “Program key 
group” on page 4-42.

I/O I/O setup. Displays the softkeys for setting the I/O interfaces. 
See “I/O key group” on page 4-43.

Display Display setup. Displays the softkeys for setting the display 
functions. See “Display key group” on page 4-48.

System System setup. Displays the softkeys used for several system 
setups. See “System key group” on page 4-49.

More... Changes the function keys to Function keys 1.
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Config key group
Pressing the Config key displays the following three softkeys for setting several 
functions of the SMU.

Source Displays the following three softkeys for setting the SMU source operation.

Connection Channel operation and connection setup. See “Output 
Connection dialog box” on page 4-25.

Filter Output filter setup. See “Output Filter dialog box” on page 
4-26.

Sweep Sweep source detail setup. See “Sweep dialog box” on page 
4-27.

Measure Displays the following two softkeys for setting the SMU measurement operation.

R Compen Resistance compensation ON or OFF. See “Resistance 
Compensation” on page 6-16.

On a 1-channel model, pressing this key displays the ON and 
OFF keys used to set the resistance compensation on or off.

On a 2-channel model, pressing this key displays the ALL, Ch 
1, and Ch 2 keys. They are used to specify the channel for 
setting the resistance compensation on or off.

ALL specifies channels 1 and 2.

Ch 1 specifies channel 1 only.

Ch 2 specifies channel 2 only.

Ranging Measurement range detail setup. See “Ranging dialog box” on 
page 4-28.

Common Displays the following two softkeys for setting the SMU’s miscellaneous function.

Wait Source and measurement wait time setup. See “Wait Control 
dialog box” on page 4-29.

Group Only on 2-channel models. Channel grouping ON or OFF. 
If this function is ON, the channels perform synchronous 
channel operation. The present setting is indicated by an 
asterisk on the softkey label.
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Output Connection dialog box

This dialog box provides the following parameters for setting the channel operation 
and connection.

Ch Only on 2-channel models. Channel 1 (Ch 1) or 
2 (Ch 2)

This field specifies the channel set by this 
dialog box.

Sensing Type Sensing type, 2-wire connection (2-WIRE) or 
4-wire connection (4-WIRE). Set 4-WIRE for 
remote sensing.

Low Terminal State Low sense terminal connection, 
grounded (GROUND) or floating (FLOAT)

High Capacitance Mode High capacitance mode, ON or OFF

Set the mode to ON to perform high capacitive 
load measurements. See “High Capacitance 
Mode” on page 6-15.

Over Voltage/Current Protection Over voltage or current protection, ON or OFF

Set the function ON to turn off the channel 
output automatically and immediately when it 
reaches its compliance.

Output-Off State Output-off state, high impedance (HIGH Z), 
normal (NORMAL), or zero volt (ZERO)

This is the source setup condition after output 
off. See Table 6-1 on page 6-13.

Auto Output-On Automatic output on function, ON or OFF

Set the function ON to turn on the channel 
output automatically just before the trigger 
system is initiated by the SCPI command (not 
by front panel operation).

Auto Output-Off Automatic output off function, ON or OFF

Set the function ON to turn off the channel 
output automatically and immediately when all 
trigger system changes the status from busy to 
idle.
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Output Filter dialog box

This dialog box provides the following parameters for setting the output filter.

Ch Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel set by this dialog box.

Filter State Output filter, ON or OFF

Set the filter ON to obtain clean source output without spikes 
and overshooting. Note, however, that using a filter may 
increase the SMU settling time.

Automatic Filter Automatic filter, ON or OFF

Set the function ON to automatically set the output filter which 
provides the best filter characteristics and cutoff frequency.

Time Constant Filter time constant, 5 s to 500 s
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Sweep dialog box

This dialog box provides the following parameters for setting details of the sweep 
source operation.

Ch Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel set by this dialog box.

Sweep Ranging Sweep source range operation, BEST, AUTO, or FIXED. 
See Table 4-5 on page 4-27.

Sweep Direction Sweep direction, UP (start to stop direction) or DOWN (stop 
to start direction)

Output after Sweep The value the source channel applies after it completes the 
sweep output

START VALUE (START): The value applied when the 
source channel starts the sweep

END VALUE (END): The value applied when the source 
channel completes the sweep

Table 4-5 Sweep Source Range Operation

Description

BEST In the linear sweep mode, the sweep source channel 
automatically uses the minimum range which covers the whole 
sweep output.

In the log sweep mode, the sweep source channel automatically 
uses the range which provides the best resolution for each sweep 
step output.

AUTO The sweep source channel automatically changes and sets the 
range which provides the best resolution to apply the source 
output for each sweep step.

FIXED The sweep source channel sets the range specified by the range 
parameter Source Volts: Spot or Source Amps: Spot. See “Range 
parameters” on page 4-11.
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Ranging dialog box

This dialog box provides the following parameters for setting details of the auto 
ranging operation for measurements.

Ch Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel set by this dialog box.

Current Auto Ranging Current measurement auto range operation, NORMAL, 
SPEED, or RESOLUTION (RESOLN). See Table 4-6.

Voltage Auto Ranging Voltage measurement auto range operation, NORMAL, 
SPEED, or RESOLUTION (RESOLN). See Table 4-6.

Threshold Sets the rate value of the formula shown below.

Table 4-6 Measurement Auto Range Operation

• Basic operation

The channel automatically sets the range which provides the best resolution in 
performing the measurement.

• Upward changing operation

If measured data  value1, the range changes up after the measurement.

value1 = measurement range  rate / 100

• Downward changing operation

If measured data  value2, the range changes down immediately.

value2 = measurement range  rate / 1000

Description

NORMAL Supports basic operation and downward changing operation 
described below

SPEED Supports basic operation and upward and downward changing 
operations described below

RESOLN Supports basic operation and upward changing operation 
described below
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Wait Control dialog box

This dialog box provides the following parameters for setting the source and 
measurement wait time.

The source wait time is defined as the time the source channel cannot change the 
output after the start of a DC output or the trailing edge of a pulse.

The measurement wait time is defined as the time the measurement channel cannot 
start measurement after the start of a DC output or the trailing edge of a pulse.

Ch Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel set by this dialog box.

State Wait time, ON or OFF

Automatic Automatic wait time, ON or OFF

Gain and Offset Parameters for calculating the wait time. See the following 
formula.

• If State=ON and Automatic=ON:

wait time = Gain  initial wait time + Offset

• If State=ON and Automatic=OFF:

wait time = Offset

• If State=OFF:

wait time=0

The initial wait time is automatically set by the instrument, and cannot be changed. 
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Function key group
Pressing the Function key displays the following three softkeys for setting the math, 
limit test, and trace functions.

Math Math function setup. See “Math Expression dialog box” on page 4-30.

Limit Test Displays the following two softkeys for setting the limit test function.

Composite Composite limit test setup. See “Composite Limit Test Setup 
dialog box” on page 4-31.

Limits Limit test setup. See “Limit Test Setup dialog box” on page 
4-32.

Trace Trace function setup. See “Trace Buffer Setup dialog box” on page 4-34.

Math Expression dialog box

This dialog box provides the following parameters for setting the math function. If 
the math function is ON, the measurement data can be calculated by using the 
specified math expression.

Ch Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel set by this dialog box.

Status Math function, ON or OFF

Unit String Unit for the calculation result of the math expression

The available math expressions are listed in the area below the Unit String field. 
This area can be used to select the math expression for data calculation. To select a 
math expression, highlight the name in this area.

The data calculation is effective for data measured after the math function is set by 
this dialog box. The calculation result can be displayed on the dialog box opened by 
using the Result key group. See “Result key group” on page 4-38.

Math expressions can be defined by using the SCPI commands while the B2900 is 
in the remote mode. 

For the predefined math expressions, see “Predefined Math Expressions” on page 
6-17.
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Composite Limit Test Setup dialog box

This dialog box provides the following parameters for setting the limit test.

Ch Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel set by this dialog box.

Limit Test Composite limit test, ON or OFF

Mode Operation mode, GRADING (GRADE) or SORTING (SORT)

GRADING: Grading mode. See Figure 6-5 for the operation.

SORTING: Sorting mode. See Figure 6-6 for the operation.

Auto Clear Automatic clear of the composite limit test result, ON or OFF

If this parameter is ON, the composite limit test results and the 
DIO lines are automatically cleared.

Update Only for the GRADING mode. IMMEDIATE (IMM.) or END 
See “Immediate?” shown in Figure 6-5.

IMMEDIATE: Outputs result immediately. (Immediate? Yes)

END: Outputs result at the end. (Immediate? No)

Offset Cancel Offset cancel of the limit test, ON or OFF

If this parameter is ON, the limit test data will be as follows.

Limit test data = raw data - offset value

Offset Offset value used for the offset cancel, -9.999999E+20 to 
+9.999999E+20

Pass Pattern Bit pattern for the limit test pass state. For the GRADING 
mode.

Fail Pattern Bit pattern for the limit test fail state. For the SORTING mode.

GPIO Pins DIO pins assigned to the bit pattern output

/BUSY DIO pin assigned to the BUSY (busy) signal output

/SOT DIO pin assigned to the SOT (start of test) signal input

/EOT DIO pin assigned to the EOT (end of test) signal output

For the DIO pin assignment, see “Using Digital I/O” on page 3-29.

DIO pins assigned to the GPIO Pins, /BUSY, /SOT, or /EOT must be set to the 
DIGITAL I/O function by using the DIO Configuration dialog box.
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NOTE Values of GPIO Pins, /BUSY, /SOT, and /EOT

0 to 14 (integer). Numbers 1 to 14 indicate the DIO pins 1 to 14, respectively. 0 
indicates that it is not used.

For GPIO Pins, multiple continuous pins are assigned. For example, “1, 2, 3, 4” 
indicates that the DIO pins 1 to 4 are assigned. Then LSB is DIO pin 1.

Limit Test Setup dialog box

This dialog box provides the following parameters for setting the limit test, which is 
a part of the composite limit test.

Ch Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel set by this dialog box.

Feed Data Type of data used for the pass/fail judgement of the limit test, 
MATH, VOLTS, AMPS, or OHMS.

MATH: Calculation result data of math expression

VOLTS: Voltage measurement data

AMPS: Current measurement data

OHMS: Resistance data given by Resistance=Vmeas/Imeas

Where, Vmeas is the voltage measurement data, and Imeas is 
the current measurement data.

For details on using resistance compensation, see “Resistance 
Compensation” on page 6-16.

Test Index Index of limit test, No. 1 to 12.

Index numbers 1 to 12 are also used for bin numbers 1 to 12. 
See “Limit Test Result dialog box” on page 4-39.

Limit Test Limit test, ON or OFF

Function Test mode, COMPLIANCE (COMP.) or LIMIT

COMPLIANCE: Compliance check

LIMIT: Limit test

Pass Pattern Bit pattern for the limit test pass state. For the SORTING mode.

Fail on Only for compliance check. OUT or IN.
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Fail on=IN judges limit test failure if the channel goes into the 
compliance state.

Fail on=OUT judges limit test failure if the channel comes out 
of the compliance state.

Fail Pattern Only for compliance check. Bit pattern for the limit test fail 
state.

Up Pattern Not available for compliance check. Bit pattern for the 
failed-by-exceeding-upper-limit state. Used for the GRADING 
mode.

Up Limit Not available for compliance check. Upper limit for the 
pass/fail judgement. Used for the GRADING mode.

Low Pattern Only for limit test. Bit pattern for the 
failed-by-exceeding-lower-limit state. Used for the GRADING 
mode.

Low Limit Only for limit test. Lower limit for the pass/fail judgement. 
Used for the GRADING mode.

Bit pattern is sent to the DIO pins specified by the GPIO Pins field on the Composite 
Limit Test Setup dialog box.
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Trace Buffer Setup dialog box

This dialog box provides the following parameters for setting the trace function. The 
data specified by the Feed Data parameter can be stored in the trace buffer if the 
Buffer Control parameter is NEXT. The maximum data size is specified by the 
Buffer Size parameter. See Figure 6-7 on page 6-24 for the trace buffer.

Ch Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel set by this dialog box.

Feed Data Type of data placed in the trace buffer, SENSE, MATH, or 
LIMIT

SENSE: Measurement result data

MATH: Calculation result data of math expression

LIMIT: Limit test data

The data contains the voltage measurement data, current 
measurement data, resistance measurement data, source output 
setting data, calculation result data, limit test data, time data, or 
status data selected by using the Format keys of the I/O key 
group. See “I/O key group” on page 4-43.

Buffer Control Trace buffer control mode, NEVER or NEXT

NEVER: Disables the write operation to the trace buffer.

NEXT: Enables the write operation until buffer full.

Buffer full will change the mode to NEVER.

Buffer Size Size of the trace buffer, 1 to 100000 data
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Trigger key group
Pressing the Trigger key displays the following four softkeys for setting the trigger 
parameters in detail and controlling the trigger system. See Figure 6-8 on page 6-28.

Config Opens a dialog box. See “Trigger Configuration dialog box” on page 4-36.

Initiate Displays the softkeys for selecting the device action to initiate (to go to the arm 
layer of the trigger system). See Table 4-7. 

Abort Displays the softkeys for selecting the device action to abort (to return to the idle 
state of the trigger system). See Table 4-7.

Immediate Displays the following two softkeys for selecting the arm layer or trigger layer for 
sending the immediate trigger.

Trigger Selects the trigger layer.

Arm Selects the arm layer.

Selecting the layer displays the softkeys for selecting the device action to send the 
immediate trigger. See Table 4-7.

Table 4-7 Softkeys to Select Device Action and Channel

Softkey label Description

ALL Selects the transient and acquire device actions.

Trans. Selects the transient (source output) device action only.

Acq. Selects the acquire (measurement) device action only.

On a 1-channel model, selecting the device action executes Initiate, Abort, or 
Immediate for the specified device action.

On a 2-channel model, selecting the device action displays the following three 
softkeys for selecting the channel.

ALL Selects channels 1 and 2.

Ch 1 Selects channel 1 only.

Ch 2 Selects channel 2 only.

Selecting the channel executes Initiate, Abort, or Immediate for the specified 
device action of the specified channel.
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Trigger Configuration dialog box

This dialog box is used to set the trigger parameters in detail. Note that the 
overlapped parameter values are ignored and replaced with the settings made on the 
Single view. See “Trigger parameters” on page 4-15.

Ch Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel set by this dialog box.

Layer Specifies the layer or device action set by this dialog box.

ARM: Arm layer

TRIGGER: Trigger layer

ACTION: Device action

For ACTION, the available parameters are Ch, Layer, Action, 
and Trigger Output.

Action Specifies the device action type set by this dialog box.

TRANS.: Transient (source output) device action

ACQ.: Acquire (measurement) device action

Count Count, 0 to 100000, for the action specified by the Ch, Layer, 
and Action parameters

Infinity (INF.) is available only for the arm count.

Bypass Bypass, ON or OFF

Bypass=ON enables the bypass only for the first passage to the 
event detector for the action specified by the Ch, Layer, and 
Action parameters.

Bypass=OFF disables the bypass.

Trigger Source Event for the action specified by the Ch, Layer, and Action 
parameters. AUTO, BUS, TIMER, INT1, INT2, LAN, EXT1, 
EXT2, EXT3, EXT4, EXT5, EXT6, EXT7, EXT8, EXT9, 
EXT10, EXT11, EXT12, EXT13, or EXT14. See Table 4-8. 

Period Only for the TIMER event.

Interval of the TIMER event for the action specified by the Ch, 
Layer, and Action parameters, 10 s to 100000 s

Trigger Delay Delay time for the action specified by the Ch, Layer, and Action 
parameters, 0 to 100 s
4- 36 Agilent B2900 User’s Guide, Edition 2



Front Panel Reference

Trigger key group
Trigger Output Trigger output, ON or OFF

If this parameter is ON, B2900 sends an output trigger when it 
changes the trigger state for the action specified by the Ch, 
Layer, and Action parameters. See Figure 6-8 on page 6-28. 
Also see “DIO Configuration dialog box” on page 4-46 for 
details on setting the trigger output timing.

The right field of the Trigger Output entry field shows the 
present setting of the trigger output terminal. In the default 
setting, it is the EXT1 terminal. It can be changed by the 
following commands.

• Between initial state and arm layer

:ARM[:ACQ|:TRAN]:TOUT:SIGN

• Between arm layer and trigger layer

:TRIG[:ACQ|:TRAN]:TOUT:SIGN

• Between trigger layer and transient action

:SOUR:TOUT:SIGN

• Between trigger layer and acquire action

:SENS:TOUT:SIGN

Table 4-8 Trigger Source

Trigger Source Description

AUTO Signal internally generated and optimized for the present 
operating mode

BUS Remote interface trigger command such as the group execute 
trigger (GET) and the *TRG command

TIMER Signal internally generated every interval set by the Period 
field

INT1 or INT2 Signal from the internal bus 1 or 2

LAN LXI trigger specified by the 
:ARM[:ACQ|:TRAN]:SOUR:LAN and 
:TRIG[:ACQ|:TRAN]:SOUR:LAN commands

EXTn Signal from the DIO pin n, which is an I/O port of the Digital 
I/O D-sub connector on the rear panel. n=1 to 14
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Result key group
Pressing the Result key displays the following three softkeys for displaying the 
measurement, limit test, and trace results.

Measure Displays the measurement result. See “Measure Result dialog box” on page 4-38.

Limit Test Displays the limit test result. See “Limit Test Result dialog box” on page 4-39.

Trace Displays the trace result. See “Trace Statistical Result dialog box” on page 4-40.

Measure Result dialog box

This dialog box is used to display the last single (one shot) measurement result 
(maximum 100000 data) stored in the data buffer.

This dialog box provides the following GUI for displaying the measurement result. 
The result data is shown in the index and data table below the Type field. Also, the 
data is plotted in the graph area above the Points fields.

Ch Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel of the data to display.

Type Type of data to display, AMPS, VOLTS, OHMS, WATTS, 
MATH, or TIME

AMPS: Current measurement data

VOLTS: Voltage measurement data

OHMS: Resistance data given by Resistance=Vmeas/Imeas

WATTS: Power data given by Power=VmeasImeas

MATH: Calculation result data of math expression

TIME: Time data

In the above formula, Vmeas is the voltage measurement data, 
and Imeas is the current measurement data.

For details on using resistance compensation, see “Resistance 
Compensation” on page 6-16.

Points Number of data points.
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Max. Y-axis maximum value of the graph.

Min. Y-axis minimum value of the graph.

Limit Test Result dialog box

This dialog box provides the following GUI for displaying the limit test result. The 
result data is shown in the data list area below the Length field.

Ch Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel of the data to display.

Length Data length

The limit test data contains the following information.

(aaaaa) BIN: bb  DATA: +c.ccccccE+dd

(aaaaa) Data index aaaaa

BIN: Bin number bb (01 to 12) See “Limit Test Setup dialog box” 
on page 4-32.

If the limit test data is out of the bins, 00 is set for the 
GRADING mode and 15 is set for the SORTING mode.

DATA: Limit test data +c.ccccccE+dd
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Trace Statistical Result dialog box

This dialog box provides the following GUI for displaying the trace statistical result. 
The result data is displayed in the Mean, Std. Dev., Min., and Max. fields.

Ch Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel of the data to display.

Feed Always SENSE

Element Type of data to display, AMPS, VOLTS, or OHMS

AMPS: Current measurement data

VOLTS: Voltage measurement data

OHMS: Resistance data given by Resistance=Vmeas/Imeas

In the above formula, Vmeas is the voltage measurement data, 
and Imeas is the current measurement data.

For details on using resistance compensation, see “Resistance 
Compensation” on page 6-16.

Length Data length

Mean Mean value

Std. Dev. Standard deviation

Min. Minimum value

Max. Maximum value
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File key group
Pressing the File key displays the following two softkeys for saving a file on and 
loading a file from a USB memory connected to the front panel USB-A connector.

Save Displays the following five softkeys for saving a file. Pressing a softkey displays the 
File Selection dialog box. See “File Selection dialog box” on page 4-41.

Measure Saves a measurement data file.

Math Saves a math result data file.

Limit Test Saves a limit test result data file.

Trace Saves a trace buffer data file.

Config Saves a system setting data file.

Load Displays the following softkey for loading a file. Pressing the softkey displays the 
File Selection dialog box. See “File Selection dialog box” on page 4-41.

Config Loads a system setting data file.

File Selection dialog box

This dialog box provides the following GUI for saving or loading a file.

Path Folder name for saving or loading a file.

File Name File name to save or load.

The files and folders saved in the specified folder are listed in the area between the 
Path field and the File Name field. This area can be used for selecting a file to save 
or overwrite. To select a file, highlight its name in this area.

For saving a system setting file, if the file extension is not specified, “.sta” is added 
automatically. For saving the other data file, “.csv” is added automatically.
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Program key group
Pressing the Program key displays the following four softkeys for setting and 
controlling the program memory.

The program memory can be defined by using the SCPI commands while the B2900 
is in the remote mode. 

Catalog Displays the Program Catalog dialog box which lists the programs saved in the 
program memory. This dialog box is also used to specify the memory program to 
use. To select a memory program, highlight its name in this list.

View Displays the Program View dialog box which shows the program code of the 
specified program. 

Variable Displays the Variable dialog box which lists the variables used in the memory 
programs. Available index is 1 to 100.

Control Displays the following five softkeys for controlling the operation of the program 
memory.

Run Starts the specified memory program.

Pause Pauses the execution of the memory program.

Step Starts the step execution of the specified memory program.

Stop Stops the execution of the memory program.

Continue Continues the execution of the memory program presently 
paused.
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I/O key group
Pressing the I/O key displays the following five softkeys for setting the I/O 
interfaces.

Format Displays the five softkeys for setting the data output format. See “Data Output 
Format” on page 4-44.

LAN Displays the following four softkeys for managing the LAN interface.

Config Displays the LAN Configuration dialog box used to set the 
configuration of the LAN interface. See “LAN Configuration 
dialog box” on page 4-46.

Status Displays the LAN Status dialog box which displays the status of 
the LAN interface.

Reset Resets all of the LAN connections.

Defaults Sets the LAN settings to the factory default settings.

Pressing the Reset softkey or the Defaults softkey displays a confirmation dialog 
box. Press the OK softkey to confirm the specified action, or press the Cancel/Local 
key to cancel the action.

USB Displays the USB Status dialog box which displays the VISA USB connect string. 

Example: USB0::2391::36376::MY12345678::0::INSTR

GPIB Displays the GPIB Configuration dialog box used to set the GPIB address of the 
B2900. This dialog also displays the VISA GPIB connect string. 

Example: GPIB0::23::INSTR

DIO Displays the following two softkeys for managing the Digital I/O interface.

Config Displays the DIO Configuration dialog box used to set the 
configuration of the Digital I/O interface. See “DIO 
Configuration dialog box” on page 4-46.

R/W Displays the DIO Read/Write dialog box used to read or write a 
value set to the Digital I/O interface. See “DIO Read/Write 
dialog box” on page 4-47.
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Data Output Format

Pressing the Format softkey displays the following five softkeys for setting the 
format and elements of the output data.

Measure Displays the Format (Measure) dialog box used to set the 
elements of the measurement data output. See “Format 
(Measure) dialog box” on page 4-44.

Math/Limit Displays the Format (Math/Limit) dialog box used to set the 
elements of the math result data output and the limit test result 
data output. See “Format (Math/Limit) dialog box” on page 
4-45.

Trace Displays the Format (Trace) dialog box used to set the elements 
of the trace data output. See “Format (Trace) dialog box” on 
page 4-45.

Data Type Displays the following three softkeys for specifying the data 
output format. The present setting is indicated by an asterisk on 
the softkey label.

ASCII ASCII format

REAL32 IEEE-754 single precision format, 4-byte

REAL64 IEEE-754 double precision format, 8-byte

Byte Swap Displays the following two softkeys for enabling or disabling 
the byte swap for the IEEE-754 precision format data output. 
The present setting is indicated by an asterisk on the softkey 
label.

OFF Disables the byte swap. Normal byte order.

ON Enables the byte swap. Reverse byte order.

If Byte Swap=ON, the byte order is reversed. Byte 1 to byte 4 are sent in the order of 
byte 4 to byte 1 for the IEEE-754 single precision format, and byte 1 to byte 8 are 
sent in the order of byte 8 to byte 1 for the IEEE-754 double precision format.

Format (Measure) dialog box

This dialog box provides the following parameters for setting the elements of the 
measurement data output.

Voltage Voltage data output, ON or OFF

Current Current data output, ON or OFF
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Resistance Resistance data output, ON or OFF

Source Source data output, ON or OFF

Time Time data output, ON or OFF

Status Status data output, ON or OFF

Format (Math/Limit) dialog box

This dialog box provides the following parameters for setting the elements of the 
math result data output and the limit test result data output.

Data Result data output, ON or OFF

Time Time data output, ON or OFF

Status Status data output, ON or OFF

Format (Trace) dialog box

This dialog box provides the following parameters for setting the elements of the 
trace statistical data output.

Ch Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel set by this dialog box.

Data Trace data. Selects one from the following data elements.

MEAN Mean value

STD.DEV. Standard deviation

MIN. Minimum value

MAX. Maximum value

PK-PK Peak to peak value

Timestamp Timestamp data format. Selects one from the following 
selections.

ABSOLUTE Absolute value (ABS.). Returns the 
incremental value for the first timestamp 
data.

DELTA Delta value (DELTA). Returns the 
incremental value for the previous 
timestamp data.
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LAN Configuration dialog box

This dialog box provides the following parameters for setting the configuration of 
the LAN interface.

mDNS mDNS (multicast DNS) status, ON or OFF

IP Address Config. IP address configuration, AUTO or MANUAL

AUTO configuration uses the DHCP server.

IP Address IP address of this instrument, used for the MANUAL IP 
address configuration

Subnet Subnet mask, used for the MANUAL IP address 
configuration

Gateway IP address of gateway, used for the MANUAL IP address 
configuration

DNS Server Config. DNS server configuration, AUTO or MANUAL

DNS Server IP address of DNS server, primary and secondary, used 
for the MANUAL DNS server configuration

Hostname Host name of this instrument

WINS Server IP address of WINS server, primary and secondary

DIO Configuration dialog box

This dialog box provides the following parameters for setting the configuration of 
the Digital I/O interface.

Pin # Digital I/O pin number, 1 to 14

This field specifies the pin set by this dialog box.

Function Function of the specified pin of the Digital I/O interface, 
digital signal input/output (DIGITAL I/O), digital signal 
input (DIGITAL IN), trigger output (TRIGGER OUT), 
trigger input (TRIGGER IN), or high voltage state 
(HIGH VOLTAGE LAMP, HI-VOLT LAMP, only for 
pin 14)

If Function is set to HIGH VOLTAGE LAMP, other 
setup parameters on this dialog box is ignored.

Polarity Polarity of the input/output function, positive 
(POSITIVE, POS.) or negative (NEGATIVE, NEG.)
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Output Trigger Type Type of output trigger, edge (EDGE) or level (LEVEL)

Output Trigger Timing Timing of the output trigger, after action (arm, trigger, 
and device action) (AFTER), before action (BEFORE), 
or both (BOTH)

Output Pulse Width Pulse width of the output trigger, 10 s to 10 ms

For more information about the trigger function, see “Trigger key group” on page 
4-35.

DIO Read/Write dialog box

This dialog box provides the following parameters for reading or writing a value set 
to the Digital I/O interface.

Format Format of the value set to the Mask Value field and the Value 
field, binary (BIN), decimal (DEC), or hexadecimal (HEX)

Mask Value Mask value which indicates the pattern of the un-used bits of 
the Digital I/O interface

The READ assist key is used to read the mask value presently 
set to the Digital I/O interface.

The WRITE assist key is used to set the specified mask value to 
the Digital I/O interface.

Value Value set to the Digital I/O interface

The READ assist key is used to read the value presently set to 
the Digital I/O interface.

The WRITE assist key is used to write the specified value to the 
Digital I/O interface.
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Display key group
Pressing the Display key displays the following four softkeys for setting the display 
functions. The present setting is indicated by an asterisk on the softkey label.

Remote Displays the following two softkeys for enabling or disabling the front panel display 
when the B2900 is in the remote mode.

OFF Disables the front panel display. Effective for fast operation.

ON Enables the front panel display.

Color Displays the following two softkeys for specifying the display color set.

Set 1 Sets the color set 1.

Set 2 Sets the color set 2.

Zoom Displays the following two softkeys for enabling or disabling the display zoom.

OFF Disables the zoom. Normal display.

ON Enables the zoom. Only the measured data is displayed.

Zoom-in can be cancelled by pressing the Zoom Out assist key.

In the zoom-in state, setup information is not displayed, and the measurement result 
is zoomed. Then,

• the Dual view displays the primary measurement data with a large font, and the 
secondary measurement data for each channel with a small font.

• the Single view displays the primary and secondary measurement data with a 
large font.

Digits Displays the following four softkeys for specifying the data display resolution.

4 Sets 3½ digit resolution.

5 Sets 4½ digit resolution.

6 Sets 5½ digit resolution.

7 Sets 6½ digit resolution.
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System key group
Pressing the System key displays the following nine softkeys used for several 
system setups.

Error Displays the following two softkeys to view or clear errors.

Log Displays the Error Log dialog box which displays the SCPI 
errors.

Clear Clears the error buffer immediately.

Reset Initializes the B2900.

Pressing the Reset softkey displays a confirmation dialog box. Press the OK softkey 
to start initialization, or the Cancel/Local key to cancel.

Cal/Test Displays the following two softkeys for performing self-calibration or self-test.

Self-Cal Performs self-calibration.

Self-Test Performs self-test.

Pressing the softkey displays a confirmation dialog box. Press the OK softkey to 
start self-calibration or self-test, or the Cancel/Local key to cancel.

PLC Displays the following two softkeys to specify the power line frequency. The 
present setting is indicated by an asterisk on the softkey label.

50 Hz Specifies the power line frequency 50 Hz.

60 Hz Specifies the power line frequency 60 Hz.

Timestamp Displays the following two softkeys to clear timestamp.

Clear Clears the timestamp. Pressing this softkey displays the 
confirmation dialog box. Press the OK softkey to clear the 
timestamp, or the Cancel/Local key to cancel.

Auto CLR Displays the following two softkeys for setting the automatic 
clear of the timestamp. The present setting is indicated by an 
asterisk on the softkey label.

OFF Disables the automatic clear of the timestamp.

ON Enables the automatic clear of the timestamp.
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Start-up Displays the System Start-up dialog box which provides the following setup 
parameters.

Power-on State Power-on state, RST, RCL0, RCL1, RCL2, RCL3, or RCL4

The power-on state can be selected from the factory default 
reset condition (RST) and user conditions RCL0, RCL1, 
RCL2, RCL3, and RCL4 which can be defined by using the 
*SAV 0, *SAV 1, *SAV 2, *SAV 3, and *SAV 4 commands, 
respectively, while the B2900 is in the remote mode. 

Power-on Program Power-on program execution ON or OFF

If this parameter is ON, the power-on program is 
automatically executed when the B2900 is turned on.

The power-on program can be defined by using the 
:PROG:PON:COPY command while the B2900 is in the 
remote mode. 

Sound Displays the following two softkeys to enable or disable the beep and sound. The 
present setting is indicated by an asterisk on the softkey label.

OFF Disables the beep and sound.

ON Enables the beep and sound.

SCPI Displays the following two softkeys for specifying the B2900 remote control 
command set. The present setting is indicated by an asterisk on the softkey label.

Default Specifies the default command set which supports all B2900 
functions.

2400 Specifies the conventional command set designed for using the 
existing programs which you created to control existing 
instruments, such as Series 2400 by Keithley Instruments, Inc.

Info. Displays the following four softkeys.

Revision Displays the Revision dialog box which displays the model 
number, serial number, and firmware revision of the B2900.

Date/Time Displays the Date and Time dialog box which is used to view or 
set the date and time.

Update Used for firmware update.

Demo. Starts demonstration.
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Front Panel Operations
This chapter explains how to use the Agilent B2900. 

• “Basic Operations”

• “Configuring Various Settings”

• “Controlling the Source Output”

• “Controlling the Measurement Function”

• “Using the Math Function”

• “Performing the Limit Test”

• “Using the Trace Buffer”

• “Using Program Memory”

NOTE Turning the instrument on or off

Press the line switch. When the power is on, the LED below the switch is turned 
green. 

NOTE Setting the instrument to local mode

Press the Cancel/Local key. 

The front panel keys are available when the instrument is in local mode. 

NOTE Enabling or disabling the channel

Press the On/Off switch. 

The channel status is indicated by the lighting status of the switch as follows. 

Off: The channel is disabled. 

Green: The channel is enabled. 

Red: The channel is in the high voltage state. 

NOTE Starting measurement

Press the Trigger key. According to the setting conditions, the single (one shot) 
measurement is performed with the DC bias output, staircase sweep output, pulsed 
bias output, or pulsed sweep output. 

Press the Auto key. The repeat (continuous) measurement is performed with the DC 
bias output (of the Source value). 
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Basic Operations
Use the field pointer to specify a setup field in the setup screen. The field pointer 
can take the following states. Change the status as needed during the setup of 
B2900. 

MOVE status Highlighted in blue. You can move the pointer from field to 
field. 

EDIT status Highlighted in green. You can change the value of the current 
field. 

Changing the Setting in a Field

1. If the field pointer is in the EDIT status, press the rotary knob. The pointer status 
is changed to MOVE. 

2. Turn the rotary knob or press the arrow keys to move the field pointer. 

3. Move the field pointer to the item to be changed and press the rotary knob. The 
pointer status is changed to EDIT. 

4. Enter a value or character by pressing the numeric/alpha keys, turning the rotary 
knob, or pressing the arrow keys. Press the rotary knob to fix the setting value. 
The pointer status is changed to MOVE. 

Or press the assist key corresponding to the setting value to fix the setting value. 
The pointer status is changed to MOVE. 

NOTE Digit pointer

In numeric value entry fields such as the Source and Limit (Compliance) fields, you 
can specify only one digit to change its value. 

When the field pointer is in the EDIT status (i.e., all digits in the entry field are 
highlighted in green), pressing the arrow keys changes the pointer to the digit 
pointer, which points only one digit in the entry field. In this status, the following 
operations are allowed. 

The arrow keys are used to move the pointer. 

The numeric/alpha keys and rotary knob are used to change the value of the digit 
indicated by the pointer. 

When the pointer is on the decimal point, turning the knob moves the decimal point. 
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Changing the Settings on a Dialog Box

1. Set the items on the dialog box in the same way as described in “Changing the 
Setting in a Field” on page 5-3.

2. To apply the settings, press Apply. 

To apply all settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key instead of pressing 
Apply. 
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Configuring Various Settings
This section describes how to configure various settings apart from the source 
output and measurement functions. 

• “Setting the Power Frequency”

• “Resetting to the Initial Settings”

• “Setting the Beeper”

• “Setting the Date and Time”

• “Performing the Self-Test”

• “Performing the Self-Calibration”

• “Setting the Operations at Power On”

• “Displaying the Error Message”

• “Clearing the Error Buffer”

• “Clearing Timestamp”

• “Setting the Automatic Clear of Timestamp”

• “Displaying the Firmware Revision”

• “Setting the GPIB Address”

• “Setting the Remote Control Command Set”

• “Setting the Remote Display Mode”

Setting the Power Frequency

1. Press the More > System > PLC function keys. 

2.  Press 50 Hz or 60 Hz. To cancel the setting change, press the Cancel/Local key. 

Resetting to the Initial Settings

1. Press the More > System > Reset function keys. 

The Confirmation dialog box is displayed. 

2. Press OK to reset. To cancel the operation, press the Cancel/Local key. 
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Setting the Beeper

1. Press the More > System > More > Sound function keys. 

2. To enable the beeper, press ON. To disable it, press OFF. To cancel the setting 
change, press the Cancel/Local key. 

Setting the Date and Time

1. Press the More > System > More > Info. function keys. 

2. Press Date/Time. 

The Date and Time dialog box is displayed. 

3. Set the date and time. 

4. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

Performing the Self-Test

1. Press the On/Off switch and confirm that the switch is turned off. 

2. Disconnect test leads and cables from the channel terminals. 

3. Press the More > System > Cal/Test > Self-Test function keys. 

The Confirmation dialog box is displayed. 

4. Press OK to perform the self-test. To cancel the operation, press the 
Cancel/Local key. 

Performing the Self-Calibration

The self-calibration must be performed after warming-up of 60 minutes.

1. Press the On/Off switch and confirm that the switch is turned off. 

2. Disconnect test leads and cables from the channel terminals. 

3. Press the More > System > Cal/Test > Self-Cal function keys. 

The Confirmation dialog box is displayed. 
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4. Press OK to perform the self-calibration. To cancel the operation, press the 
Cancel/Local key. 

Setting the Operations at Power On

1. Press the More > System > More > Start-up function keys. 

The System Start-up dialog box is displayed. 

2. See “Start-up” on page 4-50 to set each parameter. 

Displaying the Error Message

1. Press the More > System > Error function keys. 

2. Press Log. 

The error message is displayed in the Error Log dialog box. 

3. Press OK to close the dialog box. 

Clearing the Error Buffer 

1. Press the More > System > Error function keys. 

2. To clear the error buffer, press Clear. To cancel the operation, press the 
Cancel/Local key. 

Clearing Timestamp 

1. Press the More > System > Timestamp function keys. 

2. Press Clear. The Confirmation dialog box is displayed. 

3. To perform the operation, press OK. To cancel the operation, press the 
Cancel/Local key. 

Setting the Automatic Clear of Timestamp

1. Press the More > System > Timestamp function keys. 

2. Press Auto CLR. 

3. To enable the automatic clear, press ON. To disable it, press OFF. To cancel the 
setting change, press the Cancel/Local key. 
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Displaying the Firmware Revision

1. Press the More > System > More > Info. function keys. 

2. Press Revision. 

The revision information is displayed in the Revision dialog box. 

3. Press OK to close the dialog box. 

Setting the GPIB Address

1. Press the More > I/O function keys. 

2. Press GPIB. 

The GPIB Configuration dialog box is displayed. 

3. Set the GPIB address. 

4. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

Setting the Remote Control Command Set

1. Press the More > System > More > SCPI function keys. 

2. To use the default command set, press Default. To use the conventional 
command set, press 2400. 

3. If the command set is changed, the Confirmation dialog box is displayed. To 
perform the operation, press OK. To cancel the operation, press the 
Cancel/Local key.

Setting the Remote Display Mode

1. Press the More > Display function keys. 

2. Press Remote. 

3. To enable the screen display in remote mode, press ON. To disable it, press OFF. 
To cancel the setting change, press the Cancel/Local key.
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The field pointer moves to the Source mode setup field. 

2. To set the source mode to voltage source mode, press the VOLTS (V) assist key. 
To set it to current source mode, press the AMPS (I) assist key. 

Applying the DC Voltage/Current

1. For the Single view, press the Source assist key. For the Dual view, press the 
Ch1 Source or Ch2 Source assist key. 

The field pointer moves to the Source value setup field. 

2. Enter the output value by using the numeric/alpha keys, rotary knob, and arrow 
keys. 

3. Press the rotary knob or assist key to fix the setting value. 

4. Press the On/Off switch for channel 1 or 2 (Ch 1 or Ch 2). 

The output of the specified voltage/current starts. While the switch is turned 
green, the output continues and changes in setting values are immediately 
reflected in the output. 

Stopping the Source Output

1. Press the On/Off switch for channel 1 or 2 (Ch 1 or Ch 2). 

The output and measurement are stopped and the switch turns off. 

Setting the Limit/Compliance Value

For details on this function, see “Limit/Compliance” on page 6-3. 

1. For the Single view, press the Limit assist key. For the Dual view, press the Ch1 
Limit or Ch2 Limit assist key. 

The field pointer moves to the Limit (Compliance) field. 

2. Enter the limit/compliance value by using the numeric/alpha keys, rotary knob, 
and arrow keys. 

3. Press the rotary knob or assist key to fix the setting value. 

Setting the Output Range

For details on this function, see “Ranging Mode” on page 6-4 and “Range 
parameters” on page 4-11. 
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1. Press the View key to display the Single view. If the Range parameters are not 
displayed, press the Hide XXXX assist key. 

2. Move the field pointer to the Source Volts: Spot (voltage source range) or 
Source Amps: Spot (current source range) field. 

3. Press the rotary knob to change the pointer status to EDIT. 

4. To set the range operation mode to the auto range operation, press the AUTO 
assist key. To set it to the fixed range operation, press the FIXED assist key. The 
pointer status is changed to MOVE. 

5. Move the field pointer to the range value setup field (on the right side of the 
Source Volts: Spot or Source Amps: Spot field). 

6. Press the rotary knob to change the pointer status to EDIT. 

7. Press the assist key to set the output range. 

For the auto range operation, set the minimum range of the range operation. 

For the fixed range operation, set the range to be used. 

Setting the Pulse Output

For details on this function, see “Pulse Output” on page 6-7.

1. Press the View key to display the Single view. 

2. Press the Show Pulse assist key to display the Pulse parameters. For details on 
the parameters, see “Pulse parameters” on page 4-14. 

3. Move the field pointer to the Pulse field. 

4. Press the rotary knob to change the pointer status to EDIT. 

5. Press the ON assist key. The pointer status is changed to MOVE. 

6. Move the field pointer to the pulse parameter setup field (Peak, Delay, or 
Width). 

7. Press the rotary knob to change the pointer status to EDIT. 

8. Enter the pulse peak value (Peak), delay time (Delay), or pulse width (Width). 

9. Press the rotary knob or assist key to fix the setting value. 

10. Repeat steps 6 to 9 for all parameters. 

NOTE Outputting the pulse voltage/current
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Press the On/Off switch to start outputting the Source value. The Source value is 
used as the pulse base value. 

Press the Trigger key to perform the specified pulse output and measurement. 

Setting the Sweep Output

For details on this function, see “Sweep Output” on page 6-9.

The following procedure sets the staircase sweep output. 

Before performing the pulsed sweep output, it is necessary to set the staircase sweep 
output and pulse output. For details on setting the pulse output, see “Setting the 
Pulse Output” on page 5-11. 

1. Press the View key to display the Single view. 

2. Press the Show Sweep assist key to display the Sweep parameters. For details on 
the parameters, see “Sweep parameters” on page 4-12. 

3. Move the field pointer to the Sweep Parameters field. 

4. Press the rotary knob to change the pointer status to EDIT. 

5. Press the LINEAR SINGLE, LINEAR DOUBLE, LOG SINGLE, or LOG 
DOUBLE assist key to select the relevant sweep operation. The pointer status is 
changed to MOVE. 

6. Move the field pointer to the sweep parameter setup field (Start, Stop, Points, or 
Step). 

7. Press the rotary knob to change the pointer status to EDIT. 

8. Enter the sweep start value (Start), sweep stop value (Stop), number of sweep 
steps (Points), or sweep step value (Step). 

9. Press the rotary knob or assist key to fix the setting value. 

10. Repeat steps 6 to 9 for all parameters. 

NOTE Outputting the sweep voltage/current

Press the On/Off switch to start outputting the Source value. 

Press the Trigger key to perform the specified sweep output and measurement. 
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Setting the List Sweep Output

For details on this function, see “List Sweep” on page 6-10.

1. Press the View key to display the Single view. 

2. Press the Show Sweep assist key to display the Sweep parameters. 

3. Move the field pointer to the Sweep Parameters field. 

4. Press the rotary knob to change the pointer status to EDIT. 

5. Press the LIST assist key. The pointer status is changed to MOVE. 

6. Move the field pointer to the sweep parameter setup field (Start, Stop, or Points). 

7. Press the rotary knob to change the pointer status to EDIT. 

8. Press the Edit assist key. The List Sweep dialog box is displayed. 

9. Set the list sweep source using the List Sweep dialog box. For details, see “List 
sweep setup” on page 4-12. 

10. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

NOTE Load assist key

If you press the Load assist key instead of the Edit assist key in step 8, the Load List 
Sweep Data dialog box is displayed to allow you to load list sweep data from a USB 
memory. 

For details, see “List sweep setup” on page 4-12. 

NOTE Outputting the list sweep voltage/current

Press the On/Off switch to start outputting the Source value. 

Press the Trigger key to perform the specified list sweep output and measurement. 

Setting the Source Output Trigger Parameters

For details on this function, see “Trigger System” on page 6-27.

1. Press the View key to display the Single view. 
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2. Press the Show Trigger assist key to display the Trigger parameters. For details 
on the parameters, see “Trigger parameters” on page 4-15. 

3. Move the field pointer to the Trigger field. 

4. Press the rotary knob to change the pointer status to EDIT. 

5. Press the AUTO, SYNC, TIMER, or MANUAL assist key to set the trigger 
type. The pointer status is changed to MOVE. 

6. Move the field pointer to the trigger parameter setup field (Count, Delay, Period, 
or Trigger in the Source column). 

7. Press the rotary knob to change the pointer status to EDIT. 

8. Enter the trigger count (Count), trigger delay time (Delay), trigger period 
(Period), or trigger source (Trigger). 

9. Press the rotary knob or assist key to fix the setting value. 

10. Repeat steps 6 to 9 for all parameters. 

NOTE If you want to set the trigger parameters in detail, select the MANUAL trigger type 
and use the Trigger Configuration dialog box opened by pressing the Trigger > 
Config function keys. See “Trigger key group” on page 4-35.

Setting the Source Wait Time

For details on this function, see “Measurement Time” on page 6-5. 

1. Press the Config > Common > Wait function keys. 

The Wait Control dialog box is displayed. 

2. Set each parameter in the Source column. For details on the parameters, see 
“Wait Control dialog box” on page 4-29. 

3. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

Setting the Output Filter

For details on this function, see “Output Filter” on page 6-11.

1. Press the Config > Source > Filter function keys. 
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The Output Filter dialog box is displayed. 

2. Set each parameter. For details on the parameters, see “Output Filter dialog box” 
on page 4-26. 

3. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

Setting the Connection Type

For details on this function, see “2-Wire Connections or 4-Wire Connections” on 
page 3-11.

1. Press the Config > Source > Connection function keys. 

The Output Connection dialog box is displayed. 

2. In the Ch field, set the channel to which the setting change is applied. 

3. Set 2-WIRE or 4-WIRE in the Sensing Type field. 

4. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

Setting the Low Terminal State

For details on this function, see “Floating” on page 3-12.

1. Press the Config > Source > Connection function keys. 

The Output Connection dialog box is displayed. 

2. In the Ch field, set the channel to which the setting change is applied. 

3. Set GROUNDED or FLOATING in the Low Terminal State field. 

4. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 
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Enabling or Disabling the High Capacitance Mode

For details on this function, see “High Capacitance Mode” on page 6-15.

1. Press the Config > Source > Connection function keys. 

The Output Connection dialog box is displayed. 

2. In the Ch field, set the channel to which the setting change is applied. 

3. Set ON (enable) or OFF (disable) in the High Capacitance Mode field. 

4. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

Enabling or Disabling the Over Voltage/Current 
Protection

For details on this function, see “Over Voltage/Current Protection” on page 6-12.

1. Press the Config > Source > Connection function keys. 

The Output Connection dialog box is displayed. 

2. In the Ch field, set the channel to which the setting change is applied. 

3. Set ON (enable) or OFF (disable) in the Over Voltage/Current Protection field. 

4. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

Specifying the Output-Off Status

For details on this function, see “Output-Off Status” on page 6-13.

1. Press the Config > Source > Connection function keys. 

The Output Connection dialog box is displayed. 

2. In the Ch field, set the channel to which the setting change is applied. 

3. Set HIGH Z (high impedance), NORMAL (normal), or ZERO (zero volt) in the 
Output-Off State field. 

4. To apply the settings, press Apply. 
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To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

Enabling or Disabling the Automatic Output-On 
Function

For details on this function, see “Automatic Output-ON/OFF Function” on page 
6-14.

1. Press the Config > Source > Connection function keys. 

The Output Connection dialog box is displayed. 

2. In the Ch field, set the channel to which the setting change is applied. 

3. Set ON (enable) or OFF (disable) in the Auto Output-On field. 

4. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

Enabling or Disabling the Automatic Output-Off 
Function

For details on this function, see “Automatic Output-ON/OFF Function” on page 
6-14.

1. Press the Config > Source > Connection function keys. 

The Output Connection dialog box is displayed. 

2. In the Ch field, set the channel to which the setting change is applied. 

3. Set ON (enable) or OFF (disable) in the Auto Output-Off field. 

4. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

Setting the Ranging Mode of the Sweep Source

For details on this function, see “Ranging Mode” on page 6-4. 

1. Press the Config > Source > Sweep function keys. 
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The Sweep dialog box is displayed. 

2. In the Ch field, set the channel to which the setting change is applied. 

3. Set BEST, AUTO, or FIXED in the Sweep Ranging field. For details, see 
“Sweep dialog box” on page 4-27. 

4. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

Setting the Sweep Direction

1. Press the Config > Source > Sweep function keys. 

The Sweep dialog box is displayed. 

2. In the Ch field, set the channel to which the setting change is applied. 

3. Set UP or DOWN in the Sweep Direction field. For details, see “Sweep dialog 
box” on page 4-27. 

4. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

Setting the Source Output Value after Sweep

1. Press the Config > Source > Sweep function keys. 

The Sweep dialog box is displayed. 

2. In the Ch field, set the channel to which the setting change is applied. 

3. Set START VALUE or END VALUE in the Output after Sweep field. For 
details, see “Sweep dialog box” on page 4-27. 

4. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 
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Controlling the Measurement Function
This section describes how to control the measurement function of Agilent B2900. 

• “Enabling the Resistance Measurement”

• “Setting the Measurement Mode”

• “Performing Spot Measurement”

• “Stopping Measurement”

• “Setting the Measurement Speed”

• “Setting the Measurement Range”

• “Performing Sweep Measurement”

• “Setting the Measurement Trigger Parameters”

• “Setting the Measurement Wait Time”

• “Setting the Measurement Auto Range Operation”

• “Enabling or Disabling the Resistance Compensation”

Enabling the Resistance Measurement

1. Press the View key to display the Single view. If the Range parameters are not 
displayed, press the Hide XXXX assist key.

2. Move the field pointer to the Measure Ohms (resistance measurement range) 
field. If this field is set to OFF, the resistance measurement is disabled.

3. Press the rotary knob to change the pointer status to EDIT.

4. Press the AUTO, FIXED, or V/I assist key to set the resistance measurement 
operation. The pointer status is changed to MOVE.

For details on the resistance measurement operation, see “Range parameters” on 
page 4-11.

To set the measurement range continuously, see “Setting the Measurement 
Range” on page 5-21.
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Setting the Measurement Mode

1. For the Single view, press the Measure assist key. For the Dual view, press the 
Ch1 Measure or Ch2 Measure assist key. 

2. To set the measurement mode to the current measurement, press the AMPS (I) 
assist key. To set it to the voltage measurement, press the VOLTS (V) assist key. 
To set it to the resistance measurement, press the OHMS (R) assist key. To set it 
to the power measurement, press the WATTS (P) assist key. 

Performing Spot Measurement

1. Set the measurement mode. For details, see “Setting the Measurement Mode” on 
page 5-20. 

2. Set the output voltage or current. For details, see “Applying the DC 
Voltage/Current” on page 5-10.

3. Press the On/Off switch for channel 1 or 2 (Ch1 or Ch2). 

The output of the specified voltage/current starts. While the switch is turned 
green, the output continues and changes in setting values are immediately 
reflected in the output. 

4. Press the Trigger key. 

The spot measurement is performed. 

NOTE For details on how to change the Limit/Compliance value, see “Setting the 
Limit/Compliance Value” on page 5-10. 

Stopping Measurement

1. Press the On/Off switch for channel 1 or 2 (Ch1 or Ch2). 

The output and measurement are stopped and the switch turns off. 

Setting the Measurement Speed

For details on this function, see “Measurement Time” on page 6-5. 

1. Press the View key to display the Single view. 

2. Press the Speed assist key. 
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3. Press the AUTO, SHORT, MEDIUM, NORMAL, LONG, or MANUAL assist 
key to set the measurement speed. For details, see “Speed” on page 4-10. 

4. When MANUAL is specified, the aperture time setup field and PLC setup field 
are displayed. Enter and fix a value in either of the fields to set the measurement 
speed. 

Setting the Measurement Range

For details on this function, see “Ranging Mode” on page 6-4 and “Range 
parameters” on page 4-11.

1. Press the View key to display the Single view. If the Range parameters are not 
displayed, press the Hide XXXX assist key.

2. Move the field pointer to the Measure Volts (voltage measurement range), 
Measure Amps (current measurement range), or Measure Ohms (resistance 
measurement range) field. 

3. Press the rotary knob to change the pointer status to EDIT. 

4. To set the range operation mode to the auto range operation, press the AUTO 
assist key. To set it to the fixed range operation, press the FIXED assist key. The 
pointer status is changed to MOVE. 

5. Move the field pointer to the range value setup field (on the right side of the 
Measure Volts, Measure Amps, or Measure Ohms field). 

6. Press the rotary knob to change the pointer status to EDIT. 

7. Press the assist key to set the measurement range. 

For the auto range operation, set the minimum range of the range operation. 

For the fixed range operation, set the range to be used. 

Performing Sweep Measurement

For details on this function, see “Sweep Output” on page 6-9.

1. Press the View key to display the Single view. 

2. Set the source function. For details, see “Setting the Source Output Mode” on 
page 5-9. 

3. Set the Source value and Limit (Compliance) value. For details, see “Applying 
the DC Voltage/Current” on page 5-10 and “Setting the Limit/Compliance 
Value” on page 5-10. 
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4. Set the measurement mode. For details, see “Setting the Measurement Mode” on 
page 5-20. 

5. Set the sweep source. For details, see “Setting the Sweep Output” on page 5-12. 

6. Press the View key to display the Graph view. 

7. Press the On/Off switch for channel 1 or 2 (Ch1 or Ch2). 

The output of the Source value starts. While the switch is turned green, the 
output continues and changes in setting values are immediately reflected in the 
output.

8. Press the Trigger key. 

The sweep measurement is performed and the measurement result is displayed 
in a graph. 

Setting the Measurement Trigger Parameters

For details on this function, see “Trigger System” on page 6-27.

1. Press the View key to display the Single view. 

2. Press the Show Trigger assist key to display the Trigger parameters. For details 
on the parameters, see “Trigger parameters” on page 4-15. 

3. Move the field pointer to the Trigger field. 

4. Press the rotary knob to change the pointer status to EDIT. 

5. Press the AUTO, SYNC, TIMER, or MANUAL assist key to set the trigger 
type. The pointer status is changed to MOVE. 

6. Move the field pointer to the trigger parameter setup field (Count, Delay, Period, 
or Trigger in the Measure column). 

7. Press the rotary knob to change the pointer status to EDIT. 

8. Enter the trigger count (Count), trigger delay time (Delay), trigger period 
(Period), or trigger source (Trigger). 

9. Press the rotary knob or assist key to fix the setting value. 

10. Repeat steps 6 to 9 for all parameters. 

NOTE If you want to set the trigger parameters in detail, select the MANUAL trigger type 
and use the Trigger Configuration dialog box opened by pressing the Trigger > 
Config function keys. See “Trigger key group” on page 4-35.
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Setting the Measurement Wait Time

For details on this function, see “Measurement Time” on page 6-5. 

1. Press the Config > Common > Wait function keys. 

The Wait Control dialog box is displayed. 

2. Set each parameter in the Measure column. For details on the parameters, see 
“Wait Control dialog box” on page 4-29. 

3. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

Setting the Measurement Auto Range Operation

For details on this function, see “Ranging dialog box” on page 4-28.

1. Press the Config > Measure > Ranging function keys.

The Ranging dialog box is displayed. 

2. In the Ch field, set the channel to which the setting change is applied. 

3. Set the current measurement auto range operation (NORMAL, SPEED, or 
RESOLN) in the Current Auto Ranging field. 

Also, set the threshold of the auto range operation in the Threshold field. 

4. Set the voltage measurement auto range operation (NORMAL, SPEED, or 
RESOLN) in the Voltage Auto Ranging field. 

Also, set the threshold of the auto range operation in the Threshold field. 

5. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 
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Enabling or Disabling the Resistance Compensation

1. Press the Config > Measure > R Compen function keys. 

2. Specify the channel to which the setting change is applied. 

ALL: Channels 1 and 2 (Ch 1 and Ch 2)

Ch 1: Channel 1 (Ch 1) only

Ch 2: Channel 2 (Ch 2) only

3. To enable the resistance compensation, press ON. To disable it, press OFF. To 
cancel the setting change, press the Cancel/Local key.
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Using the Math Function
This section describes how to use the math function. For details on this function, see 
“Math Expression” on page 6-17. Also, for details on the setup parameters, see 
“Math Expression dialog box” on page 4-30. 

1. Press the Function > Math function keys. 

The Math Expression dialog box is displayed. 

2. In the Ch field, set the channel to which the setting change is applied. 

3. In the Status field, set ON (enable) or OFF (disable) for the math function. 

4. In the Unit String field, enter the unit for the calculation result data. 

To enter alphabets, press the ABC assist key and then use the numeric/alpha 
keys. 

To enter numbers, press the 123 assist key and then use the numeric/alpha keys. 

To delete a character, highlight the character to be deleted and then press the 
Delete function key. 

To insert a character, highlight the character at the position where to insert the 
character and then press the Insert function key. 

5. Select a math expression to use. 

To select a math expression, highlight the name of the math expression in the list 
area below the Unit String field. 

6. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 
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Performing the Limit Test
This section describes how to set the limit test and how to display the result of the 
limit test. For details on this function, see “Limit Test” on page 6-20. 

To perform the limit test, set the composite limit test, individual limit tests, and 
source output and measurement conditions, and then press the Trigger key. 

• “Setting the Composite Limit Test”

• “Setting Individual Limit Tests”

• “Displaying the Limit Test Result”

Setting the Composite Limit Test

For details on the setup parameters, see “Composite Limit Test Setup dialog box” on 
page 4-31. 

1. Press the Function > Limit Test > Composite function keys. 

The Composite Limit Test dialog box is displayed. 

2. In the Ch field, set the channel to which the setting change is applied. 

3. In the Limit Test field, set ON (enable) or OFF (disable) for the composite limit 
test. 

4. In the Mode field, set GRADING (grading mode) or SORTING (sorting mode) 
for the operation mode. 

5. In the Auto Clear field, set ON (enable) or OFF (disable) for the automatic clear 
of the composite limit test result. 

6. When the operation mode is GRADING, set IMMEDIATE (for outputting 
results immediately) or END (for outputting results at the end) for the test result 
output timing in the Update field. 

7. In the Offset Cancel field, set ON (enable) or OFF (disable) for the offset cancel. 

8. In the Offset field, set the offset value used for the offset cancel. 

9. When the operation mode is GRADING, set a bit pattern that represents the limit 
test pass state (Pass) in the Pass Pattern field. 

10. When the operation mode is SORTING, set a bit pattern that represents the limit 
test fail state (Fail) in the Fail Pattern field. 
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11. In the /BUSY field, set the DIO pin number used for outputting the BUSY 
signal. 

12. In the /SOT field, set the DIO pin number used for outputting the start-of-test 
(SOT) signal. 

13. In the /EOT field, set the DIO pin number used for outputting the end-of-test 
(EOT) signal. 

14. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

Setting Individual Limit Tests

For details on the setup parameters, see “Limit Test Setup dialog box” on page 4-32.

1. Press the Function > Limit Test > Limits function keys. 

The Limit Test Setup dialog box is displayed. 

2. In the Ch field, set the channel to which the setting change is applied. 

3. In the Feed Data field, set the type of data used for the pass/fail judgement of the 
limit test. 

MATH: Calculation result data of math expression

VOLTS: Voltage measurement data

AMPS: Current measurement data

OHMS: Resistance data given by Resistance=Vmeas/Imeas

(Vmeas: Voltage measurement data, Imeas: Current measurement data)

4. In the Test Index field, set the index of the limit test between numbers 1 and 12. 

Index numbers 1 to 12 are also used for bin numbers 1 to 12. For details, see 
“Displaying the Limit Test Result” on page 5-29. 

5. In the Limit Test field, set ON (enable) or OFF (disable) for the limit test 
identified by Test Index. 

6. In the Function field, set COMPLIANCE (compliance check) or LIMIT (limit 
test) for the test mode. 

7. When the operation mode is SORTING, set a bit pattern that represents the limit 
test pass state (Pass) in the Pass Pattern field. 
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8. When the test mode is COMPLIANCE, configure the following settings:

• In the Fail on field, set IN or OUT for the fail judgement method. 

IN: Failure if the channel goes into the compliance state. 

OUT: Failure if the channel comes out of the compliance state. 

• In the Fail Pattern field, set a bit pattern that represents the limit test fail state 
(Fail). 

9. When the test mode is LIMIT and the operation mode is GRADING, configure 
the following settings:

• In the Up Pattern field, set a bit pattern that represents the 
failed-by-exceeding-upper-limit state. 

• In the Low Pattern field, set a bit pattern that represents the 
failed-by-exceeding-lower-limit state. 

• In the Up Limit field, set the upper limit for the pass/fail judgement. 

• In the Low Limit field, set the lower limit for the pass/fail judgement. 

10. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

NOTE For using MATH in the pass/fail judgement of the limit test, see “Using the Math 
Function” on page 5-25. 

For using the resistance compensation, see “Enabling or Disabling the Resistance 
Compensation” on page 5-24. 
5- 28 Agilent B2900 User’s Guide, Edition 2



Front Panel Operations

Performing the Limit Test
Displaying the Limit Test Result

For details on the setup parameters, see “Limit Test Result dialog box” on page 
4-39.

1. Press the Result > Limit Test function keys. 

The Limit Test Result dialog box is displayed. 

2. In the Ch field, set the channel for the data to be displayed. 

The limit test result is displayed in the area below the Length field. 

3. Press OK to close the dialog box. 

The Length field displays the number of data. 

In the area below the Length field, the limit test result is displayed in the following 
format: 

(aaaaa) BIN: bb  DATA: +c.ccccccE+ddd

(aaaaa) Data index aaaaa

BIN: Bin number bb (01 to 12). For details, see “Setting Individual 
Limit Tests” on page 5-27. 

If the limit test data is out of the bins, 00 is set for the 
GRADING mode and 15 is set for the SORTING mode. 

DATA: Limit test data +c.ccccccE+ddd
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Using the Trace Buffer
This section describes how to set the trace buffer and how to display the statistical 
data. For details on this function, see “Trace Buffer” on page 6-23. 

To use the trace buffer, set the trace buffer and source output and measurement 
conditions, and then press the Trigger key. 

• “Setting the Trace Buffer”

• “Displaying the Statistical Data”

Setting the Trace Buffer

For details on the setup parameters, see “Trace Buffer Setup dialog box” on page 
4-34.

1. Press the Function > Trace function keys. 

The Trace Buffer Setup dialog box is displayed. 

2. In the Ch field, set the channel to which the setting change is applied. 

3. In the Feed Data field, set SENSE (for collecting the measurement result data), 
MATH (for collecting the calculation result data), or LIMIT (for collecting the 
limit test result data). 

4. In the Buffer Control field, set NEXT (for enabling the write operation to the 
trace buffer) or NEVER (for disabling it). 

5. In the Buffer Size field, set the size of the trace buffer (1 to 100000). 

6. To apply the settings, press Apply. 

To apply the settings and close the dialog box, press OK. 

To cancel the setting change, press the Cancel/Local key. 

NOTE To specify the measurement result data (SENSE) to be collected, use “Format 
(Measure) dialog box” on page 4-44. 

To specify the calculation result data (MATH) or limit test result data (LIMIT) to be 
collected, use “Format (Math/Limit) dialog box” on page 4-45. 

To change the statistical data to be saved in the trace buffer, use “Format (Trace) 
dialog box” on page 4-45. 
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Displaying the Statistical Data

For details on the setup parameters, see “Trace Statistical Result dialog box” on 
page 4-40.

1. Press the Result > Trace function keys. 

The Trace Statistical Result dialog box is displayed. 

2. In the Ch field, set the channel for the data to be displayed. 

3. In the Element field, set SOURCE (source output data), VOLTS (voltage 
measurement data), AMPS (current measurement data), OHMS (resistance 
measurement data) for the data type of the statistical calculation. 

The statistical data for the data specified here is displayed in the area below the 
Length field. 

4. Press OK to close the dialog box. 

The Length field displays the number of data. 

The statistical data is displayed in the following fields: 

Mean: Mean value

Std. Dev.: Standard deviation

Min.: Minimum value

Max.: Maximum value
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Using Program Memory
This section describes how to select and run a memory program. For details on this 
function, see “Program Memory” on page 6-25. 

See also “Program key group” on page 4-42. 

• “Selecting a Program”

• “Controlling the Program Operation”

Selecting a Program

1. Press the More > Program > Catalog function keys. 

The Program Catalog dialog box is displayed. 

2. Highlight the name of the memory program to be run. 

3. Press OK. 

NOTE To set a value for a variable used in the memory program, use the Variable dialog 
box. For details, see “Program key group” on page 4-42. 

Controlling the Program Operation

1. Press the More > Program > Control function keys. 

2. Use the following keys to control the operation of a memory program. 

Run Starts the specified memory program. 

Pause Pauses the execution of the memory program. 

Step Starts the step execution of the specified memory program. 

Stop Stops the execution of the memory program. 

Continue Continues the execution of the memory program presently 
paused. 
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Function Details
This chapter describes the following functions of the Agilent B2900.

• “Limit/Compliance”

• “Ranging Mode”

• “Measurement Time”

• “Pulse Output”

• “Sweep Output”

• “List Sweep”

• “Output Filter”

• “Over Voltage/Current Protection”

• “Output-Off Status”

• “Automatic Output-ON/OFF Function”

• “High Capacitance Mode”

• “Resistance Measurement”

• “Math Expression”

• “Limit Test”

• “Trace Buffer”

• “Program Memory”

• “Channel Grouping”

• “Trigger System”

• “Interlock Function”

• “Over Temperature Protection”

• “Initial Settings”
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Limit/Compliance 
Limit/Compliance is the output limiter for preventing damage to the test device 
from overcurrent or overvoltage. Voltage compliance is for current output channels, 
and current compliance is for voltage output channels.

When a channel reaches compliance, the channel acts as a constant voltage source or 
a constant current source. The channel keeps the output value once compliance has 
been reached.

Compliance can be set with the same resolution and accuracy as output current or 
output voltage.

To Set Compliance

The following points must be noted when setting the compliance.

• The minimum compliance value is limited as follows.

• Current compliance

1 % of the range (at 100 nA Range)

1 nA (at 10 nA Range)

• Voltage compliance

20 mV (at 0.2 V range)

• If the current compliance value is too low, the SMU will require a long settling 
time.
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Ranging Mode
The following ranging modes are available for performing source output or 
measurement.

• FIXED (fixed range)

The channel uses the specified range only.

• AUTO (auto range)

The channel automatically uses the range which provides the best resolution for 
the source output value or the measurement value. It is possible to specify the 
minimum range effective for the auto range operation.

• BEST (best, only for the sweep source channel)

In the linear sweep mode, the channel automatically uses the minimum range 
which covers the whole sweep output.

In the log sweep mode, the channel automatically uses the range which provides 
the best resolution for each sweep step output.

Setting the Ranging Mode

The following points must be noted when setting the ranging mode.

• The measurement channel does not use ranges higher than the minimum range 
which covers the compliance value.

• The pulsed source channel always uses the fixed range for measurement.

• For the source side measurement, the channel uses the present source range.

• To set the ranging mode of the DC (constant) source or measurement channel, 
see “Range parameters” on page 4-11.

• To set the ranging mode of the sweep source channel, see “Sweep dialog box” 
on page 4-27.

• To set the detail of the auto ranging operation for measurements, see “Ranging 
dialog box” on page 4-28.
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Measurement Time 
Measurement time depends on aperture time, measurement range, and other 
measurement conditions, and can be expressed by the following formula:

Measurement time = Aperture time + Overhead time

Aperture time is the time required for measurement, and does not include such 
factors as range change or data compensation, which would be the overhead time.

Aperture Time

Aperture time is the time required to acquire the measurement data. For accurate and 
reliable measurement, the aperture time should be increased.

The aperture time is set by using the Measure Speed parameter on the Single view. 
See “Speed” on page 4-10.

Overhead Time

Overhead time is the time required for range change, etc. This time depends on the 
measurement condition, and cannot be specified. Major elements of the overhead 
time are:

• Range change time during measurement (when measurement ranging mode is 
set to AUTO)

• Range change time at the start of a measurement (when the measurement range 
is less than the compliance value)

To Control Source/Measure Timing

The source output and measurement timing can be controlled by the following 
parameters. See Figure 6-1. This figure shows an example of sweep output. For a 
bias output, focus the shape of a sweep step only. 

1. Source delay

The source delay time is defined as the time from trigger to start of a source 
output.
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2. Measure delay

The measurement delay time is defined as the time from trigger to start of a 
measurement.

3. Source wait

The source wait time is defined as the time the source channel cannot change the 
output value after starting an output.

4. Measure wait

The measurement wait time is defined as the time the measurement channel 
cannot start measurement after starting an output.

5. Period

The period is the trigger interval. It can be defined for the TIMER or MANUAL 
trigger type (trigger source) and for the source output and measurement actions 
individually.

Figure 6-1 Source Output and Measurement Timing, Sweep Output Example

To set the delay time and the period, see “Trigger parameters” on page 4-15.

To set the wait time, see “Wait Control dialog box” on page 4-29.

For more information about the trigger setup, see “Trigger key group” on page 4-35.

Voltage or current

Start value

Previous value

Trigger

: Measurement
Time

Stop value

Source wait (3)

Measure wait (4)

Trigger Trigger

Source delay (1)

Period (5)

(2) (2)

(4)

(3)

(1) (1)

(4)

(3)

(5)

Measure delay (2)
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Pulse Output
The source/measure unit SMU can apply the pulsed voltage or current. Figure 6-2 
shows a pulsed sweep output example. For a pulsed bias output, focus the shape of a 
pulse only. 

To Control Pulse Output/Measure Timing

The pulse output and measurement timing can be controlled by the following 
parameters. See Figure 6-2.

1. Source delay

The source delay time is defined as the time from trigger to start of a source 
output.

2. Measure delay

The measurement delay time is defined as the time from trigger to start of a 
measurement.

3. Pulse delay

The pulse delay time is defined as the time from the start of a source output to 
the start of a pulse (peak) output.

4. Source wait

The source wait time is defined as the time the source channel cannot change the 
output value after the trailing edge of a pulse.

5. Measure wait

The measurement wait time is defined as the time the measurement channel 
cannot start measurement after the trailing edge of a pulse.

6. Pulse width

The pulse width is the time from the start of a pulse output to the end of a pulse 
(peak) output. However, it is strictly defined as the time from 10 % of peak level 
at the leading edge to 90 % of peak level at the trailing edge. The available 
values are 50 s to 100000 s.
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Figure 6-2 Pulse Output and Measurement Timing, Sweep Output Example

To set the delay time, see “Trigger parameters” on page 4-15.

To set the pulse delay time and the pulse width, see “Pulse parameters” on page 
4-14.

To set the wait time, see “Wait Control dialog box” on page 4-29.

For more information about the trigger setup, see “Trigger key group” on page 4-35.

To Set Pulse Output

The following points must be noted when setting the pulse output.

• Pulse base value is set by the Source value on the Single or Dual view.

• Pulse peak value is set by the Single view.

Set the Peak value of “Pulse parameters” on page 4-14 for the pulsed bias 
output.

Or set the Start, Stop, and Points values of “Sweep parameters” on page 4-12 for 
the pulsed sweep output.

Voltage or current

Previous value

Trigger

: Measurement
Time

Stop value

Pulse delay (3)

Trigger

Pulse width (6)

Trigger

Start value

Source delay (1)

Source wait (4)

(1)

(2)

(3)

(6)

(1)

(3)

(6)

(2)

Measure wait (5)

Measure delay (2)

(4)

(5)

(4)

(5)
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Sweep Output
The source/measure unit SMU can apply a sweep voltage or current. It supports 
several shapes of sweep output, as shown in Figure 6-3. The SMU not only performs 
the sweep output but performs the measurement for each sweep step as shown in 
Figures 6-1 and 6-2.

Figure 6-3 Variety of Sweep Outputs

To Set Sweep Output

The following points must be noted when setting the sweep output.

• To set the staircase sweep source, see “Sweep parameters” on page 4-12. 

• To set the ranging mode of the sweep source, see “Sweep dialog box” on page 
4-27. 

• To set the sweep direction, see “Sweep dialog box” on page 4-27. 

• To set the output condition after sweep, see “Sweep dialog box” on page 4-27. 

• To set the pulse delay time and the pulse width, see “Pulse parameters” on page 
4-14. 

• To set the list sweep source, see “List sweep setup” on page 4-12. 

Single Sweep Double Sweep

Linear Sweep

Logarithmic Sweep

DC output Pulse output

DC output Pulse output

Pulse output

Pulse output

DC output

DC output
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List Sweep
List Sweep
The list sweep function is effective for performing an arbitrary waveform output. 
The source/measure unit (SMU) can apply the waveform as shown in Figure 6-4, 
and measure voltage or current at each output value. The source output and the 
measurement can be performed in the following minimum interval.

• B2901A/B2902A: 20 s

• B2911A/B2912A: 10 s

The source output and measurement timing is controlled by the trigger system. And 
the interval can be set to a constant value if the trigger type is set to TIMER. 

To set these trigger parameters, see “Trigger parameters” on page 4-15. The interval 
can be set by the Period parameter. The number of output values can be set by the 
Count parameter.

To set the source output values, use the List Sweep dialog box. See “List sweep 
setup” on page 4-12.

Figure 6-4 shows an example setup of the List Sweep dialog box with an image of 
the output waveform.

Figure 6-4 List Sweep Dialog Box
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Output Filter
Output Filter 
The filter is mounted on the source/measure unit (SMU). It assures clean source 
output with no spikes or overshooting. However, using a filter may increase the 
SMU settling time.

To set the filter, see “Output Filter dialog box” on page 4-26.
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Over Voltage/Current Protection
Over Voltage/Current Protection
The over voltage/current protection is effective for preventing damage to the test 
device from overcurrent or overvoltage. If this function is enabled, the 
source/measure unit (SMU) sets the output to 0 V and sets the output switch to off 
automatically and immediately when it reaches the compliance status.

To set the over voltage/current protection, see “Output Connection dialog box” on 
page 4-25.
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Output-Off Status
Output-Off Status
The output-off status is the condition which is set on the source/measure unit (SMU) 
automatically, immediately after its output is turned off. The status must be specified 
before enabling the source output. The available conditions are shown in Table 6-1 

To set the output-off status, see “Output Connection dialog box” on page 4-25.

Table 6-1 Output-Off State

NOTE This setting is not applied to the output-off process triggered by the emergency 
condition such as the over voltage/current protection, interlock open, and over 
temperature protection. Then the output voltage is immediately set to 0 V and the 
output switch is set to off. 

Name Conditions after output-off

HIGH Z, 
high 
impedance

• Output relay: off (open or break)

• Voltage source setup is not changed if the source applies 
40 V or less.

• Current source setup is not changed if the source uses the 
100 mA range or lower.

NORMAL • Source function: Voltage source

• Output voltage: 0 V

• Current compliance: 100 A at the 100 A range

• Output relay: off (open or break)

ZERO • Source function: Voltage source

• Output voltage: 0 V

• Current compliance: 100 A at the 100 A range
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Automatic Output-ON/OFF Function
Automatic Output-ON/OFF Function
The automatic output-ON/OFF function defines the source channel’s output 
ON/OFF operation when the trigger system changes the status.

• Automatic-ON function

If this function is enabled, the source/measure unit (SMU) automatically turns 
the channel output ON just before the trigger system is initiated by an SCPI 
command, not by a front panel operation.

• Automatic-OFF function

If this function is enabled, the SMU automatically turns the channel output OFF 
immediately when all trigger system changes the status from busy to idle.

To set the automatic output ON/OFF function, see “Output Connection dialog box” 
on page 4-25.
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High Capacitance Mode
High Capacitance Mode
High capacitance mode is effective for the measurement of a capacitive load greater 
than 0.01 F. 

If the measurement result data is not stable, set this function ON. The measurement 
data may come stable. This function is effective for measurements of capacitive 
devices up to 50 F. 

High capacitance mode is available for the following source/measure condition.

• Operation mode: voltage source and current measurement

• Measurement ranging mode: Fixed

• Measurement range value: 1 A to 10 A

To set the high capacitance mode, see “Output Connection dialog box” on page 
4-25.
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Resistance Measurement
Resistance Measurement
B2900 supports resistance measurement. If the measurement parameter is set to 
resistance OHMS (R), the source/measure unit (SMU) automatically sets the current 
source and voltage measurement operation to perform resistance measurement.

For performing accurate measurement, B2900 provides the compensation function. 

NOTE To Enable Resistance Measurement

The resistance measurement operation must be specified. See “Range parameters” 
on page 4-11 and “Enabling the Resistance Measurement” on page 5-19.

In the initial setting, the resistance measurement operation is set to OFF.

Resistance Compensation

Resistance compensation (R Compen) is effective for performing low resistance 
measurements accurately. If R Compen is set to ON, the channel performs 
measurement twice and returns the compensated measurement result given by the 
following formula. This technique is effective for reducing the thermal EMF.

Rcompen=(V2-V1)/(I2-I1)

where, V1 is the measurement results at the 0 A source condition, and I1 is the 
measurement results at the 0 V source condition.

To enable resistance compensation, press the Config > Measure > R Compen > ON 
function key on a 1-channel model, or the Config > Measure > R Compen > ALL or 
Ch 1 or Ch2 > ON function key on a 2-channel model.

To disable resistance compensation, press the Config > Measure > R Compen > 
OFF function key on a 1-channel model, or the Config > Measure > R Compen > 
ALL or Ch 1 or Ch2 > OFF function key on a 2-channel model.
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Math Expression
Math Expression
B2900 provides a math function for performing calculations using the measurement 
result data. The calculation result can be displayed and used for the limit test and 
trace statistics.

For the predefined math expressions, see “Predefined Math Expressions”.

To define a math expression, see the Agilent B2900 SCPI Command Reference. 
Math expressions can be defined by using the :CALC:MATH commands. For 
resources effective for the expression, see “Resources Used in the Expressions”. 

To use the math function, see “Math Expression dialog box” on page 4-30.

To display the calculation result, see “Graph View” on page 4-17 and “Measure 
Result dialog box” on page 4-38.

Predefined Math Expressions

The following math expressions have already been defined in B2900. The 
predefined math expressions are not cleared by the power off and on operations.

• Power (POWER)

• Offset Compensated Ohms (OFFCOMPOHM)

• Varistor Alpha (VARALPHA)

• Voltage Coefficient (VOLTCOEF)

In the following formula, [c] specifies the channel (1 or 2) used for the 
measurement.

POWER Calculates power using the following formula.

POWER = VOLT[c] * CURR[c]

OFFCOMPOHM Calculates offset compensated ohms (resistance) using the following formula.

OFFCOMPOHM = (VOLT[c][1]-VOLT[c][0]) / (CURR[c][1]-CURR[c][0])

where, VOLT[c][0] and CURR[c][0] are the data measured with a current output 
level, and VOLT[c][1] and CURR[c][1] are the data measured with a different 
current output level or zero output.
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Math Expression
This function is effective for reducing measurement errors in low resistance 
measurements.

VARALPHA Calculates varistor alpha using the following formula.

VARALPHA = log(CURR[c][1] / CURR[c][0]) / log(VOLT[c][1] / VOLT[c][0])

where, CURR[c][0] and VOLT[c][0] are the measurement data at a point on a 
varistor’s non-linear I-V characteristics curve, and CURR[c][1] and VOLT[c][1] are 
the data at the another point.

VOLTCOEF Calculates voltage coefficient using the following formula.

VOLTCOEF = (RES[c][1]-RES[c][0]) / (RES[c][1] * (VOLT[c][1]-VOLT[c][0])) 
* 100 %

where, RES[c][0] and RES[c][1] are the resistance measurement data at the first and 
second measurement points, respectively, and VOLT[c][0] and VOLT[c][1] are the 
voltage measurement data at the first and second measurement points, respectively.

The voltage coefficient is known as the ratio of the fractional change for a resistor 
whose resistance varies with voltage.

Resources Used in the Expressions

The following resources can be used in user-defined math expressions.

• Reserved variables

The variables listed in Table 6-2 are reserved for reading the channel output or 
measurement data. 

Scalar variable is used for spot measurement data. 

Vector (array) variable is used for sweep measurement data.

• Math operators

The following operators are available.

• Arithmetic operators: +, -, *, /, ^, see Table 6-3

• Elementary functions: ln, log, sin, cos, tan, exp

The functions log and ln perform the operation after calculating the absolute 
value. So if a negative value is specified, they do not cause an error but calculate 
as a positive value. For example, log(-10) results in log(10)=1.
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Math Expression
Table 6-2 Reserved Variables

Table 6-3 Arithmetic and Unary Operators

Reserved variable a

a. The numeric suffix [c] is effective for specifying the channel. For exam-
ple, use CURR2 to read the current spot measurement data of the chan-
nel 2.

Description
Scalar Vector 

SOUR[c] SOUR[c][] Source output setting data

VOLT[c] VOLT[c][] Voltage measurement data

CURR[c] CURR[c][] Current measurement data

RES[c] RES[c][] Resistance measurement data

TIME[c] TIME[c][] Time (timestamp) data

Priority of task Operator Description

High
:
:
:
:
:

Low

( ) Parentheses

+ and - Unary plus operator and unary minus operator

^ Exponentiation operator

* and / Multiplication operator and division operator

+ and - Additive operator and subtraction operator
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Limit Test
Limit Test
Limit test is a pass/fail judgement performed for a measurement data or math result 
data obtained by a channel. It can be performed if both limit test and composite limit 
test are set to ON. Maximum of twelve limit tests can be defined and used for the 
bins of composite limit test.

B2900 supports the following two operation modes of composite limit test.

• Grading mode

Performs limit test for up to 12 test limits (bins) until a failure is detected. See 
Figure 6-5 for an example flowchart.

• Sorting mode

Performs limit test for up to 12 test limits (bins) until a pass is detected. See 
Figure 6-6 for an example flowchart.

In the figures, SOT is the start-of-test strobe pulse sent by the component handler 
connected to B2900 via the Digital I/O connector.

To set the composite limit test, see “Composite Limit Test Setup dialog box” on 
page 4-31.

To set the limit test, see “Limit Test Setup dialog box” on page 4-32.

The composite limit test result Pass or Fail is displayed with the measurement result 
data on the Single or Dual view. To display the limit test result log, see “Limit Test 
Result dialog box” on page 4-39.

NOTE Limit test for the math result

If the math expression refers to a measurement result data by multiple channels, the 
acquire trigger count for the channels must be the same.

If the math expression contains a vector operation, the acquire trigger count must be 
equal to or greater than the maximum number of the vector.
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Limit Test
Figure 6-5 Composite Limit Test Flowchart Example for Grading Mode
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Limit Test
Figure 6-6 Composite Limit Test Flowchart Example for Sorting Mode
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Trace Buffer
Trace Buffer
The trace buffer collects the test result data until a buffer full is detected. The 
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Function Details

Trace Buffer
NOTE Do not forget to save or read the data before turning the B2900 off. The trace buffer 
is cleared by turning the instrument off.

Figure 6-7 Data Flow to Trace Buffer for Each Channel
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Program Memory
Program Memory
The program memory stores command strings temporarily. The stored program can 
be executed by using the front panel keys, or automatically when B2900 is turned 
on. See “Program key group” on page 4-42 and “Start-up” on page 4-50. The keys 
used for controlling the program memory are shown in Table 6-4. This table also 
shows the status changed by pressing the program control keys.

The program memory can eliminate several processes in the program execution, 
such as transferring commands, checking command syntax, and converting 
commands to the internal codes. Thus, using the program memory speeds up 
program execution. If frequently used command strings are stored in the program 
memory, interface/computer activity is minimized.

The program memory can be defined by using SCPI commands while B2900 is in 
the remote mode. See Agilent B2900 series SCPI Command Reference.

• Number of programs saved in the memory: 100

• Number of programs used for start-up automatic execution: 1

• Total memory size: 100 KB

• Maximum length for a line: 256 bytes

• Maximum number of characters of program name: 32 with alphabets, numbers, 
hyphens, and underscores

Table 6-4 Program Control Keys (Function Keys) and Status Changes

Control key
Present execution status

Running Paused Stopped

Run Error to Running to Running

Pause to Paused Paused Stopped

Step Error to Running to Paused to Running to Paused

Stop to Stopped to Stopped Stopped

Continue Error to Running Error
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Channel Grouping
Channel Grouping
This section applies only to 2-channel models. This function is used to control the 
channel output timing automatically so that the channel keeps the output while the 
other channel performs measurement.

The grouped channels start the source output in the order of channel number, then 
start the measurement at the same time, and keep the output until the measurement is 
completed. If delay time and wait time are set, this is adjusted by these values.

If the grouping is released, the channels work independently regardless of the 
condition of the other channel.

To enable the channel grouping, press the Config > Common > Group > ON 
function keys.

To disable the channel grouping, press the Config > Common > Group > OFF 
function keys. 

NOTE About Wait Time

If wait time is set, channels cannot start measurement or source output change until 
the wait time elapses. See “Wait Control dialog box” on page 4-29 for setting the 
wait time.

For the grouped channels, the wait time starts at the timing of the last output change 
(DC output change or pulse level transition from peak to base) by the last source 
output channel.
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Trigger System
Trigger System
B2900 supports the ARM-TRIGger model described in 1999 SCPI Command 
Reference. The ARM-TRIGger model shows independent event detection for the 
ARM and TRIGger layers. This layered model is similar to the for-loop statement of 
programming languages. When the trigger system is initiated, the ARM layer waits 
for the specified ARM source signal. After the ARM condition is satisfied, the 
control is passed to the TRIGger layer. The TRIGger layer waits for the specified 
TRIGger source signal, and launches the device action(s) when the TRIGger 
condition is satisfied. Both layers have repeat count.

B2900 has both source and measure functions, and has the independent 
ARM-TRIGger model’s operation for each function and channel. See Figure 6-8. 
ARM-TRIGger operations can be controlled independently or simultaneously.

Trigger Source

B2900 supports the following trigger sources.

• AUTO (automatic internal, AINT): Automatically selects the trigger source best 
suited for the present operating mode by using internal algorithms. 

• BUS: Trigger source will be the remote interface trigger command such as the 
group execute trigger (GET) and the *TRG command. 

• TIMER (timer, TIMer): Trigger source will be a signal internally generated 
every interval set by the Period parameter. 

• INT1 or INT2 (internal): Trigger source will be a signal from the internal bus 1 
or 2, respectively.

• EXT1, EXT2, EXT3, EXT4, EXT5, EXT6, EXT7, EXT8, EXT9, EXT10, 
EXT11, EXT12, EXT13, or EXT14 (external): Trigger source will be a signal 
from the DIO pin n which is an output port of the Digital I/O D-sub connector on 
the rear panel. n=1 to 14.

• LAN: Trigger source will be the LXI trigger.

The trigger setup parameters can be set by the “Trigger parameters” on page 4-15 of 
the Single view, or the “Trigger Configuration dialog box” on page 4-36.
Agilent B2900 User’s Guide, Edition 2 6- 27



Function Details

Trigger System
Figure 6-8 B2900 Trigger System
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Trigger System
Device Actions

B2900 supports the following device actions.

• Triggered transient (source) action

After the transient trigger condition is satisfied, the channel applies a new 
voltage or current value after the source delay time (Source delay) elapses.

• Triggered acquire (measurement) action

After the acquire trigger condition is satisfied, the channel performs current 
and/or voltage measurement after the measurement delay time (Measure delay) 
elapses.

Figure 6-9 Transient and Acquire Device Actions
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Trigger System
Trigger Output

B2900 provides the trigger output function by using the Digital I/O connector on the 
rear panel. For more information about the connector, see “Using Digital I/O” on 
page 3-29.

• Trigger output terminal

Specifies Digital I/O pins. Pin assignment can be specified by the “DIO 
Configuration dialog box” on page 4-46.

• Trigger output timing

The output trigger can be generated at the timing shown in Table 6-5. The trigger 
output timing can be specified by the Layer, Action, and Trigger Output 
parameters of the “Trigger Configuration dialog box” on page 4-36 and the 
Output Trigger Timing parameter of the “DIO Configuration dialog box” on 
page 4-46.

Table 6-5 Trigger Output Timing and Setup Parameters

The output trigger polarity, type, and pulse width can be set by the “DIO 
Configuration dialog box” on page 4-46.

Trigger output timing Layer Action
Trigger 
Output

Output 
Trigger 
Timing

Starting arm loop ARM TRANS. for 
transient 
action or 
ACQ. for 
acquire 
action

ON BEFORE

Ending arm loop ARM ON AFTER

Starting trigger loop TRIGGER ON BEFORE

Ending trigger loop TRIGGER ON AFTER

Starting transient (source) action ACTION TRANS. ON BEFORE

Ending transient (source) action ACTION TRANS. ON AFTER

Starting acquire (measure) action ACTION ACQ. ON BEFORE

Ending acquire (measure) action ACTION ACQ. ON AFTER
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Trigger System
Synchronous Device Actions

This section applies only to when performing synchronous channel operation on a 
2-channel model. 

If channels are set as shown below, the device actions start simultaneously.

• To synchronize transient actions (source output)

• Trigger source is set to the same mode.

• Delay time is set to the same value.

• Source output ranging mode is set to the fixed mode.

• Source wait time control is set to OFF.

• Measurement wait time control is set to OFF.

• Measurement ranging mode is set to the fixed mode.

• To synchronize acquire actions (measurement)

• Trigger source is set to the same mode.

• Delay time is set to the same value.

• Measurement wait time control is set to OFF.

• Measurement ranging mode is set to the fixed mode.
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Interlock Function
Interlock Function
The interlock function is designed to prevent electrical shock when a user touches 
the measurement terminals. If the interlock terminal is open, maximum output is 
limited to 42 V.

To perform high voltage measurement greater than 42 V, connect the interlock 
terminal to an interlock circuit of a test fixture or a shielding box. The interlock 
circuit must have one LED and two mechanical switches that are connected together 
and placed near the shielding box opening doors. For details on installing the 
interlock circuit, see “Installing the Interlock Circuit” on page 3-19.

The interlock function works as shown below.

• When the interlock terminal is open, maximum output is limited to 42 V.

• When the interlock terminal is shorted, source channel can apply its maximum 
output value.

• When the interlock terminal is opened in a high voltage condition greater than 
42 V, the output voltage is immediately set to 0 V and the output switch is set 
to off. 

WARNING Open the interlock terminal so that the SMU cannot apply dangerous voltage 
when the source/measure terminal is touchable or opened.
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Over Temperature Protection
Over Temperature Protection
The over temperature protection is effective for preventing damage to a channel 
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Initial Settings
Initial Settings 
The B2900 is initialized by turning the B2900 on, the *RST command, or the device 
clear. Initial settings of the B2900 are shown in this section.

Table 6-6 System Initial Settings

Setup item Power on Reset

GPIO function Digital In 

GPIO function (D14) High Voltage 

GPIO polarity Negative 

GPIO output trigger type Edge 

GPIO output trigger timing Both 

GPIO output trigger pulse width 100 s 

Display digits 7 

Zoomed display OFF Not changed

Display image format JPG 

User message enable Disabled 

User message “” 

Byte order (measurement data) Normal 

Data format (measurement data) ASCII 

Data format (GPIO data) ASCII 

Data format (status register) ASCII 

Data elements (measurement data) All 
(V/I/R/S/T/Stat)



Data elements (calculate) CALC 

Automatic timestamp reset ON 
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Initial Settings
Table 6-7 SMU Initial Settings

Mass storage directory (Root) 

Program variables None Not changed

Program selection None 

Program status Idle 

Setup item Power on Reset

Low terminal state Grounded Not changed

Output state OFF 

Output auto filter enable ON 

Output filter enable ON 

Output filter time constant 5 s 

Output filter frequency 31.8309886 kHz 

Output OFF state Normal 

Output protection OFF 

Source mode Voltage 

Source shape DC 

Automatic output-on ON 

Automatic output-off OFF 

Voltage source 0 V 

Voltage protection level 2 V 

Voltage source auto ranging ON 

Voltage source range 2 V 

Voltage source range lower limit 0.2 V 

Setup item Power on Reset
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Voltage source mode Fixed 

Voltage sweep points 1 

Voltage sweep start 0 V 

Voltage sweep stop 0 V Not changed

Voltage list points 1 

Voltage list values 0 V 

Current source 100 A 

Current protection level 100 A 

Current source auto ranging ON 

Current source range 100 A 

Current source range lower limit 10 nA for B291x

100 nA for B290x



Current source mode Fixed 

Current sweep points 1 

Current sweep start 0 A 

Current sweep stop 0 A Not changed

Current list points 1 

Current list values 0 A 

Sweep direction UP 

Double sweep OFF 

Sweep ranging BEST 

Continuous triggered source ON 

Pulse delay 0 s 

Pulse width 50 s 

Setup item Power on Reset
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Auto settling time ON 

Settling time 0 s 

Measure function Current 

Auto aperture ON 

Aperture time 0.1 PLC 

Voltage measure range mode AUTO 

Voltage measure range limit 0.2 V 

Voltage measure range 2 V 

Current measure mode AUTO 

Current measure range limit 1 A 

Current measure range 100 A 

Resistance measure mode OFF 

Res. meas. range 2  

Res. meas. range limit (Low) 2  

Res. meas. range limit (High) 200 M 

Res. meas. compensation OFF 

Remote sensing OFF 

Measurement auto range operation NORMAL 

Measurement auto range threshold 90 

Setup item Power on Reset
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Table 6-8 Trigger System Initial Settings

Setup item Power on Reset

ARM count 1 

ARM source AINT 

ARM timer 100 s 

ARM delay time 0 s 

ARM bypass OFF 

Trigger count 1 

Trigger source AINT 

Trigger timer 10 s for B291x

20 s for B290x



Trigger delay time 0 s 

Trigger bypass OFF 

External trigger output EXT1 

External trigger output (LAN) LAN0-7 (all) 

External trigger output enable OFF 
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Table 6-9 LXI Trigger Events Initial Settings

Setup item Power on Reset

Event domain 0 

LAN event “WaitingForAcquir
eArm1”, “WaitingF
orTransitionArm1”
, “WaitingForAcqu
ireTrigger1”, “Wait
ingForTransitionTr
igger1”, “Measurin
g1”,  “Settling1”

“WaitingForAcquir
eArm2”, “WaitingF
orTransitionArm2”
, “WaitingForAcqu
ireTrigger2”, “Wait
ingForTransitionTr
igger2”, “Measurin
g2”,  “Settling2”



Delay time 0 

Input/output filter string “ALL:5044” 

Input/output status OFF 

Input detection RISE 

Output drive OFF 

Output slope Positive 

Output source “” 

Output timestamp delta 0 

Event logging ON 

Circular event logging ON 

Event log size 100 
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Table 6-10 Calculate Functions Initial Settings

Setup item Power on Reset

Composite limit test result transfer 
timing

IMM 

Composite limit test result 
automatic clearance

ON 

Composite limit test fail bit pattern All 0 

Composite limit test pass bit pattern All 0 

Composite limit test mode GRADing 

GPIO bit assignment (pass/fail bit 
pattern)

None 

GPIO bit assignment (/BUSY) None 

GPIO bit assignment (/EOT) None 

GPIO bit assignment (/SOT) None 

Limit test feed source VOLTage 

Compliance check fail bit pattern All 0 

Compliance check fail condition IN 

Limit test function LIM 

Upper limit +1 

Lower limit -1 

Upper bit pattern All 0 

Pass bit pattern All 0 

Lower bit pattern All 0 

Limit test enable OFF 

Math function enable OFF 

Math function expression (VOLT*CURR) 
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Math function expression name “POWER” 

Math function catalog “POWER”, 
“OFFCOMPOHM
”, “VOLTCOEF”, 
“VARALPHA”



Math function unit name “W” 
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Table 6-11 Non-volatile Communication Settings

Setup item Factory default setting

DHCP Enabled

IP address 169.254.5.2

Subnet mask 255.255.0.0

Default gateway 0.0.0.0

Obtain DNS server from DHCP Enabled

DNS server 0.0.0.0

WINS server 0.0.0.0

Hostname A-B29xxA-nnnnn

B29xxA: model number

nnnnn: suffix of serial number.

Desired hostname

Desired service name

mDNS Enabled

Use DNS naming service Enabled

Use NetBIOS naming service Enabled

Domain name Not set

GPIB address 23

LXI identify Disabled

GPIB command interface Enabled

USB command interface Enabled

VXI-11 command interface Enabled

SCPI telnet command interface Enabled

SCPI socket command interface Enabled

SCPI HiSLIP command interface Enabled
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Table 6-12 Other Non-volatile Settings

Web interface Enabled

Command prompt for a Telnet session B2900A>

Welcome message for a Telnet session Welcome to Agilent B2900A 
Series

Setup item Factory default setting

Channel grouping “1” for 1-ch models

“1-2” for 2-ch models

Remote display Enabled

Display color set 1

Beeper Enabled

Graphical web interface (web server) Enabled

SCPI language mode Default

Power-on program Not set

Line frequency 50 Hz

Fan control mode Normal

Setup item Factory default setting
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